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Preface

About this Manual
The Profile® Family User Manual supports Profile system software 2.5 for the 
PDR200 and PDR300 Profile Video File Servers and, with a Master Enhanced 
Disk Recorder board upgrade, the Profile PDR100 Video Disk Recorder. 
Profile disk recorders use digital technology to store and produce broadcast-
quality JPEG and MPEG video and CD-quality audio. This manual documents 

nd optional software applications that run on the Profile platform: 

 Configuration Manager configures your hardware for input and 
ideo and audio, genlock, and system timing. 
the standard a

• The Profile
output of v
17
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• The Media Manager manages clips and masters on disk and in a cartridge 
library system. With Fibre Channel, you can use Media Manager to copy or 
move media between Profile units. 

• The Transcode Utility converts media between different video compression 
formats, such as from JPEG to MPEG. 

• VdrPanel lets you capture and use JPEG and MPEG video and audio clips.

• The Profile Disk Utility lets you manage the Profile systems media disk 
drives. 

• The optional Tool Box Editor records media and performs simple, cuts-only 
edits. It also allows you to create a sequence of clips called a master. 

• The optional List Manager allows you to set up simple station automation. 

• The Resource Manager allocates video, audio, and timecode resources for the 
Tool Box Editor, the List Manager, and Time Delay. 

• TimeDelay, also optional, allows you to delay a video feed by a specific 
amount of time. 

• Other Profile utilities include Profile Log (via WinTail), ProLink, and 
PortServer, among others. 

NOTE: This manual assumes that you are familiar with basic 
Microsoft  Windows  operation.
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Related Documentation
Several manuals related to the Profile Family User Manual include:

• On-line manuals. You can access on-line help for an application at any time 
by choosing Help | Help Topics. 

• Profile System Version 2.5 Release Notes. 

• Profile PDR200 & PDR300 Installation Manual. 

• PLS20 Library System Manual. 
Profile Family

• PLS200 Library System Manual. 

• PRS200/A RAID Storage Instruction Manual. 

• PRS250 RAID Storage Instruction Manual. 

• PDX103 Disk Expansion Unit Installation Manual. 

• PDX208 Disk Expansion Chassis Instruction Manual. 

• PRC100 Profile Control Panel User Manual. 

• Microsoft Windows NT user documentation. 
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Terminology and Conventions
Button (graphical) Buttons shown in bold (OK, for example) that you click 

with the mouse pointer. 

Button (mouse) The two or three buttons on the top of the mouse. 

Choosing Choosing menu items, File | Exit, for example. (File | Exit 
means choose the Exit menu item under the File menu.) 

Commands Commands (a:\setup, for example) are shown in bold. 

Clicking Pressing and releasing the mouse button without moving 
Profile Family

the pointer. 

Ctrl key Hold Ctrl down while pressing other keys in a sequence. 

Double-clicking Pressing and releasing the left mouse button twice without 
moving the pointer. 

Dragging Pressing and holding the mouse button while moving the 
pointer. 

Moving Changing the location of the pointer on the screen by 
moving the mouse. 

Pointer An arrow or other graphic on the screen indicating the 
current cursor position for selecting or clicking. 

Pointing Positioning the pointer on an object on the display by 
moving the mouse. 

Right-click Pressing and holding the right mouse button. 

Shift key Hold Shift down while pressing other keys in a sequence. 



Preface

20
 Profile Family



Chapter 1 
Introducing the Profile Family

The Profile PDR100 Video Disk Recorder and the Profile PDR200 and 
PDR300 Video File Servers store broadcast-quality motion JPEG or MPEG 

 and PDR300 only) video and CD-quality audio on computer disk 
er than on video tape, allowing almost instant access to any timecode 
f your video and audio material. 
(PDR200
drives rath
location o
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A Profile system is more than just a one-for-one replacement of a VTR: it can 
Profile Family

have up to six record and eight playback video channels. Clips are available on 
all channels at once, so you can play a clip on more than one channel at the same 
time, without making a copy of it. Since each channel is independent of the 
others, each playback can start at a different time and at a different place in the 
clip.

You can even start playing a clip while it’s still being recorded. Just start 
capturing the clip on one channel, wait about five seconds, and then play the clip 
back on another channel. This kind of control makes the Profile system an ideal 
solution if you want to go to air with a clip before you are finished recording it.

NOTE: Profile System Software version 2.5 supports the PDR200, the 
PDR300, and, when upgraded with a Master and Slave Enhanced 
Disk Recorder (EDR) boards, the PDR100. In addition, version 2.5 
runs on Microsoft Windows® NT™ 3.51 and 4.0. 

This version of system software offers support for the MPEG-2 4:2:2 @ Main 
Level encoder/decoder boards, which are standard in the PDR300. Upgrading 
your PDR200 with MPEG can approximately double its video/audio storage 
capacity and enables much faster data transfers over Fibre Channel. The MPEG 
encoder offers both 4:2:2 and 4:2:0 chroma sampling, variable bit rates from 4 
Mb/s to 50 Mb/s, and group of picture (GOP) structures from I-frame only to 
16-frame GOPs. 

MPEG uses motion prediction to increase efficiency—essentially, it uses lower 
data rates because it does not duplicate video that does not change from frame 
to frame. MPEG accomplishes this through both backward and forward 
prediction. To do this, it uses GOPs, consisting of I-frames, P pictures and B 
pictures.
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An I-frame (also known as an I-picture or Intra-picture) is analogous to a single 
motion JPEG frame, where all data required to display a frame is stored in one 
picture. A P picture (also called a predictive picture) uses a motion vector to 
predict what will happen in the next frame and contains only the changed data, 
rather than passing along another complex frame of video. In addition, a
B picture (known also as a bidirectional picture) relies on data from both 
backward and forward motion vectors to determine how a future frame will be 
composed. In general, the longer the GOP, the more efficient your MPEG video 
stream will be.

Table 1 compares the capabilities of the PDR100 and PDR200/300. The 
optional products supported by these disk recorders are listed here: 
Profile Family

• MPEG encoder/decoder board (optional PDR200, standard PDR300)

• Fibre Channel interface board 

• Video mix effects board 

• PDX103 and PDX208 Profile Disk Expansion Units 

• PAC208 and PAC216 Analog/Digital Audio Interface chassis (PDR200/300) 

• XLR216 and BNC216 Digital Audio Interface chassis (PDR200/300) 

• PRS200 and PRS250 Profile RAID Storage Systems 

• PLS20 and PLS200 Profile Library Systems 

• PRC100 Profile Control Panel unit 

• LVS100 Live Controller 

• Profile VideoGateway 

• CD-ROM Drive 

• Profile Tool Box Editor software 

• Profile Tool Box List Manager software 

• Profile TimeDelay application software
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Table 1. PDR100 and PDR200/300 features compared  

Feature PDR100 PDR200/300

Video inputs Analog composite, component 
analog (CAV), serial digital 
component

Analog composite, component analog 
(CAV), serial digital component

Video channels: JPEG 
CODECs

2 or 4 play/record channels 2 or 4 play/record channels

Video channels: MPEG 
encoders and decoders 

None 1 or 2 record channels (encoders), 4, 
6, or 8 playback channels (decoders); 
Profile Family

Optional PDR200, Standard PDR300

Disk drives Up to eight 4-GB SCSI Up to eight 9-GB Ultra-SCSI

Audio Up to 16 channels, 16-bit analog 
standard; digital embedded optional 
(625 only)

16 channels, digital standard 
(AES/EBU, embedded); up to 32 
channels possible; analog optional

Digital audio interfaces None XLR216, BNC216

Analog audio interfaces XLR100 PAC208 (8 channel),
PAC216 (16 channel)

Internal storage at 24 Mb/s 3 hours 6 hours (JPEG),
12 hours (MPEG) 

Mainframe bandwidth 24 Mb/s 30 Mb/s

Ethernet 10/100 BaseT 10/100 BaseT

Video network Fibre Channel upgradeable Fibre Channel ready

RS-422 protocols Profile, Louth, Odetics, BVW Profile, Louth, Odetics, BVW

Reference signals NTSC and PAL NTSC and PAL

Line formats 525/60 and 625/50 525/60 and 625/50

Video compression Continuously variable motion 
JPEG

Continuously variable motion JPEG, 
MPEG 4:2:0 or 4:2:2 
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A Profile System Overview
The PDRseries of video servers are multichannel digital disk recorders. Both 
the PDR100 and PDR200 are capable of supporting up to four play/record 
channels (codecs) of continuously variable motion JPEG video compression. 
The PDR200 and PDR300 support Fibre Channel networking and MPEG 
4:2:0/4:2:2 video compression, with up to two record channels (encoders) and 
up to eight playback channels (decoders). Each channel can play back one video 
and up to 16 audio signals, each capable of using different video formats. In 
other words, one Profile unit can replace the functionality of up to eight VTRs, 
with the added benefit of random access to video and audio data stored on disk.
Profile Family

The Profile system has an EISA motherboard with an internal digital video 
routing system. There are sixteen EISA slots and one ISA slot used for interface 
cards and routing audio data. The server also uses a PCI bus for routing data 
between the master and slave enhanced disk recorder (EDR) boards, Fibre 
Channel boards, and MPEG boards.

A video router chip set is integrated on the mother board. It routes video signals 
between the video disk system, video mix effects cards, and video I/O cards. 
The video router is a 32 x 32 crosspoint matrix capable of full bandwidth 4:2:2 
CCIR 601 8-bit digital video. The video router allows real-time transfer of 
video throughout the system without impacting overall system performance. 
The video router also makes possible simultaneous record and playback on 
separate channels.

A block diagram showing the hardware layout of a PDR200 or above is shown 
in Figure 1 on page 27.

Video Disk Subsystem
In the video disk subsystem, video data is compressed and written to up to eight 
4-gigabyte (PDR100 only) or 9-gigabyte disks, and then read from these disks 
and decompressed. This video data is read from and written to the video router 
in 8-bit, parallel component digital video format. The video disk subsystem has 
disk recorder boards (PDR100) and enhanced disk recorder boards (PDR200 
and above), with an Intel i960 real-time processor and a SCSI-2 interface to the 
disks.

The video disk subsystem uses master and slave disk recorder or enhanced disk 
recorder (EDR) boards with two SCSI-2 channels on each board. The master 
disk recorder board comes standard with a two-channel JPEG codec. 
Bidirectional codec channels allow channels to be configured for recording or 
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playback. By adding a slave disk recorder board, a Profile unit becomes a four-
channel JPEG system. The master board has a Intel i960 real-time processor 
which controls compression and the data flows on SCSI-2 channels and JPEG 
codecs. Master and slave EDR boards also control MPEG encoder and decoder 
boards which are connected to the master and slave via a PCI interconnect 
board.

Video Compression
The i960 on the master board is used to control data flow and compression 
coefficient loading of the JPEG codecs and, if present, MPEG encoders and 
decoders. The amount of JPEG video compression varies according to the 
Profile Family

setting of the compression coefficient; the amount of MPEG video compression 
varies according to the bit rate. Higher compression ratios or bit rates store 
more video, but the result is lower quality video. On the other hand, lower 
compression ratios or bit rates result in higher quality video and less storage 
capacity. Audio, however, is not compressed.

Since the video compression ratio can be varied to change the video quality 
given available storage time, the amount of storage depends on your choice of 
compression ratio. A quick rule of thumb is that five minutes of JPEG 
video—plus four channels of audio and two channels of timecode—is roughly 
equal to one gigabyte of disk storage at 75,000 bytes per field in the 525 
standard video format. For example, a PDX208 Disk Expansion unit expands 
storage up to twelve hours and a PRS200 RAID Storage System can bring it up 
to approximately 96 hours. For video stored in the MPEG format at an average 
24 Mbps, you can just about double these capacities.

In addition to video compression, the disk recorder boards also integrate the 
digital audio data coming from the EISA bus, with typically four channels of 
audio per channel of video (up to 32). These recorder boards communicate with 
the SCSI-2 interface using a Direct Memory Access (DMA) interface. The 
PDR200 also supports the audio signal processing board (ASPB). This board is 
capable of delivering 16 channels of analog, embedded digital, or AES/EBU 
digital audio. The PDR200 can be equipped with two of these boards, for a total 
of 32 channels of audio.

Video and Audio Interface Boards
Video and audio interface boards receive incoming and send outgoing video 
and audio data. These boards are responsible for converting the video and audio 
to internal formats used by the video server.
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The PDR200 and PDR300 come with the Audio Signal Processing board 
(ASPB). This audio architecture accepts and simultaneously processes sixteen 
audio inputs and outputs. Internally, all audio is processed with a selectable 
storage resolution of 16 or 20 bits. Inputs may be individually clocked in groups 
of four, and any clock group may be referenced to the system reference (house 
black) or any one of four video inputs. Output clocking is synchronous to 
system reference. Sample rate conversion is available for all inputs (30 to 
50kHz), providing uniform storage at 48kHz.

You can configure the PDR200 or 300 to operate with analog, AES/EBU 
digital, or embedded (SMPTE 272M Level A) audio, depending on which 
options are installed in your system. All three audio formats are supported 
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without external conversion equipment. Analog audio is only available with an 
optional PAC208 or PAC216 Analog/Digital Interface chassis. You can 
expand the number of XLR or BNC connectors for AES/EBU audio with an 
optional XLR216 or BNC216 Digital Interface chassis.You can choose an 
audio format for each video channel. For example, you could enable analog 
audio on one channel, embedded audio on another, and AES/EBU on the rest.

There are several video boards that allow a Profile video server to be used with 
various standard video formats: composite analog, serial digital component, or 
component analog video are all possible. All boards accept 525 or 625 (NTSC 
or PAL) video standards.

The latest analog composite input and output board offers two input and output 
channels per board. The two output channels for this board are similar to the 
output channels of the original analog composite board. An analog composite 
monitor board allows you to display text and burn-in timecode on an output 
monitor.

The component analog input allows dithering, auto-timing, and vertical 
blanking. As with other inputs, you can automate VITC detection. You can 
adjust input gain and also select an input format such as Betacam.

A serial digital component board provides two channels of both input and 
output, plus embedded audio when used with an ASPB. You can also enable 
dithering, auto-timing, and automate VITC detection. The board also has error 
detection and handling.

The standard reference genlock board allows you to time your Profile server to 
other devices in a broadcast facility. You can lock a Profile unit to a PAL or 
NTSC reference signal (house black). The genlock board also lets you have 
LTC inputs and outputs, with four inputs and four outputs possible for each 
channel.
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Profile Software Development
The Profile Software Development Kit (SDK) provides an application 
programming interface (API) for libraries of Profile functions. We recommend 
that you call these functions via Microsoft Visual C++ 5.0; however, it is 
possible to use other languages that permit calls to C declared functions 
(contact your Grass Valley Group representative for more information). 
Software developers can use the API to control the Profile from third-party 
hardware devices, for example. The API consists of seven libraries: 

• The TekCfg library provides an interface to the Profile configuration. 
Profile Family

• The TekPdr library furnishes calls that inventory and manage movies in 
Common Movie Format (CMF), an internal file format standard for video, 
audio, and timecode. 

• The TekRem library makes it possible for a remote Windows NT system to 
control a Profile disk recorder over an Ethernet LAN. 

• The TekVdr library provides an interface for playing and recording video 
and audio clips. 

• The TekVfs library supports low-level access to individual media files in the 
media file system. 

• The TekVme library controls the optional video mix effects board. 

• The TekXfr library supports media streaming of Fibre Channel connections.

Eight RS-422 serial ports come standard on a disk recorder. A disk recorder can 
issue serial commands or receive them from an external device via RS-422 
communication lines. The Profile Protocol associates each API call with a 
specific number that can be sent over an RS-422 line. The ProLink application 
monitors Profile Protocol calls over an RS-422 link, allowing you to use 
compatible hardware devices, such as the PRC100 Control Panel, to issue 
commands to a Profile unit. 

Windows applications are also available to control the Profile system. Your 
disk recorder comes with several standard and optional applications. See 
“Starting and Closing Profile Applications” on page 31 for more information. 

NOTE: Louth and Odetics RS-422 protocols are also supported, 
although there is not a one-to-one correspondence between these 
protocols and the Profile API. Louth and Odetics protocols do not 
allow you full access to the functionality of the Profile system. 
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What to Read First
The order in which you should read the chapters of this manual depends on how 
you want to set up your Profile system. 

• Before using your Profile unit, you must first configure your video and audio 
boards. Refer to Chapter 2, “Using the Profile Configuration Manager.” 

• If you are upgrading a PDR100 to version 2.5 of Profile system software 
from version 1.4.XX or earlier, you must install enhanced disk recorder 
(EDR) boards and you must rebuild your file system. To install the EDR 
boards, you must install a field kit that is sold separately. To rebuild your file 
Profile Family

system, refer to Chapter 5, “Using the Profile Disk Utility.” Your file system 
may consist of internal disks, a disk expansion unit, or a RAID unit. 

• Once you have configured your video and audio boards, and, if necessary 
rebuilt your file system, you are ready to capture and replay video and audio 
clips. Refer to Chapter 4, “Using VdrPanel.” 

• To configure your Fibre Channel board, see Chapter 7, “Fibre Channel 
Video Networking.” 

• To read Profile logs, access your Profile system from a remote PC, or attach 
a PRC100 Profile Control Panel, refer to Chapter 6, “Using Profile Utilities.” 

• To learn how to manage media on disk or over Fibre Channel on a Profile 
network, see Chapter 3, “Using Media Manager.” 

• If want to use optional software applications, see Chapter 8, “Using the Tool 
Box Editor,” Chapter 9, “Using the List Manager,” or Chapter 11, “Using 
TimeDelay.” To allocate resources for Tool Box Editor, List Manager, and 
TimeDelay, see Chapter 10, “Using the Resource Manager.” 
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Starting Your Profile System
Once the unit is properly installed, you are ready to log in. For instructions on 
how to install and power-on a PDR100, PDR200, or PDR300 see the 
installation manual that came with the unit.

To log in automatically:

Power up the Profile unit, and the start up routine begins. During normal start 
up, you are logged in automatically and the VdrPanel application starts. You 
can hold down the Shift key during start up to interrupt the automatic log in 
process.
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NOTE: If you stop the automatic log in, or if it fails, the Windows NT 
log in dialog box appears. When logging in, remember that this 
dialog box is case-sensitive.

To manually log in:

1. At the Windows NT 4.0 log in window, enter the username: profile
(However, you must log in as administrator when installing software, 
performing Windows NT administration, starting a service, or setting an 
Ethernet IP address.) 

2. Use the Tab key to advance to the password field.

3. The password appears as asterisks (*) for password security. For the 
password, enter: profile 

4. Use the Tab key to advance to the From field. 

5. If your domain name or local computer name is not displayed in the box, 
click in the box to access a list of choices. Select your domain or local 
computer name from the list.

6. Click OK or press Enter.

NOTE: If a log in error message appears, and all the information is 
correct, try deleting the password and clicking OK.
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Starting and Closing Profile Applications
After logging into your Profile system, you see shortcut icons for the Profile 
applications on the Windows NT 4.0 desktop.
Profile Family

Figure 2. PDR Application shortcuts on the Windows NT 4.0 desktop
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Starting an Application
To start a Profile application—VdrPanel in these examples—using Windows 
NT 4.0: 

• Double-click the shortcut icon on the Windows NT desktop. 

Or: 

• Choose Start | VdrPanel. 

Or: 

• Choose Start | Programs | PDR Applications | VdrPanel. 
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To start a Profile application such as VdrPanel using Windows NT 3.51: 

1. In Program Manager, double-click the PDR Applications program group 
icon. 

2. Double-click the VdrPanel icon in the PDR Applications program group. 

Viewing Help
To view the Help for an application: 

• Choose Help | Help Topics. 

Or: 

• Click the Help button in a dialog box or a toolbar, if available. 

To view version information (for VdrPanel in this example): 

• Choose Help | About VdrPanel. 

Closing an Application
To close Profile applications: 

• Choose File | Quit, File | Exit or click the Close button. 
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Profile Configuration 
Manager
The Profile Configuration Manager 
is a graphical user interface for 
configuring reference genlock, 
system timing, video and audio 
inputs and outputs. For more 
information, refer to Chapter 2, 
“Using the Profile Configuration 
Manager.” 
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NOTE: You must configure system resources with Configuration 
Manager before using your Profile disk recorder. 

Media Manager
The Media Manager allows you to manage 
clips and masters on disk, transfer media 
between systems, and archive and restore 
clips on a library system. Refer to Chapter 3, 
“Using Media Manager.” 

Transcode Utility
The Transcode Utility, which is started from 
Media Manager, converts motion JPEG media to 
MPEG or from MPEG to JPEG. You can also 
change the video quality of a clip. Refer also to 
Chapter 3, “Using Media Manager.” 
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VdrPanel 
VdrPanel enables you to capture and 
trim video and audio clips and then 
play them back. By default, 
VdrPanel starts automatically when 
you power-on your Profile system. 
For more information, refer to 
Chapter 4, “Using VdrPanel.” 
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Profile Disk Utility 
As shipped from the factory, Profile 
media disks come preformatted and 
with a file system already created. 
Profile Disk Utility allows you to 
create new file systems, reformat 
disks, and change disk labels. To find 
out more about how to use this 
utility, refer to Chapter 5, “Using the 
Profile Disk Utility.” 

NOTE: Locked versions of the following optional applications—Tool 
Box Editor, List Manager and TimeDelay—were shipped to you with 
version 2.5 system software. You can use the software for a limited 
time only. Unlocking this software for permanent use requires an 
additional purchase. Click Purchase in the timelock dialog box for 
information on how to purchase this software.
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Tool Box Editor 
The optional Tool Box Editor lets you 
create new media by logging and 
capturing video and audio clips while 
also providing an inexpensive, cuts-
only editing system. Refer to Chapter 
8, “Using the Tool Box Editor.” 
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List Manager 
The optional List Manager allows you 
to set up simple station automation. 
You can record incoming video at 
predetermined times, send incoming 
video directly to an output, or combine 
all of these functions to increase the 
automation level of you operations. 
Refer to Chapter 9, “Using the List 
Manager.”

TimeDelay
TimeDelay allows you to delay incoming 
video by an amount of time you specify. For 
more information, see Chapter 11, “Using 
TimeDelay.” 
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Profile Utilities
• Profile Logs allow you to view Profile system logs with the graphical log 

viewer, WinTail. This log viewer allows you to see the end of a log file. To 
learn more about how to view Profile logs, see Chapter 6, “Using Profile 
Utilities.” 

• ProLink monitors Profile Protocol calls over RS-422 communication lines, 
allowing you to use a controller such as the PRC100 Control Panel to 
communicate with a Profile system. For more information on Profile 
Protocol, see the documentation that accompanies the Profile Software 
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Development Kit. 

• PortSever allows you to control a Profile unit remotely using Ethernet 
communications. For example, you can run PortServer on a remote Profile 
system so that you can control it over a LAN from another Profile or PC. 
PortServer is generally used in conjunction with Fibre Channel operations. 

• PDR Access Control is a Windows NT service that prevents one application 
from crashing another application by mistake. Though largely transparent to 
users, the service prevents applications from accidentally reloading the video 
processor while in use, essentially providing a controlled gateway to the 
processor.

• Update Firmware reprograms components on boards in your PDR200 
Video File Server, such as the Master Enhanced Disk Recorder (EDR) board. 
Updating the firmware in the selected components of these boards ensures 
that software and hardware will function together as expected. 

• Update Fibre Channel Microcode updates the microcode on Fibre Channel 
boards. 

Fibre Channel Support
You can use Fibre Channel video networking capabilities to move media from 
one Profile unit directly to another. With Media Manager, you can use the Fibre 
Channel connection to transfer media files between machines. Ethernet LAN is 
also required for transferring commands and status information. For more 
information, see Chapter 7, “Fibre Channel Video Networking.”
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Using the Profile Configuration Manager

The Profile Configuration Manager provides an easy-to-use interface that 
streamlines the set up of reference genlock, video and audio inputs and outputs, 

ing, and timecode for your Profile video disk recorder. The 
tion tree allows you to open the specific configuration dialog boxes 
l the settings. A graphic representation of the Profile rear panel at the 
system tim
configura
that contro
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bottom of the Configuration Manager window shows which boards are 
installed. The Configuration Manager window appears in Figure 3.
Profile Family

Figure 3. Profile Configuration Manager window 

Configuration tree

Profile rear panel representation

Toolbar
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To select an item from the configuration tree:

• ²The configuration tree appears on the left side of the window. Clicking on 
an entry, such as Video Input, expands the list of choices. Clicking on an 
expanded list of choices, such as if you click on Video Input a second time, 
collapses the list of choices. 

• ²A single click opens the specific dialog box, closing a previously opened 
box, if necessary. A double-click opens the specific dialog box but does not 
close any other open dialog boxes. To close all open dialog boxes at once, 
choose Window | Close All.
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All changes in a dialog box take place immediately. The Undo button will undo 
changes from the time a dialog box was opened in the current tab of the dialog 
box. The Undo button is dimmed if there is nothing to undo. The Help button 
opens context-sensitive help related to the current dialog box.

By default, the toolbar and status bar are shown in the Configuration Manager 
window. To hide the toolbar or status bar:

• Choose View | Toolbar or View | Status Bar.²

To view information about installed boards:

• Choose Help | Installed Boards Information. 
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Saving a Configuration File
It is possible to preserve a configuration for later use. You can save your current 
overall configuration in a file and then load it later. Configuration files have a 
.cfg extension. To save your current configuration in a file:

1. Choose File | Save Current Configuration. The Save As dialog box appears 
(Figure 4).
Profile Family

Figure 4. Save As dialog box for saving a configuration file 

2. Enter a file name in the File Name box—new.cfg in this example.

3. Press Enter or click Save. The current configuration is saved.
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Loading a Configuration File
To load a configuration file that has been saved previously:

1. Choose File | Load Configuration File. The Open dialog box appears 
(Figure 5).
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Figure 5. Open dialog box for loading a configuration file 

2. A message box warns you that if you load a configuration file, all open 
windows are closed. Click Yes to continue.

3. Double-click a file name in the tree or type the name of the file in the File 
Name box—new.cfg in this example.

4. Press Enter or click Open. The file is loaded as the current configuration.
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Setting Master Timecode
From the Master VITC Setting dialog box, you can conveniently view and 
change VITC settings for genlock and all available inputs and outputs. To set 
the master timecode (VITC) settings: 

1. Choose Option | Master Timecode or click the Master Timecode button on 
the toolbar. The Master VITC Setting dialog box appears (Figure 6). 
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Figure 6. Master Timecode dialog box, genlock settings
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2. The VITC Present status indicator should be on (green) if VITC is present. 
If VITC Present is not on, use one of the following options:

• ²Manual VITC detection (four-channel LTC version of the reference genlock 
board): 

- Verify Automatic VITC detect is not selected. If it is, click to toggle it. 

- Set VITC Reader Line1 to the expected location of the first Reader Line 
and VITC Reader Line2 to the second expected Reader Line. If you only 
have one VITC line, enter the same value on both Reader lines. 

- Check VITC Present. If it is still not on, use a waveform monitor to check 
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the genlock signal to make sure that VITC exists on these lines. 

• ²Automatic VITC detection only: 

- Verify Automatic VITC detect is selected. If it is not, click to toggle it. 
The Search Lines are automatically established for NTSC/525 and 
PAL/625. 

- Check VITC Present. If it is still not on, check the genlock signal to make 
sure that VITC exists and is within the expected range. 

3. For each video input that should have VITC, select it from the list: 

• ²For automatic VITC detection on analog composite and serial digital 
component signals: 

- Verify Automatic VITC detect is selected. If it is not, click to toggle it.

- Set VITC Reader Line1 to the beginning of the search line. The minimum 
line number is 6 in PAL and 10 in NTSC.

- Check for VITC Present.

• ²For manual VITC detection on analog composite and serial digital 
component signals:

- Verify Automatic VITC detect is not selected. If it is, click to toggle it. 

- Set VITC Reader Line1 and VITC Reader Line2 to the lines where VITC 
is located. If you only have one VITC line, enter the same value on both 
Reader lines. 

- Check VITC Present. If it is still not on, double check your line numbers 
and try again. 
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4. For each video output that should have VITC, select it from the list: 

• For analog composite on preexisting PDR100 and PDR200 units: 

- Verify VITC Generator Enable is checked. If not, click to toggle it. 

- Click on Vert. Interval to open the Vertical Interval Line Programming 
dialog box.

- Select the desired VITC lines by checking in the VITC Enable column for 
the line. There is not a limit on the number of VITC lines. 

- Click Close to close the Vertical Interval Line Programming dialog box. 
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• ²For serial digital component: 

- From the Serial Digital Component Video Output dialog box, set the lines 
where you want VITC in VITC Generator Line1 and VITC Generator 
Line2. 

- Verify VITC Generator Enable is checked. If not, click to toggle it. 
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Setting the System Timing
A new, factory-default PDR200 or PDR300 is configured so that:

• All outputs are zero-timed to the external reference (house black).

• Each input can lock to and record any stable video input, whether or not the 
source is genlocked to an external reference.

NOTE: Serial digital inputs (525 lines) on a PDR100 must be timed 
manually.
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To adjust system timing:

1. Choose Option | System Timing or click the System Timing button on the 
toolbar. The System Timing dialog box appears (see Figure 7 which shows 
an example of how the dialog box looks when the outputs are zero-timed by 
default).

- The red line represents the external reference, and the yellow line 
represents reference genlock.

- A hashed box represents a timing window or, in other words, the range of 
lines within which the timing is adjusted.

- The external reference, represented at the top of the dialog box, shows a 
range from –16 to +16 lines. You can scroll past this range by dragging 
the pointer on this line in either direction with the mouse.

2. Click any button to the left of the internal reference (genlock) or video output 
signal name and the timing edit box appears in the bottom left of the System 
Timing dialog box (see Figure 8 which shows the dialog box when the 
outputs are E to E timed).

3. In the timing edit box, you can adjust the number of fields (genlock only) or 
lines, and also tune these settings with course or fine adjustments. You can 
enter a number directly or click an arrow to adjust a setting. The adjustments 
and ranges available vary, depending on the type of output you have.

4. Click Close to accept the settings, Undo to return to the previous settings, 
Default to return to the default settings.

NOTE: You must restart your unit for the new system timing setting 
to take effect.
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You can also fine tune your system timing settings individually under 
Reference Genlock System Input Advanced Adjustment in the Reference 
Genlock dialog box. You can also tune individual output settings under Output 
Timing Adjustment in under Video Output.
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Figure 7. System Timing dialog box, zero-timed
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E to E Timed Outputs
In some applications, you may want to precisely switch an output from a live 
video feed to playback of recorded material. Since the live input will be delayed 
as it passes through the Profile unit, you must set a corresponding delay on the 
playback. The E to E Timed Output option sets a 16-line delay on all the system 
outputs, allowing a zero-timed input to be exactly timed with a play to air 
signal. To set all your Profile unit output for E to E operations:

1. Choose Option | System Timing or click the System Timing button on the 
toolbar. The System Timing dialog box appears.
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2. Click E to E Timed Output.

3. Click Close.

Figure 8. System Timing dialog box, E to E timed
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Adjusting the Timing when Upgrading to 2.5
If you are upgrading an existing PDR100 to system software version 2.5, your 
system timing will be left in E to E mode and no changes will be made to your 
system timing. The only difference you will see is a numeric offset of 7 lines in 
the Line setting under Reference Genlock System Input Advanced Adjustment 
in the Reference Genlock dialog box and an offset of nine lines in the Vertical 
Line Delay under Output Timing Adjustment under Video Output.

Auto Timing
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Auto-timing determines if the input is synchronized to the reference genlock 
signal. The disk recorder records time-base corrected video whether or not it is 
also locked to the reference. If auto-timing is enabled and the signal was able to 
be timed into the system, the Auto Timed indicator at the top of the video input 
dialog box is turned on.

If you want to use the disk recorder as a switcher and/or have the output video 
correctly timed when in E to E mode, the input video must be locked to the 
reference and properly timed to the disk recorder. To aid in the timing setup, all 
video inputs have auto-timing circuits which synchronize input video to the 
internal timing reference as long as the input video is within the auto-timing 
sync window (±2 lines for the latest analog composite boards, ±1 lines for all 
others). To get to the auto-timing window, input must be advanced 7 1/2 lines. 

The auto-timing circuit is always trying to lock to the signal. If you try to auto 
time a signal outside of the window, the video signal appears to be broken-up 
as it cannot be timed into the system. If the input drifts out of range, it is retimed 
as soon as it drops back into range. The disk recorder can use untimed signals 
if auto-timing is not enabled, but they are not timed correctly and may cause 
jumping and skipping in E to E mode. 

NOTE: If you select auto-timing for an input signal and it cannot 
auto time with the genlock reference signal, the input signal is not 
recorded accurately. If you must record an input that cannot lock, 
disable auto timing and then record. There may be problems if you 
are operating in E to E mode, but the clip plays back correctly timed.

If auto-timing is enabled, and the signal was able to be timed into the system, 
the Auto Timed indicator is turned on. Also, for serial digital component input, 
Line 1 can still be adjusted, but Line 2 is always equal to Line 1 + 14.
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Setting the Reference Genlock
The Reference Genlock dialog box sets the genlock parameters for VITC reader 
settings and internal reference timing. At the top of the dialog box, the status 
indicators display the current status of the genlock input: Locked to External 
Reference, Internal Clock Locked and VITC Present. A green light indicates 
that a particular status is on. These indicators cannot be edited.

To change the reference genlock settings:

1. Click or double-click Genlock from the configuration tree and the Reference 
Genlock dialog box appears (see Figure 9). 
Profile Family

Figure 9. Reference Genlock dialog box 

2. Click Automatic VITC Detect to have the Profile disk recorder use the range 
set in the From and To lines to look for the VITC (vertical interval timecode) 
signal. If the VITC signal is found, the VITC Present indicator is turned on. 
Otherwise, when you do not use Automatic VITC Detect, the disk recorder 
expects to find the VITC signals on VITC Reader Line 1 (default 10) or Line 
2 (default 12). 
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3. Use the Field, Line, and Fine entries to adjust the internal timing relative to 
the reference input. Changing this setting affects all system timing, including 
all output timing and the input synchronized timing window. Click Default 
to return to the default timing values (0,0,0).

NOTE: In order to properly time the disk recorder, the Internal 
Reference Timing should only be changed if the downstream timing 
requirements cannot be met using the video output Timing 
Adjustment (see “Video Output” on page 67). This should be done 
prior to setting individual output delay adjustments. 
Profile Family

4. Click Undo to return all values in the dialog box as they were set at the time 
the dialog box appeared.

5. Click Close to accept the changes. 
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Changing LTC Input and Output Names
The LTC (longitudinal timecode) inputs and outputs dialog box allows you to 
rename the LTC inputs and outputs.

To change an LTC name:

1. Click or double click LTC Input & Output in the configuration tree and LTC 
Input & Output dialog box appears. 
Profile Family

Figure 10. LTC Inputs & Outputs dialog box 

1. Select an LTC input or output name.

2. Position the edit cursor within the appropriate edit box.

3. Enter the new name or portion of a name.

4. The new name appears in the name list.

5. Click Undo to return the name or names as they were at the time the dialog 
box appeared.

6. Click Close to accept the new LTC name or names. 



Setting MPEG Input Timing

51

Setting MPEG Input Timing 
If you have one or more MPEG board(s) installed that have decoders only (no 
encoders) and you are running in BVW [insert edit] mode (see “Setting up 
BVW [insert edit] Emulation” on page 172), you need to obtain a timing signal 
from a video I/O board to synchronize your output. 

To select a timing input for the MPEG board: 

1. Click or double-click MPEG Board from the configuration tree and the Input 
Timing Selection dialog box appears (see Figure 11). 
Profile Family

Figure 11. MPEG Input Timing dialog box 

2. In the Input Timing box, select the board from which you want to get the 
timing signal. 

3. Click Undo to return to original input timing source. 

4. Click Close. 



Chapter 2 Using the Profile Configuration Manager

52

Video Input
You may have analog composite, component analog (CAV), or serial digital 
component video inputs installed in your Profile system. The steps to configure 
video inputs follow.

Analog Composite Video Input
The indicators at the top of the dialog box show the current status of the analog 
composite video input. The indicators are VITC Present, Input Locked, and 
Auto Timed (also Burst Present for earlier analog composite cards). A green 
Profile Family

light indicates that a status is on. These are indicators and cannot be edited. 

To configure analog composite video input:

1. Select Video Input from the configuration tree, and then click or double-
click an analog composite input from the list, such as Composite-InA-J5. The 
Analog Composite Video Input dialog box appears (Figure 12 for current 
analog composite cards and Figure 13 for earlier cards). 

Figure 12. Analog Composite Video Input dialog box, Main tab (A) 
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Figure 13. Analog Composite Video Input dialog box, Main tab (B) 

2. If you prefer, enter a new name for the input signal in the Name box. For 
example, if the signal is a network feed, you could rename it to 
Network_Feed. The VITC name, the window title bar, and the configuration 
tree name change automatically as you enter the new name. Names can be 
up to 30 characters, and can include spaces. To return a renamed signal to the 
default, delete all the characters in the text field, and press Enter. 

3. Select a video standard. Click either NTSC with pedestal, NTSC without 
pedestal, or PAL (PAL is available only with earlier cards). If you change 
the standard, restart all tools that use this channel. The board can accept only 
one input at a time. 

4. If you use Automatic VITC Detect, the Profile unit uses the range set in the 
From and To lines to look for the VITC signals. If Automatic VITC Detect 
is not checked, the system expects to find the VITC signals on the VITC 
Reader Line 1 (default 10) or Line 2 (default 12). If the signal is found, the 
VITC Present status indicator is turned on.

NOTE: Input must be auto-timed to use automatic VITC detection.
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5. If you want video input auto timed, click Enable Auto-Timing. Auto-timing 
determines if the input is synchronized to the reference genlock signal. The 
disk recorder records time-base corrected video whether or not it is also 
locked to the reference. If auto-timing is enabled, and the signal was able to 
be timed into the system, the Auto Timed indicator is turned on. For more 
information on auto timing, see “Auto Timing” on page 47.

6. Click Enable Dithering if the incoming signal is 10-bit resolution. This 
produces the best quality result. The LSB artifacts on 10-bit video feeds are 
reduced. There is no effect if the incoming signal is 8-bit. 

7. Click Vertical Blanking to enable vertical blanking. When enabled, for the 
Profile Family

525 standard, lines 1 through 9 and 264 through 272 are blanked; for the 625 
standard, lines 1 through 5, 311 through 317, 624, and 625 are blanked.

8. Adjust the input gain on the syncs to compensate for any losses in the input. 
You can adjust the gain manually or, with earlier cards, click AGC 
(Automatic Gain Control) which enables the internal quality monitoring 
circuit to automatically adjust the gain to keep the sync level constant. To 
adjust the gain manually, move the slider to the desired value. The range is 
from 71 to 141 percent (±3 dB) of the input signal. (For earlier cards, the 
range is from 45 to 142 percent (±3 dB) of the input signal for NTSC and 82 
to 142 percent for PAL.) When you click Default, the Input Gain Adjustment 
resets to the default value (100 percent). 

9. Click Undo to return the values in the dialog box to their original settings.

10. Click Close to accept all inputs. 
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Analog Composite Video Input Advanced Control
The Advanced Control tab allows you to select a decode mode, clamp speed, 
and other settings, depending on which analog composite card you have. To 
change advanced controls settings: 

1. Click or double-click on the Advanced Control tab to view it (Figure 14 
shows the dialog box for the most recent analog composite video cards while 
Figure 15 shows the dialog box for earlier cards). 
Profile Family

Figure 14. Analog Composite Video Input dialog box, Advanced Control tab (A) 
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Figure 15. Analog Composite Video Input dialog box, Advanced Control tab (B) 

2. Click a setting for decode mode. Decode mode determines how the 
chrominance and luminance information is separated for conversion for 
storage. There are three options for the current analog composite cards and 
four options for the earlier cards:

- ²Notch Filter. Decode mode separates the chrominance by using a notch 
filter around the chrominance subcarrier. This leaves the high frequency 
luminance intertwined with the chrominance. A notch decoder readily 
determines horizontal lines are line-to-line luminance. Fine vertical lines 
can be more difficult. 

- ²Comb Filter. Decode mode tries to separate high frequency luminance 
from the chrominance using the same notch filter as the notch decoder, but 
also takes information from the next line. It uses this information to 
determine if high frequency is luminance or chrominance. A comb 
decoder readily determines finely spaced vertical lines are luminance. A 
lack of line-to-line phase alteration causes difficulty with fine horizontal 
lines. 
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- ²Spatial Adaptive. Decoding uses either the comb or notch decoder, on a 
pixel by pixel basis, depending on which gives the best results. For 
horizontal lines, notch is used; for vertical lines, comb is used. 

NOTE: Spatial adaptive and temporal/spatial adaptive decoding uses 
the high or low threshold setting.

- ²Temporal/Spatial Adaptive. This is for earlier analog composite cards 
only. Decoding uses both the next line and the same line in the alternate 
field in the calculations. This decoder uses all of the properties of the 
Spatial Adaptive decoder, plus it uses Temporal (interfield changes) 
Profile Family

information. The phase change (or lack of) from field to field helps 
determine whether high frequency should be decoded as chrominance or 
luminance. The threshold determines the amount of motion allowed 
between alternate fields to still have the Temporal decoder recognize the 
pixel. High allows more motion than Low.

3. For the current analog composite card, click Enable Clamp Speed to enable 
it. Clamp speed sets the reaction to changing DC levels of the input signal. 
Speed can be either slow or fast. The fast clamp speed is more reactive to 
small DC variations. The slow speed ignores short-term DC level changes 
but gradually changes the clamping level to track the input. 

For clamp speed on earlier cards, click Adaptive, Slow, Medium, or Fast 
under the Clamp Speed group. Fast and Slow settings are the same for both 
the earlier and current cards, while Medium is a compromise between Fast 
and Slow. Adaptive uses the best clamp for the current video input. Clamp 
Speed also helps with white noise reduction. Adaptive is the best choice for 
white noise reduction. Do not use Adaptive for impulse noise, use Slow and 
the Impulse Noise Detection option from the Noise Reduction group.

NOTE: If you set AGC (audio gain control) to automatic on the main 
screen, clamp speed cannot be selected.

4. For current analog composite cards, the Vertical Interval controls set how 
vertical interval signals are handled. Move the Group Definition slider to set 
how many lines are in Groups 1 and 2. In Group 1, Notch and Pass are 
available while Blank and Pass are available in Group 2: 

- Notch applies notch filtering to the vertical interval video line. This 
means that chrominance information and any luminance around the 
chroma subcarrier are removed.
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- Pass indicates that the vertical video line is passed-through.

- Blank indicated that line the group are blank.

5. Under Noise Reduction (earlier analog composite cards only), the controls 
enable and set various noise reduction methods: 

- Click ²Enable Luma and Chroma Reduction. This applies the Level and 
Threshold settings to use a feedback noise reduction scheme on the 
decoded input signals after they have been separated into chrominance 
and luminance. The Level and Threshold sliders determine the amount of 
weight the feedback signal has in comparison to the input signal. The 
Profile Family

Threshold range takes into consideration the amount of motion in the 
picture. Use the sliders to adjust the ranges. Be sure Enable Luma and 
Chroma Reduction is checked for the reduction values to be applied.

- Click Enable Quiet Line, if desired. This acts as a noise reference. If the 
Quiet line is noise-free, the rest of the signal should also be noise-free. 
This allows the decoder to not mistake noise for motion. If the Quiet Line 
is enabled, the line values for Field 1 and Field 2 are used. Use the sliders 
to set the line values for each field. Click on Default Lines to return to the 
default values.

- Enable Impulse Noise Reduction automatically filters out noise spikes, 
such as amplifier crackling. 

NOTE: If reduction of impulse noise is selected, the disk recorder 
automatically switches the clamp speed to slow. It is recommended 
that you use the spatial adaptive decode option, although it does not 
automatically switch. 

6. Click Undo to return the values in the dialog box to their original settings.

7. Click Close to accept all inputs. 
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Analog Composite Video Input Time Base Correction
The Time Base Correction tab is available only on the newer analog composite 
cards. To select the settings:

1. Click the TBC Selection tab (see Figure 16). 
Profile Family

Figure 16. Analog Composite Video Input dialog box, Time Base Correction tab 

2. When you select Time Base Correction, you can select either composite 
input or Super VHS (SVHS or S-video) input. There are two channels 
available for the most recent analog composite video input board. If Time 
Base Correction is selected in channel A, channel B is unselected, and vice 
versa. 

3. Click Undo to return the values in the dialog box to their original settings.

4. Click Close to accept all inputs. 
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Analog Composite Video Input Vertical Interval
For earlier analog composite cards, the controls under the Vertical Interval tab 
sets how the vertical interval signals are handled. This tab is visible only if you 
have an older card in your Profile unit. For the most recent cards, the vertical 
interval settings are handled under the Advanced Control tab. There are 
different vertical interval line numbers in the dialog boxes, depending on your 
video standard—NTSC/525 or PAL/625. To change vertical interval settings:

1. Click or double-click on the Vertical Interval tab (see Figure 17). 
Profile Family

Figure 17. Analog Composite Video Input dialog box, Vertical Interval tab 
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2. Move the sliders for each individual line to select Normal, Notch, Pass on 
Y, or Delete. 

- ²Normal indicates the vertical interval video line is passed-through.

- ²Notch applies notch filtering to the vertical interval video line 
(chrominance information and any luminance around the chroma 
subcarrier are removed). 

- Pass On Y passes luminance information straight through. This is useful 
for VITC and closed-caption or data filtering. 

- Delete removes the vertical interval video line and replaces it with black.
Profile Family

3. Click Undo to return the values in the dialog box to their original settings.

4. Click Default to return all values to their default values.

5. Click Close to accept all inputs. 
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Analog Component Video Input
You can configure analog component video (CAV) input with the Analog 
Component Video Input dialog box. The current status indicators, shown at the 
top of the dialog box, are Video Present, VITC Present, and Auto Timed. The 
green light indicates that a particular status is on. These indicators cannot be 
edited.

To configure analog component video input:

1. Select Video Input from the configuration tree, and then click or double-
click an analog component input from the list, such as CAV-InA-J9. The 
Profile Family

Analog Component Video Input (CAV) dialog box (Figure 18). 

Figure 18. Component Analog Video Input dialog box (CAV) 

2. If you prefer, enter the new name in the Name box. For example, if the signal 
is a Betacam input, you could rename it to Betacam_1. The VITC name, 
window title bar name, and the configuration tree name automatically 
change as you enter the new name. Names can be up to 30 characters, and 
can include spaces. To return a renamed signal to the default, delete all the 
characters in the text field, and press Enter.
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3. Under Overwritable Video Standard, click either 525 Video Standard or 
625 Video Standard. If you change this standard, you must restart all tools 
that use this channel. The video input board can serve both standards, but the 
input can only accept one at a time.

4. Select a VITC reader setting. If you to use Automatic VITC Detect, the disk 
recorder uses the range set in the From and To lines to look for the VITC 
signals. If Automatic VITC detect is not used, the disk recorder expects to 
find the VITC signals on the VITC Reader Line 1 (default 10) or Line 2 
(default 40). If the signal is found, the VITC Present indicator is turned on. 

NOTE: Input must be auto timed to use automatic VITC detection.
Profile Family

5. To change Input Gain Adjustment, move the slider to the desired value. The 
range is from 70 percent to 140 percent (3 dB) for the input signal for both 
525 and 625. When you click on Default, the Input Gain Adjustment resets 
to the default value (100 percent).

6. If you want video input auto timed, click Enable Auto-Timing. Auto-timing 
determines if the input is synchronized to the reference genlock signal. The 
disk recorder records time-base corrected video whether or not it is also 
locked to the reference. If auto-timing is enabled, and the signal was able to 
be timed into the system, the Auto Timed indicator is turned on. For more 
information on auto timing, see “Auto Timing” on page 47.

7. Click Enable Dithering if the incoming signal is 10-bit resolution. This will 
produce the best quality result. The LSB artifacts on 10-bit video feeds are 
reduced. There is no effect if the incoming signal is 8-bit. 

8. Click Vertical Blanking to enable vertical blanking. When enabled, for the 
525 standard, lines 1 through 9 and 264 through 272 are blanked; for the 625 
standard, lines 1 through 5, 311 through 317, 624, and 625 are blanked.

9. Click an appropriate format under Select Video Input Format. 

10. Click Undo to return the values in the dialog box to their original settings.

11. Click Close to accept all inputs. 
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Serial Digital Component Video Input
You can configure serial digital component video input with the Serial Digital 
Component Video Input dialog box. The current status indicators, shown at the 
top of the dialog box, are Video Present, VITC Present, and Auto Timed. The 
green light indicates that a particular status is on. These indicators cannot be 
edited.

To configure serial digital component video input: 

1. Select Video Input on the configuration tree, and then click or double-click 
a digital component input from the list, such as SDI-InA-J13. The Serial 
Profile Family

Digital Component Video Input dialog box appears (Figure 19). 

Figure 19. Serial Digital Component Video Input dialog box 

2. If you prefer, enter the new signal name in the Name box. For example, if 
SDI-InA-J13 is a dedicated satellite feed, you could rename it to Satellite_1. 
The VITC name, window title bar name, and the configuration tree name 
automatically change as you enter the new name. Names can be up to 30 
characters, and can include spaces. To return a renamed signal to the default, 
delete all the characters in the text field, and press Enter.
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3. Under Overwritable Video Standard, click either 525 Video Standard or 
625 Video Standard. If you change this standard, you must restart all tools 
that use this channel. The video input board can serve both standards, but the 
input can only accept one at a time. 

4. Select a VITC reader setting. If you to use Automatic VITC Detect, the disk 
recorder uses the range set in the From and To lines to look for the VITC 
signals. If Automatic VITC detect is not used, the disk recorder expects to 
find the VITC signals on the VITC Reader Line 1 (default 10) or Line 2 
(default 12). If the signal is found, the VITC Present indicator is turned on. 
Line 1 and Line 2 cannot be more than 14 lines apart. 
Profile Family

NOTE: Input must be auto timed to use automatic VITC detection. 

5. If you want video input auto timed, click Enable Auto-Timing. Auto-timing 
determines if the input is synchronized to the reference genlock signal. The 
disk recorder records time-base corrected video whether or not it is also 
locked to the reference. If auto-timing is enabled, and the signal was able to 
be timed into the system, the Auto Timed indicator is turned on. For more 
information on auto timing, see “Auto Timing” on page 47. 

6. Click Enable Dithering if the incoming signal is 10-bit resolution. This will 
produce the best quality result. The LSB artifacts on 10-bit video feeds are 
reduced. There is no effect if the incoming signal is 8-bit. 

7. Click Undo to return the values in the dialog box to their original settings. 

8. Click Close to accept all inputs. 
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Serial Digital Component Video Input Advanced
The Advanced tab allows you to determine whether the EDH (Error Detection 
and Handling) packet is present, which audio groups (1–4) are present, and 
which errors are present: Full Field (FF) CRC or Active Picture (AP) CRC, plus 
parity and checksum errors.

To reset EDH for serial digital video input: 

1. Click the Advanced tab to view the Serial Digital Component Video Input 
Advanced settings.
Profile Family

Figure 20. Serial Digital Component Video Input, Advanced 

2. Click Reset FF CRC to reset Full Field errors or Reset AP CRC to reset 
Active Picture errors. 

3. Click Undo to undo the resets.

4. Click Close to exit. 
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Video Output
You can configure either analog composite or serial digital component video 
output on your Profile system, depending on which boards are installed.

Analog Composite Video Output
To open the Analog Composite Video Output dialog box:

1. Select Video Output from the configuration tree and click or double-click an 
analog composite output from the list, such as Composite-OutA-J11. The 
Analog Composite Video Output dialog box appears (see Figure 21). 
Profile Family

Figure 21. Analog Composite Video Output dialog box 

2. ²Enter a new name in the Name box to change the signal name. For example, 
if this is a dedicated signal to a main switcher, rename it Switcher_1. The 
VITC Name automatically tracks the signal name and cannot be edited. 
Names can be up to 30 characters, and can include spaces. To return a 
renamed signal to the default, delete all the characters in the text field, and 
press Enter.
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3. Click VITC Generator Enable to place VITC on specified lines in the 
vertical interval, as specified under VITC Generator Settings in analog 
composite video input. 

4. Click NTSC with Pedestal to set the video output to NTSC with pedestal. 

5. Under Timing Adjustment, you can adjust the timing of the output signal to 
compensate for any additional delays in your system. Any changes you make 
in this group take place immediately. You can delay at the following levels, 
to get the exact amount of delay required:

- ²Vertical Line level (from –2 to +148 lines)
Profile Family

- ²Coarse Horizontal level (from –100 to +100 ms)

- ²Fine Horizontal level (from –100 to +100 ms)

Use the Line, Course, or Fine boxes to set the timing adjustment amounts. 
When the timing adjustments are done with a waveform monitor, you can 
visually move the signal so that it matches the reference. Click Default to 
reset the values to 0, which is the point where the output signal timing is 
aligned with the reference genlock signal.

6. Under Procamp Adjustment, you can modify the output signal to 
compensate for any irregularities in the signal path. All changes take place 
immediately.

- Enable Procamp must be checked before anything in this group can be 
adjusted. This enables you to setup the Procamp and then disable it 
without losing the setup.

- ²Luminance (enabled) specifies only the luminance portion of the signal 
is output. The signal is black and white.

- ²Gaussian Chroma Filter determines the type of filter used on the 
chrominance portion of the signal. If the Gaussian Chroma Filter is 
selected, the filter has a long slow roll-off to prevent ringing. If it is not 
selected, then a brickwall filter is used. Although this may introduce 
ringing into the signal, it maintains the integrity of the signal for multiple 
processing. Use the Gaussian Filter as a last step before transmission and 
if ringing suppression is required. Do not use this filter if you are doing 
multiple processes/passes on the signal or if the material is in component 
form.



Analog Composite Video Output

69

The Procamp controls are adjusted with either the slider bars or arrow 
buttons. The corresponding numeric values are displayed in the text boxes.

- ²Video Gain raises or lowers the overall amplitude of the video signal. It 
has a range of 50 to 200 percent of nominal. 

- ²Chroma Gain changes the amplitude of the chrominance portion of the 
signal to change the color intensity. It has a range of 50 to 200 percent of 
nominal.

- Black Level sets the voltage level of the reference black level. This is 
expressed in mV in the PAL video standard and in IRE units in NTSC. 
Profile Family

The range in the PAL standard is –140 to 140 mV. The range in the NTSC 
standard is –20 to +20 IRE.

- Chroma Phase sets the colors by varying the phase of the chrominance 
subcarrier. The range is –45 to +45.

- ²Luminance Black Clip Level is the point where the procamp clips the 
luminance portion of any video that drops below this level. For PAL, the 
range is –150 mV to 0 mV and –20 IRE to 7.5 IRE (or 0 IRE if pedestal 
is not selected) in the NTSC standard.

- ²Luminance White Clip Level follows the same logic, only it clips any 
luminance above the set threshold. Its range in the PAL standard is 700 to 
909.5 mV and 100 to 139.5 IRE in the NTSC standard.

- ²Default Procamp resets the Procamp to the factory-defined levels. 

7. Click Undo to return the values in the dialog box to their original settings.

8. Click Close to accept the changes. 
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Analog Composite Video Output Vertical Interval
The Vertical Interval tab brings up the analog composite video output vertical 
interval controls that determine how the vertical interval signals are handled: 

1. Click the Vertical Interval tab to view the vertical interval controls. The 
vertical interval line numbers change depending on the selected video 
standard (see Figure 22). 
Profile Family

Figure 22. Analog Composite Video Input Vertical Interval tab 

2. Click in the boxes for each line to enable Procamp (the settings are the same 
as the regular video), VITC (if VITC Generator Enable is selected), or to 
Pass Video through. All or none of the options can be selected for each line. 
The default buttons for Procamp, VITC, and Pass Video reset these specified 
values back to the factory presets. 

NOTE If the Pass Video box is not checked, the input video is 
replaced with black. Do not check Pass Video for VITC lines as Pass 
Video overrides VITC insertion.

3. Click Undo to return the values in the dialog box to their original settings.

4. Click Close to accept the changes. 



Analog Composite Monitor Output

71

Analog Composite Monitor Output
To open the Analog Composite Monitor Output dialog box:

1. Select Video Output from the configuration tree, and then click or double-
click a monitor output from the list, such as Monitor-Out-J12. The Analog 
Composite Monitor Output dialog box appears (see Figure 23).
Profile Family

Figure 23. Analog Composite Monitor Output dialog box, Main tab 

2. Enter a new name in the Name box to change the signal name. For example, 
you could rename it to Monitor_1. Names can be up to 30 characters, and can 
include spaces. To return a renamed signal to the default, delete all the 
characters in the text field, and press Enter.

3. Click Show Text to display text on an attached monitor. Displaying text on 
a monitor is good way to help identify where the output is coming from. 

4. Under Text Layout, you can select either a small or large font, a dim or 
bright white character display, and a transparent or opaque background for 
the lettering. With the small font, you get twelve lines and twenty-four 
columns; with the large, you get six lines and thirteen columns.
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5. To enter text, click in the text entry box and start typing where you want the 
text displayed on the monitor. Legal characters are: a-z A-Z 0-9 / ! ? + - = ( 
) < > ‘ “ . , . Use _ (underbar) for transparent space. 

6. To clear entire monitor, click Clear Display. Click the button again to 
display text once more. Under Windows NT 3.51, this button appears as a 
check box.

7. Click Undo to return the values in the dialog box to their original settings.

8. Click Close to accept the changes. 
Profile Family
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Analog Composite Monitor Output Burn-in Timecode 
To display burn-in timecode:

1. Click the Burn-in Timecode tab to bring up the controls for displaying burn-
in timecode on the monitor (see Figure 24).
Profile Family

Figure 24. Analog Composite Monitor Output dialog box, Burn-in Timecode tab 

2. To display timecode on an attached monitor, select Show/Hide Window. 

3. To display a large timecode window, select Large Window Size. 

4. Under Window Position, select the Start Row and Start Column for the 
timecode with the sliders. This determines where the timecode is displayed 
on the monitor screen. The current row and column are displayed on the 
right.

5. You can display the timecode in one of four formats. Click on Black on 
White, White on Black, Black on Background, or White on Background. 

6. Click Undo to return the values in the dialog box to their original settings.

7. Click Close to accept the changes. 
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Serial Digital Component Video Output
To open the Serial Digital Component Video Output dialog box:

1. Select Video Output from the configuration tree, and then click or double-
click a digital component output from the list, such as SDI-OutA-J5. The 
Serial Digital Component Video Output dialog box appears (see Figure 25). 
Profile Family

Figure 25. Serial Digital Component Video Output dialog box 

2. Enter a new name in the ²Name box to change the signal name. For example, 
if the signal named SDI-OutA-J13 is a dedicated signal to a main switcher, 
you could rename it to Switcher_1. The VITC name automatically tracks the 
signal name. Names can be up to 30 characters, and can include spaces. To 
return a renamed signal to the default, delete all the characters in the text 
field, and press Enter.

3. Under VITC Generator Setting, you can place VITC (vertical interval 
timecode) on specified lines and/or erase lines in the vertical interval. 

- If VITC Generator Enable is selected, VITC is placed on the lines given 
in VITC Generator Line 1 and 2. If you only want one line, use the same 
number for both.
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- If VITC Erase Enable is selected, it removes any VITC that may have 
been recorded previously. Without enabling VITC erase, previous VITC 
may or may not be overwritten, so it is best to enable it. The range of lines 
is determined by the Start and End values. 

4. Under Timing Adjustment you can set the timing of each output with 
respect to the reference genlock internal reference timing which, in turn, is 
set with respect to the external reference input (house black). With the 
reference genlock timing set to the factory default of 0, the outputs have an 
adjustment range of –2.5 lines to +148 lines of delay. The Fine delay is in 
pixels and the Line delay is in lines. 
Profile Family

5. Click Undo to return the values in the dialog box to their original settings.

6. Click Close to accept the changes. 
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Serial Digital Component Video Output Advanced
To change error detection settings for serial digital video output: 

1. Click the Advanced tab to view the Serial Digital Component Video Output 
Advanced settings (see Figure 26).
Profile Family

Figure 26. Serial Digital Video Output dialog box, Advanced tab 

2. Click Insert EDH Packets to insert Full Frame CRC and Active Picture 
CRC into the video stream.

3. Click Blank Ancillary Data to insert ancillary data information into the 
video stream.

4. Click Undo to return the values in the dialog box to their original settings.

5. Click Close to accept the changes. 
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PDR100 Audio
The PDR100 supports both analog and serial digital embedded (625 only) 
audio inputs and outputs, depending on which boards are installed your the 
PDR100 system. Audio in the PDR100 is routed using the EISA bus with data 
flow controlled by a real time controller and the audio interface card. 

The analog audio card is capable of converting four channels of analog audio to 
digital audio (and vice versa) using 16-bit/48kHz conversion. The input and 
output data flow to the card via the EISA bus, with sample clocks coming from 
a video interface card, such as the analog composite board or the SDI board. 
Profile Family

However, the analog audio card can only have one clock operating at a time. If 
the card is used as an input device, it must have the clock that originates on the 
video board associated with the audio. 
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Analog Audio Input
To open the Analog Audio Input dialog box:

1. Select Audio Input from the configuration tree, and then click or double-
click an analog audio name from the list, such as Analog-InA-J8. The dialog 
box appears, as shown in Figure 27.
Profile Family

Figure 27. Analog Audio Input dialog box 

2. Enter a new name in the Name box. For example, you could change the 
signal name from Analog-InA-J8 to Audio One. Signal names can be up to 
30 characters long, and can include spaces. The window title bar name and 
the configuration tree name automatically change as you enter the new name. 
To return a renamed signal to the default, delete all the characters in the text 
field, and press Enter.

3. ²Click System Clock or Record Clock to select the audio record clock 
source. 

4. ²Related Audio Channels lists the audio channels that are related to the 
current signal name.

5. Click Undo to return the values in the dialog box as they were set at the time 
the dialog box appeared.

6. Click Close to accept the changes.
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Digital Audio Input
To open the Digital Audio Input dialog box:

1. Select Audio Input from the configuration tree, and then click or double-
click a digital audio name from the list, and the Digital Audio Input dialog 
box appears (see Figure 28). 
Profile Family

Figure 28. Digital Audio Input dialog box 

2. ²Audio Groups Present shows four status indicators, one per audio group. 
The green light indicates that the particular status is on. These indicators 
cannot be edited. 

3. Enter a new name in the Name box to change the signal name—Audio_1, for 
example. Names can be up to 30 characters, and can include spaces. The 
window title bar name and the configuration tree name automatically change 
as you enter the new name. To return a renamed signal to the default, delete 
all the characters in the text field, and press Enter. 

4. Associated Video Input Channel lists the name of the digital component 
video input channel associated with the audio signal. 
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5. Related Audio Channels lists the audio channels that are related to the 
signal name. 

6. Select an audio group. You can either click Automatic Group Select or 
click the button associated with the group (1–4) in the Selected Audio 
Receive Group. 

7. ²Selected Group Status represents parity error and check sum error with a 
status indicator for each. The green light indicates an error condition. These 
indicators cannot be edited. 

8. Click Undo to return the values in the dialog box as they were set at the time 
Profile Family

the dialog box appeared.

9. Click Close to accept the changes.
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Analog Audio Output
To change the analog audio output signal name:

1. Select Audio Output from the configuration tree, and then click or double-
click an analog audio name from the list.
Profile Family

Figure 29. Analog Audio Output dialog box 

2. Enter a new name in the Name box to change the signal name—
Audio_Out_1, for example. Names can be up to 30 characters, and can 
include spaces. The window title bar name and the configuration tree name 
automatically change as you enter the new name. To return a renamed signal 
to the default, delete all the characters in the text field, and press Enter.

3. ²Related Audio Channels lists the audio channels that are related to the 
signal name.

4. Click Undo to return the signal name to its original name. 

5. Click Close. 
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Digital Audio Output
To change the digital audio signal name and transmit group: 

1. Select Audio Output from the configuration tree, and then click or double-
click a digital audio name from the list.
Profile Family

Figure 30. Digital Audio Output dialog box 

2. Enter a new signal name in the Name box—Audio_Out_1, for example. 
Names can be up to 30 characters, and can include spaces. The window title 
bar name and the configuration tree name automatically change as you enter 
the new name. To return a renamed signal to the default, delete all the 
characters in the text field, and press Enter.

3. ²Click a group name (1–4) under Audio Transmit Group to change the audio 
transmit. 

4. Associate Video Output Channel lists the name of the associated video 
output channel. 

5. ²Related Audio Channels lists the audio channels that are related to the 
signal name. 

6. Click Undo to return the signal name to its original name. 

7. Click Close. 
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PDR200 Audio
The PDR200 audio architecture accepts and simultaneouly processes sixteen 
audio inputs and outputs at up to four simultaneous clock rates. Internally, all 
audio is processed in floating point at 48kHz with a selectable storage 
resolution of 16 or 20 bits. Inputs may be individually clocked in groups of four, 
and any clock group may be referenced to the system reference (house black) 
or any one of four video inputs. Output clocking is synchronous to system 
reference. Sample rate conversion is available for all inputs (30 to 50kHz), 
providing uniform storage at 48kHz.

The PDR200 can be configured to operate with analog, AES/EBU digital, or 
Profile Family

embedded (SMPTE 272M Level A) audio, depending on which options are 
installed in your system. All three audio formats are supported without external 
conversion equipment. Analog audio is only available with an optional 
PAC208 or PAC216 Analog/Digital Interface chassis. You can expand the 
number of XLR or BNC connectors for AES/EBU audio with an optional 
XLR216 or BNC216 Digital Interface chassis.You can choose an audio format 
for each video channel. For example, you could enable analog audio on one 
channel, embedded audio on another, and AES/EBU on the rest.

NOTE: Do not turn off sample rate conversion or use AES/EBU as a 
reference unless you are certain that all inputs and outputs are 
synchronous.
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Analog Audio Input
In analog audio input, you can change audio channel names, check the channel 
overload status, or adjust line levels in decibels. Click Undo to cancel changes, 
or click Help for context-sensitive Help. To configure analog audio input:

1. Expand Audio Input, and then click one of the Analog Channels. The 
Analog Audio Input dialog box appears (Figure 31). The channel numbers 
on the left refer to the physical input connectors on the audio input box. Ch. 
01 refers to the first connector, and Ch. 02 refers to the second connector, 
and so forth.
Profile Family

Figure 31. Analog Audio Input dialog box, Main tab

2. Click the Main tab, if it is not already visible.

3. Click in the box of the input channel whose name you want to change. A 
channel name can have up to 30 characters.

4. After you have changed the channel names, click Close or another tab.
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To trim the line level or view overload status:

1. In the Analog Audio Input dialog box, click the Line Level tab (Figure 32).
Profile Family

Figure 32. Analog Audio Input dialog box, Line Level tab

2. The line level range is –12 to +12 dB. If you trim the line level for an 
individual channel with the slider handle, the line level is incremented by 1 
dB; clicking on either side of the slider handle increments the line level by 
0.5 dB. The Level boxes show the current line level. If you enter a number 
directly into a Level box, the line level number is rounded to the nearest ±0.5 
dB.

3. To adjust the trim for all channels at once, use the Group Fader slider. While 
the Group Fader moves all channels at once, it maintains the individual 
channel differences.

4. If a channel is overloaded, the Overload indicator is on. This means that the 
incoming audio is clipping.

5. After you have adjusted the line levels, click Close or another tab.
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Digital Audio Input
In digital audio input, you can change channel names, check the status of 
channel errors, and change the setting of the sample rate converter. Click Undo 
if you want to cancel any changes, or click Help for context-sensitive Help.

To configure digital audio input:

1. Expand Audio Input, and then click one of the Digital Channels to bring up 
the Digital Audio Input dialog box (Figure 33). The channel numbers on the 
left refer to the physical input connectors on the audio input box. Ch. 01 and 
Ch. 02 refer to the channel pair on the first connector, and Ch. 03 and Ch. 
Profile Family

04 refer to the pair on the second connector, and so forth.

Figure 33. Digital Audio Input dialog box, Main tab 

2. Click the Main tab, if it is not already visible.

3. Click in the box of the input channel whose name you want to change. A 
channel name can have up to 30 characters.

4. After you have changed the channel name or names, click Close or another 
tab.
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To check the status of digital input channels:

1. In the Digital Audio Input dialog box, click the Status tab. Under Status 
Indicators, you see the error status of each channel. If a channel has an error, 
the indicator is on. See Table 2 for a description of each error indicator. 
Profile Family

Figure 34. Digital Audio Input dialog box, Status tab 

2. When you are done checking for errors, click Close or another tab.

Table 2. Digital audio input channel indicators 

Indicator Description

Unlocked Error Receiver unlocked

Validity Error AES receiver validity

Parity Error Parity error

CRC Error CRC subframe errors

Emphasis Detected emphasis
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If you want to bypass the sample rate converter:

1. In the Digital Audio Input dialog box, click the Sample Rate Converter tab 
(Figure 35). By default, the sample rate converter is enabled. The sample rate 
converter affects all four channel inputs. 
Profile Family

Figure 35. Digital Audio Input dialog box, Sample Rate Converter tab

2. Click Bypass Sample Rate Converter.

NOTE: Do not bypass sample rate conversion unless you are certain 
that all inputs and outputs are synchronous.

3. After you have disabled the sample rate converter, click Close or another 
tab.
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Analog Audio Output
In analog audio output, you can change audio channel names, change line 
modes for XLR connectors, or adjust individual or group line levels in decibels. 
Click Undo if you want to cancel any changes, or click Help for context-
sensitive Help.

To configure analog audio output:

1. Expand Audio Output, and then click one of the Analog Channels to bring 
up the Analog Audio Output dialog box. The channel numbers on the left 
refer to the physical output connectors on the audio output box. Ch. 01 refers 
Profile Family

to the first connector, and Ch. 02 refers to the second connector, and so forth.

Figure 36. Analog Audio Output dialog box, Main tab

2. Click the Main tab, if it is not already visible.

3. Click in the box of the output channel whose name you want to change. A 
channel name can have up to 30 characters.

4. After you have changed channel name(s), click Close or another tab.



Chapter 2 Using the Profile Configuration Manager

90

To change line modes for the XLR connectors:

1. In the Analog Audio Output dialog box, click the Line Mode tab (Figure 37).
Profile Family

Figure 37. Analog Audio Output dialog box, Line Mode tab

2. In the Line Mode box, you have three options: Balanced (default), 
unbalanced Pin 2 Low, or unbalanced Pin 3 Low. The illustrations of the 
XLR connectors to the left of the box give visual cues of the selected mode.

3. After choosing a line mode or modes, click Close or another tab.
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To trim the line level:

1. In the Analog Audio Output dialog box, click the Line Level tab (Figure 38).
Profile Family

Figure 38. Analog Audio Outputs dialog box, Line Level tab 

2. The line level range is –12 to 0 dB. If you trim the line level for an individual 
channel with the slider handle, the line level is incremented or decremented 
by 1 dB; clicking on either side of the slider handle changes the line level by 
0.5 dB. The Level boxes show the current line level. If you enter a number 
directly into a Level box, the line level number is rounded to the nearest 0.5 
dB.

3. To adjust the trim for all channels at once, use the Group Fader slider. While 
the Group Fader moves all channels at once, it maintains the individual 
channel differences.

4. To mute a channel, click the mute button next to the channel name.

5. After you have adjusted the line levels, click Close or another tab.
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Digital Audio Output
You can change the names of the digital audio channels. Click Undo if you 
want to cancel any changes. Click Help for context-sensitive Help on digital 
audio output.

To change a channel name:

1. Expand Audio Output, and then click one of the Digital Channels to bring up 
the Digital Audio Output dialog box (Figure 39). The channel numbers on 
the left refer to the physical output connectors on the audio output box. Ch. 
01 and Ch. 02 refer to the channel pair on the first connector, and Ch. 03 and 
Profile Family

Ch. 04 refer to the pair on the second connector, and so forth.

Figure 39. Digital Audio Output dialog box

2. Click in the box of the output channel whose name you want to change. A 
channel name can have up to 30 characters.

3. After you have changed the channel name or names, click Close.
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Audio Configuration for the PDR200
The Audio Configuration dialog box shown in Figure 40 allows you to 
configure input and output channels, input clocking, audio quality and monitor 
channels. 

Input and Output Mapping
The Input Mapping tab is used for mapping input sources to Profile channels, 
while the Output Mapping tab is used for mapping Profile channels to output 
destinations. For example, you can map Profile Audio Chassis (PAC) input 
sources and serial digital audio input sources. Figure 40 and Figure 41 illustrate 
Profile Family

a sample configuration: a Profile unit with an audio signal processing board, a 
PAC 208 chassis (with A/D and D/A convertors and connectors for eight 
channels), and two serial digital cards providing eight analog audio channels, 
eight digital audio channels, and four video channels with 16 embedded audio 
channels each. 

Figure 40. Audio Configuration dialog box, Input Mapping tab 
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Figure 41. Audio Configuration dialog box, Output Mapping tab 

The columns represent the sources to the sixteen channels on the input side and 
the destinations from the sixteen channels on the output side. The examples in 
Figure 40 and Figure 41 illustrate the system with a PAC 208 chassis allowing 
the selection of analog channels 1–8 and digital channels 9–16. A PAC 216 
chassis, however, provides sixteen analog inputs and outputs or sixteen digital 
inputs and outputs. For the PAC 208, rows 9 through 16 of the analog channel 
column, and rows 1 through 8 of the AES/EBU channel column, are cross-
hatched to indicate that these channels are not selectable. In Figure 41, in the 
column labeled AES/EBU, rows 9–16 appear dimmed, indicating that this 
audio type is always mapped and cannot be unmapped. Attempting to remap 
this section results in an error message.

The number of columns in the mapping grid depends on the number of possible 
input or output audio types that may be mapped to or from the disk recorder 
channels. The grid is used for selecting which of the possible input or output 
audio sources and destinations to map to the channels. Audio channels are 
mapped in groups of four channels only, and the four audio channels are always 
mapped to consecutive disk channels. For example, analog channels 1–4 (Input 
01–Input 04) in the first column of Figure 40 are mapped to the first four disk 
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recorder channels (Ch. 01–Ch. 04), while digital channels 9–12 (Input 09–Input 
12) in Figure 41 are mapped to another four disk recorder channels (Ch. 09– Ch. 
12). 

In another example, channels 1–4 may be mapped to analog, channels 5–8 
mapped to AES/EBU, and so forth. In addition, analog and AES/EBU audio 
types have an assigned one-to-one mapping to their respective channels, that is, 
input 1 always maps to channel 1, input 2 to channel 2, and so on. 

Serial digital embedded audio contains sixteen audio channels grouped into 
four groups of four channels. Each group can be assigned to any group of four 
channels. For example, group 1 (Grp1) may be assigned to channels 1–4 (Ch1–
Profile Family

Ch4), 5–8 (Ch5–Ch8), 9–12 (Ch9–Ch12), or 13–16 (Ch13–Ch16). However, a 
maximum of two of the four groups from a serial digital video source may be 
used simultaneously. 

Input Mapping

The Input Mapping tab is used for mapping input channels to Profile disk 
channels. The channels must be mapped to an audio type (analog, SDI, or 
AES/EBU) at all times—there is no unmapped state for input mapping. 
However, channels may only be mapped to one audio type at a time. Analog and 
AES/EBU channels must always be mapped directly to the same physical 
channel numbers. 

To map input channels: 

1. Choose Option | Audio Configuration Board 1 or 2 or click an ASPB 
Configuration button. The Audio Configuration dialog box appears (Figure 
40). 

2. Click the Input Mapping tab. 

3. Click on a button in a column. This displays a list containing analog, 
AES/EBU, or SDI audio groups. Unavailable audio groups appear dimmed.

4. Click on the group of channels you want. Any single group of AES/EBU 
channels may be mapped to any group of disk channels. 

5. Click OK to accept your changes or click another tab. 
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Output Mapping

The Output Mapping tab is used for mapping Profile disk channels to output 
destinations. If analog or AES/EBU audio types are present, they are always 
mapped to their associated channels. These audio types cannot be unmapped. 
Channels may be mapped to multiple audio types, but of these only one can be 
a serial digital embedded or SDI audio type. 

To map output channels: 

1. Choose Option | Audio Configuration Board 1 or 2 or click an ASPB 
Configuration button. The Audio Configuration dialog box appears (Figure 
Profile Family

41). 

2. Click the Output Mapping tab. 

3. Click on a button in a column. This displays a list containing analog, 
AES/EBU, or SDI audio groups. Unavailable audio groups appear dimmed. 

4. Click on the group of channels you want. The audio channel may be mapped 
to any of the outputs in groups of four. 

5. Click OK to accept your changes or click another tab. 

Input Clocking
The Input Clocking tab is used for assigning video input clocking sources to 
input audio channels. The first column on the left side of the dialog box displays 
the disk recorder channel numbers. The last column shows the audio clock 
reference source selection (Figure 42). 

You get one system reference by default from the Reference Genlock boards, 
and up to four video input references, depending on which video boards are 
installed in your Profile unit. Even if more than four video references are 
available, only the first four input clocking references are used. If you look at 
the bottom of the Configuration Manager window, you see a graphic 
representation of the installed boards. A key to the board representations is 
shown in Table 3. 
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The video references shown in the Input Clocking tab—Video Input 1–4 —

Table 3. Board representation key 

Board Tag Board Type
No. of Video 
References

Vid I/O SDI VA Serial digital component video 2

Vid I CAV Component analog video 1

Vid I Cmpst Analog composite video 1
Profile Family

correspond to the actual video boards installed, from left to right, as represented 
at the bottom of the Configuration Manager window. 

For example, a system that does not use all four available clock references 
might be configured like this. In this specific example, shown in Table 4, you 
have one analog composite board and one component analog board. The panel 
in the tab shows System, Video Input 1, and Video Input 2.  

In the next example, a system that uses all four available clock references might 
be configured with two serial digital component boards. In this specific 
example, shown in Table 5, the panel in the tab shows System, Video Input 1, 
Video Input 2, Video Input 3, and Video Input 4. 

Table 4. Configuration example, two video input clocking sources 

Board Tag Board Type Board 
Reference

Input Clock Reference

Vid I CAV Component analog video 1 Video Input 1

Vid I Cmpst Analog composite video 1 Video Input 2
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Table 5. Configuration example, four video input clocking sources 

Board Tag Board Type
Board 

Reference
Input Clock Reference

Vid I/O SDI VA Serial digital component 1 and 2 Video Input 1,
Video Input 2

Vid I/O SDI VA Serial digital component 1 and 2 Video Input 3,
Video Input 4
Profile Family

Figure 42. Audio Configuration dialog box, Input Clocking tab 
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To change the input clocking: 

1. Choose Option | Audio Configuration Board 1 or 2 or click an ASPB 
Configuration button. The Audio Configuration dialog box appears. Click 
the Input Clocking tab, if it isn’t already displayed. 

2. Click the button in the Audio Clock Reference Source column for the desired 
channels and select one of up to five choices: System (default) or Video 
Input. (The number of video inputs depends on the number of available video 
channels.) Selecting one of the video inputs sets the group of four channels 
to use the selected input as their audio clocking source. 

3. Click OK to accept your changes or click another tab. 
Profile Family

Audio Configuration Monitor Channels Tab 
Under the Monitor Channels tab, you can select recording and playback quality 
and adjust monitor channels. 

1. Choose Option | Audio Configuration Board 1 or 2 or click an ASPB 
Configuration button. The Audio Configuration dialog box appears (Figure 
43). 

Figure 43. Audio Configuration dialog box, Monitor Channels tab 
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2. Click the Monitor Channels tab. 

3. Under Monitor Channels, the Channel Selection box allows you to select 
which channels you want to monitor. Click next to a channel pair to select 
them. You can now adjust line levels for the pair. 

4. The line level range is –12 to +0 dB. If you trim the line level for an 
individual channel with the slider handle, the line level is incremented by 1 
dB; clicking on either side of the slider handle increments the line level by 
0.5 dB. The Level boxes show the current line level. If you enter a number 
directly into a Level box, the line level number is rounded to the nearest ±0.5 
dB. 
0 Profile Family

5. To adjust the trim for all channels at once, use the Group Fader slider. While 
the Group Fader moves all channels at once, it maintains the individual 
channel differences. 

NOTE: If the audio interface box is not present, the Monitor group 
will not appear. If your system is configured with an XLR 216 digital-
only chassis, channel selection is the only option available in the 
Monitor Channels group.

6. Click OK to accept your changes or click another tab. 
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System Audio Configuration 
To set recording and playback quality, or audio scrubbing: 

1. Choose Option | Audio Configuration or click the System Audio 
Configuration button. The System Audio Configuration dialog box appears 
(Figure 44). 
Profile Family

Figure 44. System Audio Configuration dialog box 

2. By default, recording and playback are set to 16-bit quality. To change the 
audio quality, click the 20-bit button for either recording, playback or both. 
Audio is played back at its recorded resolution, even if the system is 
configured for 20-bit playback quality. If 16-bit quality is enabled, all audio 
will be played back at 16-bit, regardless of what quality it was recorded in. 

3. Click Enabled under Scrubbing to turn audio scrubbing on, and click 
Disabled to turn it off. Disabled is the default. 

4. Click Undo to return the settings in the dialog box 

5. Click Close when finished. 
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Setting Up Fibre Channel Networking
If you have a Fibre Channel board in your Profile unit and you are part of a 
Fibre Channel Profile network, you must configure the board with an IP 
(Internet Protocol) address and other optional settings. Configuration Manager 
allows you to do this with the Fibre Channel Networking command.

To configure your Fibre Channel board:

1. Choose Option | Fibre Channel Networking or click the Fibre Channel 
Networking button on the toolbar. The Fibre Channel dialog box appears 
(see Figure 45). 
2 Profile Family

Figure 45. Fibre Channel Network Configuration dialog box 
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2. Click Auto hosts administration for TCP/IP name lookup. When selected, 
the PDR Network Configuration Service (fcncs.exe) automatically 
administers the file c:\winnt\system32\drivers\etc\hosts. 

3. Click Use TCP Checksum. When selected, a checksum is used to aid in 
error checking. 

4. Click Enable Multicast if the Fibre Channel Multicast option is installed and 
you want to enable it. This checkbox is dimmed if the option is not installed. 
Disabling the option even though it is installed can be done to avoid 
unintentional file transfers or the need to manage the feature if it is not in use.
Profile Family

5. Click Enable Switch to enable the Fibre Channel driver to communicate 
with Fibre Channel switches. This box should be checked if your Profile unit 
is directly connected to a Fibre Channel switch (fabric).

6. The Hostname box shows the name of the Profile host with a unique Fibre 
Channel identifier appended to it—in this case, _fc0. 

7. Enter dotted decimal IP address in the box provided. Contact your network 
administrator for an appropriate address. The IP address must be different 
than the Ethernet address for the machine. Click Clear to erase an entry. 

8. Enter a netmask in the box provided. A netmask can help speed routing of 
network traffic. Click Clear to erase an entry. Based on the address you use 
for a netmask, there is an implicit netmask, but you can override this with a 
larger mask. For example, 255.0.0.0 can be overridden by 255.255.0.0 or 
255.255.255.0. 

9. Enter a dotted decimal gateway address in the box provided. This is if you 
have a Profile VideoGateway attached to your network. Click Clear to erase 
an entry. 

10. Enter a hardware address in the box provided, in the range 1 to 120. A 
hardware address of 0 (zero) will allow the address to be automatically 
configured. Every Fibre Channel node (board) on your Profile network must 
have a unique hardware address.

11. Click OK. 
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Chapter 3
Using Media Manager

The Profile Media Manager allows you to have access to digitally stored JPEG 
and MPEG media and provides tools for managing that media—such as 

ut, copy, paste, and delete. Media may be stored locally on disk on 
le unit, or it may be on a disk expansion unit, RAID system, or library 
ached to your Profile unit. You can also transfer media stored on any 
explore, c
your Profi
system att
05

Profile system on your Profile network via a Fibre Channel connection.
Profile Family 1

Digital video and audio media may be stored in volumes. A volume is a disk set 
or file system on one of the following machines:

• PDR100 Professional Video Disk Recorder

• PDR200 or PDR300 Video File Server

• PRS200/A or PRS250 Profile RAID Storage system

• PDX103 Profile Disk Expansion Chassis

• PDX208 Profile Disk Expansion Chassis

Video and audio clips can also be stored on digital tape cartridges in the PLS20 
and PLS200 Profile Library Systems.

With Media Manager, you view media in a tree structure. On disk, media may 
consist of video and audio clips and masters. Clips and masters are organized 
into bins that are kept on a volume. A bin is a container for clips and masters, 
similar to a directory on a computer. A clip refers to segments or portions of a 
media file or a media file in its entirety. A master is an edited sequence of clips. 
On a cartridge in a library system, media also consists of clips and masters. 
Cartridges are divided into one or more partitions.

NOTE: Profile system software version 2.5 supports Media Manager 
version 1.1.5. 
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Starting and Exiting the Media Manager
To start the Media Manager application with Windows NT: 

• Double-click the Media Manager shortcut icon.

Or: 

• Choose Start | PDR Applications | Media Manager.

The Media Manger window appears (see Figure 46). The tree pane is on the left 
and the contents pane is on the right. What appears in the contents pane depends 
on what you select in the tree pane. For example, if you select the volume icon 
6 Profile Family

INT: in the tree pane, the Recycled and default bins appear in the contents pane. 
If you select a bin, the masters and clips in that bin appear in the contents pane. 
Masters and clips will only appear in the contents pane.

Figure 46. Media Manager window 
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To exit the Media Manager, choose File | Exit.

A message box is displayed, asking you to confirm that you really want to exit 
the Media Manager application. Click on the Yes button to confirm the exit or 
the No button to cancel the quit command.

Whenever you start the Media Manager, a Hardware Communication Monitor 
is also started, if it is not already running. This program makes calls to the disk 
recorder and keeps track of the Profile host file (profile.hst) which lists Profile 
systems on the network. The Hardware Communication Monitor is normally 
invisible in its operation, but is essential to the operation of Media Manager. It 
appears in the Processes tab of the Windows NT Task Manager as 
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VMHWCOM.EXE; ending this process will stop Media Manager as well.
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Starting Other Applications from the Tools Menu
You can start other tools and applications from Media Manager’s Tools menu:

• Choose Tools | Transfer Monitor to start the Transfer Monitor tool. See 
“Viewing the Transfer Monitor” on page 156. 

• Choose Tools | Media Manager to start another instance of the Media 
Manager. 

• Choose Tools | Tool Box Editor to start the optional Tool Box Editor, if 
available. See Chapter 8, “Using the Tool Box Editor” on 253. 
8 Profile Family

• Choose Tools | List Manager to start the optional List Manager, if available. 
See Chapter 9, “Using the List Manager” on 281. 

• Choose Tools | Transcode to start the Transcode Utility. This utility 
converts media between different compression formats, such as from JPEG 
to MPEG. See “Using the Transcode Utility” on page 130. 

When an application is started from the Media Manager, it initially connects to 
the machine that was selected in the Media Manager’s machine list box. If the 
application is not installed, an error occurs.
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Viewing and Hiding the Toolbar and Status Bar
By default, the toolbar is visible. To hide it:

• Choose View | Toolbar.

To make it visible again, choose View | Toolbar again.

By default, the status bar is visible. To hide it:

• Choose View | Status Bar.

To make it visible again, choose View | Status Bar again.
Profile Family

To refresh the tree and contents panes:

• Choose View | Refresh or press F5.

Viewing Help and Software Version Information
To view Help topics on Media Manager:

• Choose Help | Media Manager Help Topics.

To view program and software version information and copyright:

• Choose Help | About Media Manager.
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Connecting to a Remote Machine
You can connect from your local Profile machine to any remote Profile 
machine. You can also connect remotely from any PC running Windows NT 
4.0. A local Profile machine refers to a Profile system to which you are directly 
attached. A remote Profile machine refers to a Profile system that is connected 
to your local system via an Ethernet local area network (LAN).

The Hardware Communication Monitor makes calls to the disk recorder, 
manages the contents of the Profile host file (profile.hst), owns connections to 
the machines listed in the host file, and passes on change notifications received 
from each of these machines when other applications—such as other instances 
0 Profile Family

of Media Manager—are running simultaneously.

While Hardware Communication is initializing, Media Manager shows the 
Hardware Communication Monitor message box. If you click the OK button, 
this message box is minimized. 

To connect to a remote Profile machine on your Profile network: 

1. Choose Add/Remove Machine from the File menu or from the shortcut 
menu with a right-click on a machine, volume, or network icon in the tree 
pane. You can also click the Add/Remove Machine button on the toolbar. 
The Add/Remove Machine dialog box appears (see Figure 47). The label 
Local appears after the name of the local Profile machine.

Figure 47. Add/Remove Machine dialog box
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2. To add a remote Profile machine to the network host list, click Add. The Add 
Network Host dialog box appears.

Figure 48. Add Network Host dialog box
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3. Enter the name of the machine in the New Host Name box. This can be the 
host name or the machine’s IP address (such as 128.161.37.138).

4. Click OK. The new host name is added to the network host list. You can click 
the Add button again to add as many machine names as you want.

5. Click OK. The connection status message box appears to show the progress 
of new connections.

To remove a Profile machine from the network host list:

1. Choose Add/Remove Machine from the File menu or from the shortcut 
menu with a right-click on a machine, volume, or network icon in the tree 
pane. You can also click the Add/Remove Machine button on the toolbar. 
The Add/Remove Machine dialog box appears. 

2. Select the name of the machine you want to remove in Network Host List 
box.

3. Click Remove.

4. Click OK.
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Viewing the Media Hierarchy
The Media Manager window is divided into two main sections: the tree and 
contents panes. Clips and masters appear in the contents pane. Items are listed 
alphabetically.

In the tree pane, you can expand or collapse the tree hierarchy by clicking on 
the + (plus) or – (minus) control buttons, as shown in Figure 49. If you click on 
a + button, the tree hierarchy is expanded or opened so you can see the branch. 
For example, under a volume, you see bins. Clicking on the – button collapses 
or closes the associated branch of the tree, hiding the bins under the volume. 
2 Profile Family

To explore the contents of an item, select the icon representing it and then 
choose Explore from the shortcut menu which is displayed with a right-click. 
If present, clips and masters are displayed in the contents pane. In this pane, you 
see information about the media: 

• The name of the clip or master. 

• The length of the media in the form 00:00:00:00 
(Hours:Minutes:Seconds:Frames). 

• The compression format of the media: JPEG or MPEG. 

• The date and time the media was last modified, in the format: 12/2/94 9:40 
PM (Month/Day/Year Hours:Minutes AM/PM). 
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Figure 49. The Media Manager tree pane 

The icons shown in tree pane are explained in more detail here.

The Profile network icon is the root for all other items in the tree pane. 

Profile machines. Each icon is labeled with the Profile machine’s name. 
A Profile can be a local machine or one connected via Ethernet alone.

A Profile machine connected via Ethernet and Fibre Channel. 

An unconnected machine icon. Appears if no connection could be 
made. This icon cannot be expanded.

A non-Profile server that recognizes Media Manager connection 
requests. Media may be copied to this server from other machines on the 
Fibre Channel network.

A volume. A machine’s storage is divided into one or more volumes. 
The volume icon represents a physical set of disks—either an 
internal disk set, and external expansion box (such as the PDX208), 
or a RAID disk array (PRS200).
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A closed bin. 

An open bin. 

A Recycle bin appears below each volume.

A master. 

A locked master. 

Clips and archived clips with audio and video. 
4 Profile Family

Locked clips and archived clips with audio and video. 

Clips and archived clips with no audio.

Locked clips and archived clips with no audio. 

Clips and archived clips with audio only (no video). 

Locked clips and archived clips with audio only (no video). 

An item in the Profile clip database that Media Manager does 
not recognize. 

A library system – appears after volumes. The library icon appears 
only on machines connected to a Profile library system. 

A cartridge – appears below the library icon. 

A cartridge that is out of the library. 

A cleaning cartridge – may appear anywhere in the cartridge list.

An unformatted cartridge.

An unformatted, out-of-library cartridge. 

Cartridges that are in an unknown state. 

An unknown, out-of-library cartridge. 

A partition – appears under cartridges. This is a closed partition. 

An open partition. 
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Toolbar

The Media Manager toolbar provides one-button access to commands:

Add/Remove Machine: Opens the Add/Remove Machine dialog box.

Select Current Machine box: Expands the machine item in the tree.

Up One Level: Goes to the folder one level up. 

Cut: Removes the selected items and copies them onto the clipboard. 
Use Paste to put them in the new location. 
Profile Family

Copy: Copies the selected items to the clipboard. Use Paste to put them 
in the new location. 

Paste: Inserts the items you have copied or cut into the selected location. 

Delete: Deletes the selected items. 

Properties: Displays the properties of the selected item. 
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Copying Media
To copy one or more clips or masters:

1. In the contents pane, select a clip or master. To extend the selection, press 
Shift-Up Arrow or Shift-Down Arrow. Choose Edit | Select All or Ctrl-A to 
select all the media in the contents pane.

2. Choose Copy from the Edit menu or from the shortcut menu with a right-
click. You can also click the Copy button on the toolbar.

3. Select the location where you want to paste the item. This can be another bin 
or anywhere in the contents pane when a bin is selected. The selected 
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location may even be in another Media Manager window. If both the source 
and the destination locations reside on machines connected to the Fibre 
Channel network, you may copy between machines.

4. Choose Paste from the Edit menu, or from the shortcut menu with a right-
click. You can also click the Paste button on the toolbar. A clip may be 
pasted into the same bin it was copied from. In this case the clip is 
automatically renamed. Media Manager automatically suggests a new name 
that does not conflict with any other item at the selected location. The new 
name is based on the old name with the addition of a number: source 
becomes source_1. When you are copying clips to a volume other than the 
source volume on a Profile system or an library system, Paste Special is 
available as an option on the Edit and right-click shortcut menus.

NOTE: It is possible to play clips or masters with VdrPanel or Tool Box 
Editor while they are being copied over Fibre Channel.

To copy a bin:

1. In either the tree pane or the contents pane, select a bin.

2. Choose Copy from the Edit menu or from the shortcut menu with a right-
click. You can also click the Copy button on the toolbar.

3. Select another bin into which you want to paste the first bin’s contents. The 
selected location may even be in another Media Manager window. If both the 
source and the destination locations reside on machines connected to the 
Fibre Channel network, you may copy between machines.
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4. Choose Paste from the Edit menu, or from the shortcut menu with a right-
click. You can also click the Paste button on the toolbar. The bin may be 
pasted into the same bin it was copied from. In this case the bin is 
automatically renamed. Media Manager automatically suggests a new name 
that does not conflict with any other item at the selected location. The new 
name is based on the old name with the addition of a number: source 
becomes source_1. 

NOTE: Copying a bin means that all clips and masters in the bin are 
copied to the new location.
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Using Paste Special
Paste Special is a method of pasting clips or masters that are currently on the 
clipboard as a result of a copy or cut operation. Paste Special is enabled only 
when you have selected a bin on a different volume a bin on a remote machine, 
or a partition in a library system. 

Unlike Paste, which always copies the material between a clip’s mark in and 
out points, Paste Special offers you the option of copying all the media that 
the clip references. To use Paste Special after placing media on the clipboard, 
choose Paste Special from the Edit menu or the right-click shortcut menu. 
When the Paste Special dialog box appears, click the button for the paste option 
you prefer, then click OK.

Figure 50. The Paste Special dialog box
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Moving Media
To move a clip or master to another bin:

1. In the contents pane, select a clip or master. To extend the selection, press 
Shift-Up Arrow or Shift-Down Arrow. Choose Edit | Select All or Ctrl-A to 
select all the media in the contents pane.

2. Choose Cut from the Edit menu or from the shortcut menu with a right-click. 
You can also click the Cut button on the toolbar.

3. Select the location where you want to paste the media. This can be another 
bin or anywhere in the contents pane when a bin is selected. The selected 
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location may even be in another Media Manager window. If both the source 
and the destination locations reside on machines connected to the Fibre 
Channel network, you may copy between machines.

4. Choose Paste from the Edit menu, or from the shortcut menu with a right-
click. You can also click the Paste button on the toolbar. Pasting media into 
the same bin has no effect.

To move a clip or master using Paste Special:

1. In the contents pane, select a clip or master. To extend the selection, press 
Shift-Up Arrow or Shift-Down Arrow. Choose Edit | Select All or Ctrl-A to 
select all the media in the contents pane.

2. Choose Cut from the Edit menu or from the shortcut menu with a right-click. 
You can also click the Cut button on the toolbar.

3. Select the location where you want to paste the media. To use Paste Special, 
you must select a bin on a different volume, a bin on a remote machine, or a 
partition in a library system.

4. Choose Paste Special from the Edit menu, or from the shortcut menu with 
a right-click. When the Paste Special dialog box appears, click the button for 
the paste option you prefer, then click OK.
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To move a clip or master using drag and drop:

1. In the contents window, select one or more clips or masters.

2. Drag the selection and drop it at the appropriate location. This can be a bin 
or anywhere in the contents pane when a bin is selected. The selected 
location may even be in another Media Manager window. The tree pane will 
automatically scroll when dragging a bin to the very top or bottom of the tree.

If you hold down the Ctrl key when you drop the item, the item is copied to the 
new location, not moved. Dragging a clip or a master to a different machine or 
volume always results in a copy—the original clip is not deleted.
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When copying or moving clips to a new location, if a clip or master with the 
same name already appears at that location, you will be prompted to change the 
name or cancel the operation, as shown in Figure 51. 

Figure 51. Confirm Copy dialog box 
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Duplicating Media
To duplicate media means that you copy a clip or master and the underlying 
media files that the clip or master reference. A normal copy operation between 
locations on the same Profile machine does not copy the associated media files, 
only references to those media files. 

NOTE: You can play clips or masters with VdrPanel or Tool Box Editor 
while Media Manager is duplicating the clip or master. This is only 
practical for longer media. 
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To duplicate a clip or master: 

1. In the contents pane, select the clip or master you want to duplicate. 

2. Choose Duplicate from the Edit menu or from the shortcut menu with a 
right-click. The Duplicate operation always automatically renames the new 
clip. 

Creating, Renaming and Deleting Bins
A bin can have a name up to 32 characters long. Spaces are legal characters, but 
count for two characters. Colons (:) and slashes (/) are illegal. Tildes (~) are 
illegal as a first character in a bin name. 

To create a new bin:

1. In the tree pane, select the machine or volume where you want to create the 
new bin. When a volume icon is selected, the new bin is added to that 
volume. When a machine icon is selected, a new bin is created in the first 
volume in that machine.

2. Choose New Bin from either the File menu or from the shortcut menu with 
a right-click.

3. A new bin called NewBin is placed in the tree. The bin name is highlighted 
so you can change it. Accept the new bin name by pressing Enter.

NOTE: Renaming a bin involves modifying the path of every clip or master 
in the bin to reflect the new name. If a clip or master cannot be renamed 
because it is locked or in use, you end up with two bins: one with the old 
name and one with the new one. The clip that could not be modified 
remains in the bin with the old name.
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To rename a bin:

1. Select the bin in either the tree or contents pane.

2. Choose Rename from either the File menu or from the shortcut menu with 
a right-click. You can also select the bin a second time.

3. The name of the bin is highlighted. Type a new name for the bin and press 
Enter.

NOTE: Deleting a bin involves deleting every clip or master currently in 
the bin. If a clip or master cannot be deleted because it is locked or in use, 
the bin is not deleted either—it will only contain those clips or masters that 
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could not be deleted. The rest go to the Recycle bin or are deleted directly.

To delete a bin:

1. Select the bin or bins in either the tree or contents pane.

2. Press Delete, Backspace, choose Edit | Delete or with a right-click, choose 
Delete from the shortcut menu. Press Shift-Delete to skip the Recycle bin 
and delete the bin or bins immediately.

3. The bin icon disappears from the tree and the contents of the bin are moved 
to the Recycle bin.

Renaming Clips and Masters
A clip or master can have a name up to 32 characters long. Spaces are legal 
characters, but count for two characters. Colons (:) and slashes (/) are illegal in 
clip and master names. Tildes (~) are only illegal as first characters. 

To rename a clip or master:

1. Select the clip or master in the contents pane.

2. Choose Rename on the File menu or with a right-click. You can also select 
the item a second time.

3. The name of the clip or master is highlighted. Type a new name for the clip 
or master and press Enter.
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Deleting Clips and Masters
When a clip or master is deleted, it is just moved to the Recycle bin. It is 
permanently deleted when the Recycle bin is emptied.

To delete a clip or master:

1. Select the clip or master in the contents pane.

2. Press Delete, Backspace, or choose Delete on the File menu or from the 
shortcut menu with the right-click. Press Shift-Delete to skip the Recycle 
bin and delete the material immediately. 
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3. The clip or master icon disappears from the tree and is moved to the Recycle 
bin.

Emptying the Recycle Bin
When a clip or master is deleted, it is moved to the Recycle bin and is 
permanently deleted when the Recycle bin is emptied. If an item of the same 
name is in the Recycle bin, the new item is automatically renamed.

To empty the Recycle bin:

1. Select the bin labeled Recycled in the tree pane.

2. Choose Empty Recycle Bin with a right-click or from the File menu. 

To always delete media immediately, avoiding the Recycle bin: 

1. Select the bin labeled Recycled in the tree pane. 

2. Choose Properties with the right-click or from the File menu. The Recycle 
Bin Properties dialog box appears (see Figure 52). 

3. Click the Options check box to enable immediate removal of deleted items.

4. Click OK. 
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Figure 52. Recycle Bin properties dialog box 
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Viewing Properties
Media Manager lets you view the properties of a volume, media properties for 
clips and masters, and properties for a library system (see “Viewing Library, 
Cartridge and Archived Clip Properties” on page 150). 

To view volume properties: 

1. Select a volume in the tree pane. 

2. Choose Properties from the File menu or from the shortcut menu with a 
right-click. You can also click the Properties button on the toolbar. The 
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Properties dialog box for volumes appears (see Figure 53). 

Figure 53. Properties dialog box for volumes 
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To view media properties: 

1. Select a clip or master in the contents bin.

2. Choose Properties from the File menu or from the shortcut menu with a 
right-click. You can also click the Properties button on the toolbar. The 
Properties dialog box for clips or masters appears (see Figure 54).
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Figure 54. Properties dialog box for clips or masters 
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3. Click the General tab to view these properties:

- A preview frame of the clip or master to help identify it. Preview frames 
are not available for MPEG masters.

- The name of the clip or master.

- How many tracks the clip or master uses for both audio and video.

- The video format, either NTSC or PAL. NTSC clips are recorded with 
either drop-frame or non-drop-frame timecode.

- The compression format, either JPEG or MPEG. 
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- The length of the clip or master. The length is shown in timecode format: 
00:00:00:00 (Hours:Minutes:Seconds:Frames). 

- The size of the media in megabytes (MBytes). 

- The date and time that the media was created and the date and time it was 
last changed. The date and time the media was created or last changed is 
shown in the format: 12/2/94 9:40 PM (Month/Day/Year Hours:Minutes 
AM/PM). 

4. Click the Locked box to lock (or unlock) the media under Media Manager. 
Clips and masters with the locked attribute cannot be renamed, deleted, or 
modified in any way. 

If the Read Only Media box is checked, it means that the media is protected 
under VdrPanel and cannot be deleted or rerecorded, but you can change 
marks. See “Setting Clip Protection” on page 195. 

5. Click the Transcode tab to view the transcode history (shown in Figure 55) 
for the master or clip. Each entry on the history page contains the date and 
time of the conversion, user description, target format, and when applicable, 
data rate, chrominance value, and GOP structure.
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Figure 55. The transcode history page
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Finding Clips and Masters
You can locate clips and masters anywhere on the Profile network. If you select 
the Profile Network icon, you will search all machines and libraries on the 
network. If you select a machine, your search will be limited to that machine’s 
volumes and attached library. If you select a cartridge in a library, your search 
includes all partitions in the cartridge.

1. Select the item where you want to begin your search in either the tree or 
contents panes.

2. Choose Find on the Edit menu or from the shortcut menu with a right-click. 
8 Profile Family

The Find dialog box appears (see Figure 56).

Figure 56. Find dialog box
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3. Enter the name of the clip or master in the Named box—in this example,
10-28-97. The Look In box indicates where the search will begin. 

NOTE: Wildcards are not supported. 

4. Click Find Now. Click Stop to abort the search. When a match is found, the 
result is displayed in the box at the bottom of the Find dialog box, as shown 
in Figure 56. 

5. If you double-click an item in the list of found items, the tree pane is 
expanded and the item is selected in the contents pane. 
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6. You can copy an item from the found list by holding the Control key and 
dragging the item to the desired location, or you can move it by dragging it 
without the Control key. 

7. Click Close when you have completed your search. 
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Using the Transcode Utility 
If you have MPEG encoders or decoders in your Profile disk recorder, you may 
have media recorded in motion JPEG compression format that you want to 
convert to MPEG. The Transcode Utility is a tool that makes format 
conversions easy. The Transcode Utility converts media files—clips and 
masters—in four ways: 

• From JPEG to JPEG using a different video quality 

• From JPEG to MPEG 
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• From MPEG to MPEG using a different video quality 

• From MPEG to JPEG 

NOTE: Converting a low-quality video clip to a higher quality (higher bit 
rate) will not improve the video quality of the clip, though it will consume 
more disk space. 

The Transcode Utility is started from the Tools menu in Media Manager. 

Figure 57. Transcode Utility window 
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To convert clips or masters: 

1. Select one or more clips or masters that you want to transcode in Media 
Manager’s contents pane. 

2. In Media Manager, choose Tools | Transcode. The Transcode Utility dialog 
box appears with the selected media in the transcode list. 

3. You may add more clips or masters to the transcode list by dragging them 
from Media Manager and dropping them on the list. You can also transfer 
media using Copy and Paste commands. 

4. In the Convert tab, select the target format, either MPEG or JPEG. 
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5. In the Video Quality box, select a video quality if you want something other 
than the default (Medium). The higher the quality, the more disk space is 
used. 

6. To change a custom quality setting, click the button next to the Video 
Quality list box, and the Custom Video Quality Settings dialog box appears. 
Select either Custom1 or Custom2 in the Video Quality list box. When 
selected, you can change the name of a custom setting. Click Undo to cancel 
changes and OK when done. 

- For JPEG (see Figure 58 and Table 6) select a video quality with the 
slider. You can move the slider with the mouse or arrow keys. 

- For MPEG (see Figure 59 and Table 7) select a chrominance value, either 
4:2:0 or 4:2:2. Then move the diamond on the grid or click the High, 
Medium, Low, or Draft button—the corresponding bit rate and picture 
structure is shown on the right side of the dialog box. 

NOTE: You can edit I-frame clips only. To make an MPEG clip I-frame, 
drag the diamond to the far left side of the grid. 
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Figure 58.  JPEG Custom Video Quality Settings dialog box  

Table 6. JPEG video quality (compression) 

Quality Settings Compression in 
Mbps

Draft 12 

Low 24 

Medium (default) 36 

High 48 

Custom 1 or 2 6–54 
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Figure 59. MPEG Custom Video Quality Settings dialog box  

Table 7. MPEG Video quality (compression) 

Quality Settings Compression in 
Mbps

Chrominance

Draft 4 4:2:0 

Low 8 4:2:0 

Medium (default) 15 4:2:2 

High 24 4:2:2 

Custom 1 or 2 4–44 4:2:2 
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Figure 60. Transcode Utility dialog box, Convert tab 

7. In the Preview tab, select a video output for the source clip or master from 
the Source Video Output box. This allows you to watch the source media 
play out on the monitor during the conversion. 

8. From the Target Video Output box, select a video output for the target clip 
or master. This allows you to compare video quality by watching the target 
media play out on a monitor during the conversion, with a few seconds delay 
from the source media. 

9. If there is media in the list that you have decided not to convert, select it in 
the media pane, then click Remove. 

10. If you want to delete the original clip or master automatically after it is 
converted, click Delete source after conversion. This will save disk space. 
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NOTE: A deleted clip or master cannot be restored. 

11. Click Start. The Transcode Description dialog box appears. Enter a 
descriptive message to be stored as part of the transcode history and when 
done, click OK to continue the conversion. 
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Figure 61. The Transcode Description dialog box

The conversion starts with the first clip or master in the list and continues to 
the last. If the media are not deleted (see step 10) the source clips and masters 
are moved to a backup bin. For example, if the source media is in the default 
bin, the original source is moved to a bin called default_bak (bin basename 
plus _bak). You can stop the conversion process at any time by clicking 
Stop. Start the process again by clicking Restart. 

NOTE: An error occurs (listed in the Status column) when a clip is the 
wrong video standard, is already present in the _bak bin, or cannot be 
opened, among other faults. 

12. Click Close or choose File | Exit. 
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Figure 62. Transcode Utility dialog box, Preview tab 
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Using a Library System
Media Manager supports both the PLS20 and the PLS200 library systems. The 
PLS 20 Profile Library System is a stand-alone drive for reading and writing to 
individual magnetic tape cartridges. The PLS 200 Profile Library System is a 
robotic library that stores up to 80 magnetic tape cartridges. The PLS 200 is a 
cost-effective mechanism for spot or news storage and management, plus a 
solution and method for the long-term archival of material. Total storage 
capacity is determined by the number of tape cartridges available and the video 
compression method used (JPEG or MPEG).
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Archiving a Bin or Clip
To archive a clip means to copy it from disk to a cartridge in the library system. 
Clips are always copied into the library when archived: they are never moved. 
To archive a bin means to copy all the clips and masters in the bin to the library 
system without having to individually select each clip or master.

NOTE: The archiving operation copies the data to the tape cartridge, but 
does not update the cartridge directory. Updates can occur when you 
export the tape, or when you specifically perform an update. See 
“Exporting a Cartridge” on page 142, and “Updating and Inventorying 
Cartridges” on page 144.

To archive a bin or clip using a copy command:

1. Select the bin in the tree pane or the clip in the contents pane that you want 
to archive. To extend the selection, press Shift-Up Arrow or Shift-Down 
Arrow. Choose Edit | Select All or Ctrl-A to select all the media in the 
contents pane.

2. Choose Copy either from the Edit menu or from the shortcut menu with a 
right-click. You can also click the Copy button on the toolbar.

3. In the tree pane, select the partition icon where you want to archive the bin 
or clip.

4. Choose Paste or Paste Special either from the Edit menu or from the right-
click shortcut menu. You can also click the Paste button on the toolbar.

If there is a bin or clip with the same name in the partition where you want to 
archive it, you are prompted to change the name or cancel the operation. Also, 
a clip can only be added to a partition if there is enough space for it.
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To archive a clip or bin using drag and drop:

1. In the tree pane, click the cartridge icon where you want to archive a clip. 
This expands the tree pane to reveal the partition icon or icons.

2. Click on the bin that you want to copy or from which you want to copy a clip. 
The clip icons from the bin appear in the contents pane.

3. In the tree pane select the bin icon, or in the contents pane select the clip icon 
that you want to archive. Hold the left mouse button and drag the selected 
icon to the partition icon in the tree pane where you want to archive the bin 
or clip.
8 Profile Family

4. If you want to check on the progress of an archive operation, click on the 
Profile logo or choose Tools | Transfer Monitor to view the Transfer 
Monitor.

Restoring a Bin or Clip
To restore an archived clip means to copy it from a partition in a cartridge in 
the library system to disk. Clips are always copied out of the library when 
restored: they are never moved.

To restore an archived clip using the copy method:

1. In the tree pane, click the cartridge icon from which you want to restore a 
clip. This expands the tree pane to reveal the partition icon or icons.

2. Click the partition in the tree pane from which you want to restore to reveal 
the clips in the contents pane.

3. In the contents pane, select the archived clip you want to restore. To extend 
the selection, press Shift-Up Arrow or Shift-Down Arrow. Choose Edit | 
Select All or Ctrl-A to select all the media in the contents pane.

4. Choose Copy on the Edit menu or from the shortcut menu with the right-
click. You can also click the Copy button on the toolbar.

5. Select the location where you want to restore the archived clip. This can be 
a bin or anywhere in the contents pane when a bin is selected. The selected 
location may also be in another Media Manager window.

6. Choose Paste on the Edit menu or from the shortcut menu with a right-click. 
You can also click the Paste button on the toolbar.

If there is a clip with the same name in the bin where you want to restore it, you 
are prompted to change the name or cancel the operation.
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To restore a clip using the drag and drop method:

1. In the tree pane, click the cartridge icon you want to restore a clip from. This 
expands the tree pane to reveal the partition icon or icons.

2. Click the partition in the tree pane that you want to restore from to reveal the 
clips in the contents pane.

3. In the contents pane, click on the clip icon or icons you want to restore, hold 
the left mouse button, and drag it to the bin icon in the tree pane where you 
want to restore the clip.

4. If you want to check on the progress of a restore operation, click on the 
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Profile logo or choose Tools | Transfer Monitor to view the Transfer 
Monitor.

Renaming an Archived Clip
A clip can have a name up to 32 characters long. Spaces are legal characters, 
but count for two characters. Colons (:) and slashes (/) are illegal in clip names. 
Tildes (~) are only illegal as a first character in a clip name. 

To rename an archived clip:

1. In the tree pane, select the library, cartridge, and partition where the archived 
clip is stored.

2. In the contents pane, select the archived clip you want to rename.

3. Choose Rename from the File menu or from the shortcut menu with a right-
click. You can also select the clip’s name a second time.

4. Type the new name and press Enter.

NOTE: The renaming operation does not take permanent effect until after 
an update operation (see “Updating and Inventorying Cartridges” on page 
144).
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Deleting an Archived Clip
To delete an archived clip:

1. In the tree pane, select the library, cartridge, and partition where the archived 
clip is stored.

2. In the contents pane, select the archived clip or clips you want to delete.

3. Press the Delete or Backspace key, or choose Delete from the File menu or 
from the shortcut menu with a right-click.

When an archived clip is deleted, it is not moved to the Recycle bin. It is 
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removed from the library database’s record of archived clips. Also, since tape 
is not a random access medium, the storage space is not reclaimed as it is on the 
disk drives, and the space cannot be reused until all clips in a partition have 
been deleted.

NOTE: The delete operation does not take effect until after an Update 
operation (see “Updating and Inventorying Cartridges” on page 144).

Importing a Cartridge
To import a cartridge is to insert or add it into the library system:

1. In the tree pane, select the library icon. If you have a stand-alone drive, you 
must insert the cartridge you are importing into the drive. 

2. Choose Import either from the File menu or from the shortcut menu with a 
right-click. The Import Cartridge dialog box appears (see Figure 63). If you 
have two or more PLS20 systems connected simultaneously, you must enter 
a drive number when prompted. 
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Figure 63. Import Cartridge dialog box 

3. Enter a unique label name (number) for the cartridge. This name must match 
the barcode on the cartridge—for example, 00000015. If the label is not 
unique or matches a label already in the library, the cartridge is rejected.

4. Click a button to tell Media Manager how you want to import the cartridge:

- If you want to verify the contents of the cartridge, click Verify the 
cartridge with its library entry. If the label (barcode) matches the one in 
the library and the directory entries match, the cartridge is imported. If the 
label matches but the directory entries do not, the cartridge is rejected. If 
the library system can find no record of the barcode label, the cartridge is 
stored as an unknown cartridge.

- For a fast import with no verification of the cartridge’s contents, click Do 
not verify the cartridge (fast import). As long as the label matches one 
in the library, the cartridge goes directly into an available slot. If the 
library system can find no record of the barcode label, the cartridge is 
stored as an unknown cartridge.

- To inventory the cartridge, click Inventory the cartridge and update the 
library. The cartridge is loaded into a transport and its contents are 
inventoried. The database is updated if it did not match what was 
inventoried.

- To import an unformatted cartridge, click Import unformatted cartridge. 
The cartridge is put into the first available slot and appears in the media 
tree with an unformatted cartridge icon.
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- To import a new cleaning cartridge, click Import new cleaning 
cartridge. The library system cannot differentiate between a cleaning 
cartridge and an ordinary cartridge. It must be told when a cleaning 
cartridge is imported. If you provide a unique tape label, the cleaning 
cartridge is stored in a cleaning cartridge bin.

5. Click Import.

6. A prompt appears requesting that you physically insert the cartridge into the 
library. Once the robot is in position and you insert the cartridge, press any 
button on the library’s control panel.
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7. The Importing Cartridge dialog box remains on the screen until the robot 
puts the cartridge in the available slot. Since this is done in the background, 
click OK at any time.

When the robot retracts with the imported cartridge, it scans the cartridges’s 
barcode. If the barcode does not match the name that was entered for the import, 
it is rejected.

Exporting a Cartridge
To export a cartridge is to eject or remove it from the library system:

1. In the tree pane, select the icon for the cartridge you want to export.

2. Choose Export Cartridge from the File menu, or from the shortcut menu 
with a right-click, and the Export Cartridge dialog box appears. By default, 
the cartridge location is Out of library.

Figure 64. Export Cartridge dialog box 
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3. Select the appropriate box:

- If you select Update the cartridge, the cartridge is loaded into a transport 
and its directory is updated to reflect clip name changes or deletions. Then 
the cartridge is ejected. 

- If you select Permanently remove from the library database, all 
references to the cartridge are deleted from the library database, then the 
cartridge is ejected. 

- If you select both boxes, the cartridge is loaded into a transport and its 
directory is updated to reflect clip name changes or deletions. This 
information is saved on the cartridge. Then all references to the cartridge 
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are deleted from the library database and the cartridge is ejected. 

4. Click Export.

5. A prompt appears requesting that you physically remove the cartridge from 
the library. Once the robot is in position and you remove the cartridge, press 
any button on the library’s control panel.

6. The Exporting Cartridge dialog box remains on the screen until the robot 
ejects the cartridge. Since this is done in the background, click OK at any 
time. If you are using a PLS20, you must manually remove the cartridge 
from the drive. 
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Updating and Inventorying Cartridges
Using the Media Manager to archive, delete, or rename bins or clips simply 
updates the library database—not the cartridge directory. This is why delete and 
rename operations are so fast: the cartridge is not loaded into a transport. 
Archive operations do copy data to a cartridge, but the cartridge directory is not 
updated. Once a bin or clip is archived, deleted, or renamed, the library 
database and the cartridge’s physical directory are out of synch.

The update and inventory operations allow you to resynchronize the cartridge 
directory and library database. The update operation rewrites the cartridge 
directory with the library database’s record of what should be on that cartridge. 
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Conversely, the inventory operation reads the cartridge directory and rewrites 
the library database’s entry for that cartridge.

>>> CAUTION: It is very important that you update a cartridge before you 
inventory the cartridge. Updating prior to inventorying ensures that the 
cartridge directory reflects all archivals, renamings and deletions since the 
last update. If you inventory the tape before you update it, any changes to the 
tape since the last update are effectively lost.

To update one or more cartridges:

1. In the media tree or contents pane, select one or more cartridge icons.

2. On the File menu, or from the shortcut menu with a right-click, click 
Update. Since the update takes several minutes to complete, you are asked 
to confirm the operation, as shown in Figure 65. 

Figure 65. Confirm Update dialog box 

3. Click Yes to update the cartridge or cartridges.
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To inventory one or more cartridges:

1. In the tree or contents pane, select one or more cartridge icons.

2. Choose Inventory either from the File menu or from the shortcut menu with 
a right-click. Since the inventory takes several minutes to complete, you are 
asked to confirm the operation, as shown in Figure 66. 
Profile Family

Figure 66. Confirm Inventory dialog box 

3. Click Yes to inventory the cartridge. 
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Inventorying the Library
There are times when the contents of the library system do not match the record 
of those contents in the library database. This usually occurs when the 
cartridges have been added or removed by hand without appropriate 
inventories, which is not recommended. The inventory operation rescans the 
barcodes of the cartridges in the library and updates the database to the actual 
library contents.

To inventory the contents of the library:

1. Select a library icon in the tree pane.
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2. Choose Inventory from the File menu or from the shortcut menu with a 
right-click. Since this operation may take several minutes, Media Manager 
asks you to confirm that you want to inventory the entire library.

Figure 67. Confirm Inventory dialog box 

3. Click Yes to inventory the entire library.

The inventory operation, like all library operations, is processed in the 
background. This allows you to continue working with the Media Manager 
while the operation is being performed. The Transfer Monitor tool is used to 
view background transactions. To view the Transfer Monitor, click the Profile 
logo or choose Tools | Transfer Monitor.
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Formatting Cartridges
When you format one or more cartridges, all storage space is reallocated and 
the cartridge is prepared to accept new data.

To format one or more cartridges:

1. Select the cartridge icon or icons in the tree pane

2. Choose Format from the File menu or from the shortcut menu with a right-
click. The Format dialog box appears (see Figure 68). The Name field shows 
the name or names of the cartridges to be formatted. If more than one 
cartridge is selected, the number of cartridges is shown (see Figure 69).
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Figure 68. Format Cartridge dialog box



Chapter 3 Using Media Manager

14
8 Profile Family

Figure 69. Format Cartridge dialog box 

3. Click Single Partition or Multiple Partitions. With a Single Partition, the 
cartridge or cartridges will have one partition when formatted and all clips 
are archived to the same partition. With Multiple Partitions, the cartridge or 
cartridges will have two or more partitions, depending on other settings. You 
do not actually set the duration of clips, or video and audio quality: you 
simply approximate based on how you anticipate using the cartridges. You 
cannot set the number of partitions directly. If you choose Multiple 
Partitions: 

- To set the anticipated length (time duration) of clips under the partitions, 
select the number of seconds or minutes in the Partition Duration box. 
Selecting Custom opens the Custom Duration box. In the Custom box, 
enter the duration of seconds in the range 1 to 9999.
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- To set the anticipated quality of the video that you will use with these 
cartridges, select a video quality from the Anticipated Video Quality box. 
If you anticipate using higher video quality, you will use more tape to 
store media. This causes the format operation to create larger and fewer 
partitions.

- To set the anticipated audio resolution that you plan to use with these 
cartridges, select either 16 bits or 20 bits from the Anticipated Audio 
Quality box. Different audio qualities affect the amount of tape used and 
therefore the number of partitions that will be created.

- To allow more than one file (clips) under a partition, click Multiple files 
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per partition. If unselected, only a single clip may be archived per 
partition.

4. Click OK.
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Viewing Library, Cartridge and Archived Clip Properties
To view the properties for the library:

1. Select the library icon in the tree pane.

2. Choose Properties either from the File menu or from the shortcut menu with 
a right-click. You can also click the Properties button on the toolbar. The 
library properties dialog box appears.
0 Profile Family

Figure 70. Properties dialog box for the library 

3. Click OK when you are done viewing the library properties.
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To view the properties for a cartridge:

1. Select a cartridge icon in the tree pane.

2. Choose Properties from the File menu or from the shortcut menu with a 
right-click. You can also click the Properties button on the toolbar. The 
cartridge properties dialog box appears.

Because the size in megabytes is constant, the available time is an 
approximation based on the settings in the Anticipated Video and Audio 
Quality boxes. The higher the quality, the less time is available for storage.

3. Click OK when you are done viewing the cartridge properties.
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Figure 71. Properties dialog box for a cartridge
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To view the properties for a archived clip on a cartridge:

1. Select a clip icon in the contents pane.

2. Choose Properties from the File menu or from the shortcut menu with a 
right-click. You can also click the Properties button on the toolbar. The clip 
properties dialog box appears.
2 Profile Family

Figure 72. Properties dialog box for an archived clip 

3. Click Read-only if you want to prevent modifying, renaming, or deleting the 
clip.

4. Click OK when you are done viewing the clip properties.



Viewing Tape Transport Status

153

Viewing Tape Transport Status
To view the status of the tape transports in the library:

1. Choose Tape Transport Status from the File menu or from the shortcut 
menu with a right-click. The Tape Transport Status dialog box appears.
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Figure 73. Tape Transport Status dialog box 
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The labels in the dialog box are explained here:

Transport Icon A transport icon is shown for each active transport
in the library. The order of transports in this dialog
does not necessarily reflect the order they appear in
the library system.

Transport Number This is the logical identifier for the transport. It is a
number from 0–255.

Robot Position This is the physical transport identifier. It is a num-
ber from 0–3.

Cartridge Name A cartridge name is shown if one is currently loaded
4 Profile Family

To add a transport to the list of active transports:

1. In the tree pane, select the appropriate library icon.

2. Choose Tape Transport Status from the File menu, or from the shortcut 
menu with a right-click. The Tape Transport Status dialog box appears.

3. Click the Add button. The Add Tape Transport dialog box appears, as shown 
in Figure 74.

into the transport.

Disable Removes a transport from service. Click Add to re-
enable the transport.

Clean Loads a cleaning cartridge and cleans the transport

Cleaning Message The message Needs Cleaning appears when the
transport is due for cleaning.

Add Adds a transport to the list of available transports.

Close Close the Tape Transport Status dialog.

Help Opens the help topic on the Tape Transport Status
dialog.
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Figure 74. Add Tape Transport dialog box 

4. Enter the logical transport number (0–255).
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5. Enter the physical robot position (0–3).

6. Click OK.

7. Click Close when you are done viewing the transport status.

To remove a tape transport from service:

• Click the appropriate Disable button.

To clean a tape transport:

• Click the appropriate Clean button. A tape transport does not need cleaning 
until the “Needs Cleaning” message appears beside the Clean button. The 
library system will find the first available cleaning cartridge in the system 
and use it to clean the selected transport. If the library system is unable to 
find the cleaning cartridge—that is, there is no cleaning cartridge in the 
library—you will get a message stating that no cleaning cartridge was found. 
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Viewing the Transfer Monitor
When clips are copied to a different machine, the media that is referenced by 
those clips is also copied. This is made possible by using a combination of 
Ethernet and Fibre Channel networks. Ethernet is used for lower-speed 
database transfers and queries. The high speed Fibre Channel network is used 
for transferring the actual media between machines.

Copying media is done in the background to allow you to continue with your 
work. Adding to and restoring from an archive also is done in the background. 
Since this may result in more than one transfer occurring at the same time, the 
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Transfer Monitor is used to keep track of these background tasks. Each time a 
media transfer is started, a new entry appears in the Transfer Monitor.

The Transfer Monitor can be opened at any time. It consists of two tabs: the 
Network tab which shows all copies over Fibre Channel and Duplicates in 
progress; and the Library tab which shows any ongoing library transactions. 

To track background operations with the Transfer Monitor:

• Choose Tools | Transfer Monitor or click the Profile logo on the toolbar. 
The Transfer Monitor dialog box appears. 

Figure 75. Transfer Monitor dialog box 
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The Profile logo on the Media Manager toolbar is animated whenever there is 
an archive item in the Transfer Monitor, whether the Transfer Monitor is open 
or not. If there are only error items in the Transfer Monitor the error logo 
appears, without animation.

The Network tab divides entries into four columns: source, destination, percent 
complete, and average megabytes per second. When copying, source and 
destination paths are constructed using the machine/volume/bin/clip names. A 
destination clip name may be different from the source clip name if the clip was 
renamed when pasted or moved to the new location (which has to be done when 
a clip with the same name already appears at the new location).
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The Library tab divides entries into four columns: operation, source, 
destination, and percent complete. Library operations that occur in the 
background include archive, restore, inventory, update, format, delete, import, 
clean, and export. The destination column is only filled in for the archive and 
restore operations. The percent complete column will show Pending while a 
cartridge is being loaded into a transport and cued to the correct tape position.

NOTE: Only network, library archive, and library restore transactions can 
be cancelled.

To interrupt a transfer do the following:

1. Click the Network or Library tab depending on the type of transfer you wish 
to interrupt.

2. Select the transaction you wish to interrupt.

3. Click the Cancel Transaction button. (This button is unavailable unless the 
transaction is highlighted.)

The label for this button is context specific. If an archive transaction was 
selected, the button is labeled Cancel Archive. If a network copy was selected, 
the button is labeled Cancel Transfer.



Chapter 3 Using Media Manager

15

Occasionally an error will occur while a transfer is in progress. The destination 
machine may have unexpectedly run out of storage, the network connection 
may have gone down, there may have been trouble reading an archive library 
cartridge. An error is indicated by a change in the Profile logo.

In the Transfer Monitor, entries that could not complete due to error are 
displayed in red and their percent complete shows Error. When the entry is 
selected, a short description of the error is shown at the bottom of the window. 
To remove the entry, select it and then click the Remove button.
8 Profile Family
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Storing media on a Profile disk recorder rather than on tape opens the door to 
almost instant access to digital video and audio material. Media is available to 

ile’s channels at once, so you can play a video and audio clip on more 
hannel at the same time. Since each of the channels is independent, 
an start at a different time and place in a clip. One of the best features 
all of Prof
than one c
playback c
59

of the Profile system is that you can start playing material while it’s still being 
recorded. 
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The basic element of digitally stored video and audio is the clip. A clip is a 
reference to video, audio, and timecode material recorded in media files on the 
Profile media disks. A clip has a beginning and an end, and, when first recorded, 
the beginning and end correspond to the first and last frames stored in the media 
file, but a clip may refer to the entire media file or just part of it. When you 
delete a clip, the media file that the clip refers to remains on disk if at least one 
other clip refers to it—only the reference to the media file is deleted, not the 
media itself. 

You can mark in and out points in a clip. These marks change the effective 
beginning and end points of a clip, while not removing the associated material 
from the media file. On the other hand, you can trim media to remove material 
from either end of a clip, which also removes the information from the media 
file. Trimmed material is permanently removed from disk and is no longer 
available for use. 

The default tool for creating and playing clips on the Profile system is VdrPanel. 
VdrPanel provides you with a VTR-like interface—complete with transport 
controls—to directly manage media operations. Once created with VdrPanel, 
clips are available for use with optional Profile applications, such as Tool Box 
Editor or the List Manager. 

VdrPanel allows you to configure any or all of your channels for operation 
through a controller connected to an RS-422 serial port. These controllers either 
comply with Profile Protocol, such as the optional PRC100 Profile Remote 
Control unit, or with Louth, Odetics, BVW, or BVW [insert edit] protocols. 
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Before using VdrPanel to capture clips, you must complete a few steps: 

1. You must decide whether you want to use the Windows NT interface (called 
Panel Control) to capture and play clips, or if you want to use an external 
device to control your Profile system. To select a controller, see “Selecting 
a Controller” on page 161. 

2. You need to configure the playback and record JPEG and MPEG channels, 
audio channels and the VITC timecodes for your selected controller. To 
configure the controller, see “Configuring a Controller” on page 165. 

3. You must set video crosspoints or connections. This means that you can 
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select video inputs, codecs, and outputs. You can also choose to bypass 
codecs. See “Selecting Video Crosspoints” on page 175. 

4. You can select timecode panel display, which timecode generators to use, 
select drop-frame timecode, and also set timecode crosspoints—inputs, 
generators, and outputs. See “Setting Timecode” on page 177. 

For information on how to start and close VdrPanel, see “Starting and Closing 
Profile Applications” on page 31. 

The VdrPanel window is shown in Figure 76. By default, the VdrPanel window 
appears automatically at power-up, unless you log in manually. You display all 
available panels in the VdrPanel window—up to eight with MPEG. Each panel 
is dedicated to one video channel. 
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Figure 76. VdrPanel window 

Selecting a Controller 
Before you can use a video channel, you must first configure it to use a 
controller. The default controller is Panel Control. Panel Control specifies 
control from the Windows NT user interface and no communication port 
selection or additional configuration is necessary.

Other controller choices allow you to select serial control protocols and require 
an external device and additional setup, such as selection of a serial 
communications port or specifying clip length for BVW-type controllers. The 
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Comm Port dialog box appears automatically the first time you select a Louth, 
Odetics, or BVW controller (see “Selecting a Communications Port” on page 
163). 

NOTE: The Controller | Manage Archive menu command is 
available under special circumstances in Louth Automation. Contact 
your Grass Valley Group representative for more information. 

To select a controller: 

1. Click a panel to make it active. 
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2. Choose Controller | Select to open the Controller Setup dialog box (Figure 
77). 

3. Select the controller for the channel, such as Louth Automation. 

4. Click OK. 

Figure 77. Controller Setup dialog box
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Selecting a Communications Port 
To select a serial communications port for an external controller: 

1. Click a panel to make it active. 

NOTE: Other than for Panel Control, the Comm Port dialog box 
appears automatically the first time you select a controller.

2. Choose Controller | Comm Port to open the Comm Port dialog box. An 
example of this dialog box is shown in Figure 78. 
Profile Family

Figure 78. Comm Port dialog box

NOTE: Ports P1 through P8 are available on the RS-422 Connector 
Panel. COM1 and COM2 are available on the unit’s back panel
(RS-232 DB-9 connectors). Any P ports used by VdrPanel should 
have the DIP switches set to Device (DIP switch must be down). 

3. Select a serial communications port, such as P1. 

4. Click OK. 
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Selecting Clip Length (BVW Only) 
If you have chosen a BVW controller, you can specify clip length by setting 
mark in and mark out points:

NOTE: The Set Clip Marks (clip length) dialog box shown here will 
not appear unless the panel controller is a BVW controller. This is 
not the same as setting clip length while in Loop or Bounce mode. 

1. Click a panel to make it active. 

2. Choose Controller | Clip Length. The Set Clip Marks dialog box appears 
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(Figure 79).

Figure 79. Set Clip Marks dialog box 

3. Enter the mark-in and mark-out points by specifying the hour, minute, 
second, and frame settings. This applies to future clips only, unless you 
perform step 4.

4. Click Apply to Loaded Clip(s) if you want the mark-in and mark-out points 
to apply to existing clips as well as future clips. 

5. Click OK. 
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Configuring a Controller 
To configure the playback and record JPEG or MPEG channels, audio channels 
and the VITC timecodes for the selected controller: 

1. Click the panel to make it active. 

2. If any clips are loaded in the panel, choose VideoClip | Eject All Clips. You 
cannot configure a panel with a controller if any clips are present in it. 

3. Choose Controller | Configure to open the Profile Options dialog box for the 
selected panel. Figure 80 illustrates the standard Profile options with an 
example configuration selected; Figure 81 illustrates the Profile Options 
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dialog box for BVW [insert-edit], also with appropriate selections shown. 

4. Click on the appropriate video, audio, and timecode resources for your 
selected controller. Use the scroll bars, if necessary, to see more resources. 

NOTE: Recording format depends on the selected video resource, 
either JPEG or MPEG Rec. 

5. Click OK. 
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Figure 80. Profile Options dialog box
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Figure 81. Profile Options dialog box (BVW [insert-edit] only)
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Setting Compression Presets 
The Profile Options dialog box lets you select a video compression preset and 
edit the preset values. 

1. Click the desired compression preset. The options range from highest 
quality, which uses the most disk space and records less material, to the 
lowest quality, which uses much less disk space and records more material. 
A custom setting is also available. 

2. Edit the preset values. Refer to Table 8 for the JPEG factory-set preset values 
and to Table 9 for the MPEG values. To change the values, click Edit 
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Presets to open the Edit Compression Presets dialog box shown in Figure 
82. You can change the values of the presets, if desired. Select the preset in 
the Preset Name box, change the values under JPEG or MPEG, and then 
click OK.

Table 8. Factory set values for JPEG compression presets 

Preset Name
525/60 Standard 625/50 Standard

Min 
Lum Q

Max 
Chroma Q

Bytes/Field Min 
Lum Q

Max 
Chroma Q

Bytes/Field

Highest quality 0.75 60.00 100000 0.75 100.00 120000

Best compromise 0.75 60.00 75000 0.75 100.00 90000

Most recording time 0.75 60.00 50000 0.75 100.00 60000

Custom setting 5.00 5.00 5.00 5.00
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3. For JPEG settings: 

- Min Lum Q sets the minimum compression that can be applied to 
luminance in a field to meet the target data rate, typically 0.75, which is 
also the lowest rate. 

- Max Chroma Q sets the maximum compression that can be applied to 
chrominance in a video field to meet the target data rate (typically 60). 

- Fixed Q sets a fixed picture quality and ignores variation in field size. Use 
this mode for critical multigeneration work. When Fixed Q is selected, the 
other fields become fixed as Lum Q (fixed luminance compression) and 
Chroma Q (fixed chrominance Q). Useful starting values for Fixed Q and 
Profile Family

Chroma Q are 5.00. Verify that there is sufficient available data rate 
headroom before using Fixed Q mode. The Bytes per Field target 
attempts to meet the Lum and Chroma goals. With Fixed Q mode, Bytes 
per Field can increase beyond the system bandwidth, causing interference 
with other channels. 

- Bytes per Field is the target compression rate. Not every field requires 
the target rate, it is simply the average rate the disk recorder tries. The 
higher the rate, the better the picture detail. The actual Bytes per Field 
depends on the picture complexity, Min Lum Q, and Max Chroma Q. The 
algorithm dynamically changes Min Lum Q and Max Chroma Q to make 
the field size meet the target unless Fixed Q is selected. 
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4. For MPEG settings: 

- Select 4:2:2 or 4:2:0 chroma sampling. 

Table 9. Factory set values for MPEG compression presets 

Preset Name Bit Rate 
(Mb/sec)

P Pictures 
per GOP

B Pictures 
per I/P

Chrom Open GOP

Highest quality 24 5 2 4:2:2 No

Best compromise 15 5 2 4:2:2 No

Most recording time 4 5 2 4:2:0 No

Custom setting 4–44 2 2 4:2:0 Yes
0 Profile Family

- # P per GOP is the number of P pictures (predictive pictures) in a group 
of pictures (GOP). 

- # B per I/P is the number of B pictures (bidirectionally predictive 
pictures) for every I-frame or P picture. B pictures improve compression 
efficiency. 

NOTE: Placing zeros in both # P per GOP and # B per I/P boxes 
forces pictures to be I-frame only. 

- Open GOP is a group of pictures that has a B picture as its last picture type 
for the next I-frame, such as IBBPBBPBBI, and so on. An Open GOP 
depends on the next GOP’s anchor to define its last B picture.

- First encoded line is the number of first encoded line of video. Lines in 
a 525 system are in the range 21–260; 625 lines are in the range 7–310. 

- Last encoded line is the number of the last encoded line of video. 

- Bit rate in megabits per second. The higher the bit rate, the higher the 
video quality, though more disk space is used. In other words, the higher 
the video quality, the fewer hours of video you can store on disk. 

5. Click OK. 
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Figure 82. Edit Compression Presets dialog box 

Selecting Vertical Blanking Interval Storage Lines
The MPEG section of the Edit compression presets dialog box has a button 
labeled VBI lines (see Figure 82). This button opens the Vertical Blanking 
Interval Storage dialog box (see Figure 83) which allows you to select from one 
to three lines in the vertical blanking interval (VBI) that will not be compressed 
with the video data, but will be stored without being encoded to avoid losses. 
This is desirable for uses such as closed captioning which would be seriously 
degraded by losses incurred at lower bit rates.

The Compress VBI checkbox at the top forces all the lines in the VBI to be 
compressed. The other checkboxes allow you to select up to three of the 
Luminance or Chrominance lines.
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Figure 83. Vertical Blanking Interval Storage dialog box

Setting up BVW [insert edit] Emulation 
This procedure sets up a panel to emulate a Betacam. Refer to the manual for 
your hardware controller device to set up Super-Edits or BVEs.

NOTE: This procedure requires access to two control ports. Close a 
panel to free a control port for use with the BVW [insert edit] panel. 

1. Click within a BVW [insert edit] panel to select the panel. Refer to 
“Selecting a Controller” on page 161 if you have not already selected BVW 
[insert edit] as the controller for this panel.
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NOTE: If you do not select BVW [insert edit] for the panel, insert edit 
operations are not properly executed. The channel can be used as a 
source deck, or be acceptable for remote control systems, such as the 
Ash-Vale slow-motion controller, that do not use EditOn commands.

2. Choose Controller | Configure to open Profile Options (see Figure 80 on 
page 167). 

3. Select two unused video codecs: one for Playback Video, and one for Record 
Video. For example, use JPEG #3 for Playback Video, and JPEG #4 for 
Record Video. Use Controller | Configure with the other panels to assure the 
codecs are not in use.
Profile Family

4. Select two pairs of audio channels. For example, select Chan #9 and Chan 
#11 for the Playback Audio and Chan #10 and Chan #12 for the Record Audio. 
Audio channel pair selection must follow these rules:

- The playback/record audio channel pair must be sequentially numbered. 
For example, Chan #1 and Chan #2 or Chan #14 and Chan #15.

- The playback/record pair must be with the same channel group. Channels 
are grouped as sets of four: Chan #1 through #4, Chan #5 through #8, Chan 
#9 through #12, and Chan #13 through 16.

- The playback is assigned to the first selected codec in the pair, record is 
assigned to the second selected codec in the pair. For example, playback 
assigned to Chan #14 and record assigned to Chan #15.

NOTE: There must be two audio channels assigned for each audio 
track to be recorded.

5. Select two pairs of timecode. For example, select TCREC #5 and TCREC #7 
for the Playback Timecode and TCREC #6 and TCREC #8 for the Record 
Timecode.

6. If any other selections are highlighted, click to deselect them.

7. Select the video compression to be applied; see “Setting Compression 
Presets” on page 168 for more information on video compression and the 
presets.

8. Click OK.

9. Choose Controller | Comm Port to open the Communication Port dialog 
box (see Figure 78 on page 163).
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10. Select the RS-422 communication port to be used for the edit controller—for 
example, P3. The Port name is the same as the name on the RS-422 breakout 
box. 

11. Click OK.

12. Verify the external connections:

- Source audio channels are connected to the inputs for the audio channels 
assigned as the Record Audio.

- Audio outputs from the disk recorder are connected to the audio channels 
assigned as the Playback Audio.
4 Profile Family

- Edit controller is connected to the assigned Port. Refer to the device’s 
installation manual.

- DIP switch on the breakout box is set to Device for the RS-422 Port. Refer 
to the breakout box installation manual.

NOTE: Insert edits for MPEG clips using the BVW or BVW [insert 
edit] controllers are not possible unless the clip is I-frame only. An 
inset edit is accomplished by over-recording previously recorded 
portions of video or audio material. 

Setting Louth Modes 
If you use Louth Automation, you can set a panel to Louth modes. Normally, 
when a clip is cued, a freeze or confidence frame appears on the monitor instead 
of a regular video input feed. In Louth switcher mode, you do not see a 
confidence frame: you see video input from the feed until you play the clip. 
When the clip is done playing, you immediately see the regular video input 
again. 

Without Louth end mode, you may see a few fields of a following clip, even if 
you don’t intend to play it. Louth end mode ensures that after playing a clip in 
a list, timecode freezes at the first frame of the next clip in that list. 

NOTE: Louth menu commands are available only when the panel 
controller is set to Louth Automation. 
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To set a panel to Louth switcher mode: 

1. Click the panel to activate it. The panel controller must be Louth 
Automation. For information on how to set the controller to Louth 
Automation, see “Selecting a Controller” on page 161. 

2. Choose Options | Louth Switcher Mode. A check mark appears next to 
Louth Switcher Mode in the Options menu to show that it is activated.

3. To return the panel to normal mode, choose Options | Louth Switcher 
Mode again. 

To set a panel to Louth end mode: 
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1. Click the panel to activate it. The panel controller must be Louth 
Automation. For information on how to set the controller to Louth 
Automation, see “Selecting a Controller” on page 161. 

2. Choose Options | Louth End Mode. A check mark appears next to Louth 
End Mode in the Options menu to show that it is activated.

3. To return the panel to normal mode, choose Options | Louth End Mode 
again. 

Selecting Video Crosspoints 
A video crosspoint shows the connection between a video input and output, 
with a JPEG codec, MPEG encoder, or MPEG decoder between.

• Video inputs (top-left corner) represent video input connectors on the back 
panel. For example, video inputs can be connected to JPEG codecs or MPEG 
encoders for recording onto disk, or connected to video output for display.

• Video outputs (top-right corner) represent video output connectors on the 
back panel. For example, video outputs can be connected to JPEG codecs or 
MPEG decoders for playback of recorded material from disk or to video 
inputs.

To specify video crosspoints:

1. In VdrPanel, choose Window | Video Crosspoint to open the dialog box. 
The green boxes indicate current connections. For example, a green box at 
the intersection of a SDI-InA-J14 serial digital video board in slot J14 and 
a Panel A: MPEG Rec #1 encoder connects the video signal from the back 
panel input labeled Video I/O Serial Digital Component IN A to an MPEG 
encoder.
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Figure 84. Video Crosspoint dialog box 

2. To assign a crosspoint, click in the intersection boxes between a video signal 
and a JPEG codec, MPEG encoder, or MPEG decoder. The selection boxes 
turn green. You can also select a video signal, and while holding down the 
left mouse button, stretch a line to the desired resource. 

NOTE: Verify that you have the appropriate BNC connections on the 
rear panel.

3. Click the Close button.
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Setting Timecode 
You can set timecode crosspoints, select drop-frame timecode, or select 
timecode panel display and generators.

Selecting How to Display Timecode on a Panel 
The Timecode Setup dialog box enables you to set the timecode display and the 
timecode source on a channel to the values required for your application.

1. Click in a panel to select it.
Profile Family

2. Choose Options | Select Timecode to open the Timecode Setup dialog box. 
The Timecode Setup dialog box is divided into two groups: Display on Panel 
and Timecode Generator Settings.

Figure 85. Timecode Setup dialog box 

3. Select the timecode to be displayed on the panel from the Display on Panel 
group:

- LTC Input is a separate signal input via the genlock card.

- VITC Input is the timecode from the VITC input signal. 
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- Compute from Field Number calculates the timecode directly from the 
field number of the recorded video. New clips start at 00:00:00:00. 

- TC Rec # displays the recorded timecode. 

- Generator displays the timecode from the generator for the channel. 

4. Set up the timecode generator used by the panel with the Timecode Generator 
Settings group: 

- Free Run causes the timecode generator to continue to advance regardless 
of the current play or record mode of the panel. 

- Freeze locks the timecode at the current value. The value does not 
8 Profile Family

advance with time nor with changes in the play or record mode of the 
panel. 

- Lock to Field Number causes the generator to output a timecode locked 
to the current clip’s timecode. When the panel is in stop, the value freezes. 
When the panel is in play or record, the timecode advances normally. 
During rewind or reverse shuttle, the timecode runs backward. 

- Regenerate pertains to BVW controllers only. When the timecode 
position is changed to a new portion of the clip, and a record operation 
includes recorded timecode tracks (which happens with assemble edits 
from BVE and other controllers), the timecode generator is initialized to 
match the timecode read from the timecode track (VITC or LTC) before 
the record occurs. 

- The Reset To button resets the timecode to the value entered in the box. 
The generator can be set to this value when Free Run, Freeze, or Lock to 
Field Number is selected. 

5. Click Close. 

Setting Timecode Crosspoints 
The Timecode Crosspoint dialog box controls the connections of timecode 
signals within the Profile system. 

• Timecode inputs (top-left corner) represent either LTC input connectors on 
the back panel or VITC input signals. Timecode inputs can be connected to 
timecode recorders for recording onto disk.

• Timecode generators (below timecode inputs) represent timecode generators 
used by the panels. Timecode generators can be connected to timecode 
recorders for recording onto disk or to timecode outputs. 
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• Timecode outputs (top-right corner) represent either LTC output connectors 
on the back panel, or VITC output signals. Timecode outputs can be 
connected to timecode recorders for playback of recorded material from 
disk, to timecode inputs, or to timecode generators.

1. Select Window | Timecode Crosspoint to open the Timecode Crosspoint 
dialog box. The green boxes indicate the current connections. For example, 
a green box at the intersection of TCRec#1 and GenlockVITC-InA-J16 
indicates the timecode signal from the back panel input is recorded by 
timecode recorder #1.
Profile Family

Figure 86. Timecode Crosspoint dialog box

2. To assign a crosspoint, click in the intersection between the signal and the 
recorder channel. The selections turn green.
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NOTE: A timecode recorder must be used by a panel to be available 
as a timecode output.

3. Click the Close button.

NOTE: To release a timecode output for use by another application, 
click the box at the intersection of the output with the unused box.

Setting Drop-Frame Timecode 
In NTSC and 525/60, you don’t actually get 30 frames per second; the real 
number is about 29.97 fps. Timecode usually assumes 30 fps. To account for 
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the discrepancy, drop-frame timecode skips or drops two timecode values at the 
beginning of every minute except every tenth minute. This allows timecode to 
exactly match a real-time clock on 525/60 systems. This correction is not 
needed on PAL or 625/50 systems because the frame rate is exactly 50 fps.

To set drop-frame timecode:

• Choose Options | Drop-Frame or Options | Non-Drop-Frame.

NOTE: This setting applies to all open panels (channels).

Panel Basics 
In the VdrPanel application, you can display up to eight Panel dialog boxes at 
a time, one for each video channel. Each Panel dialog box has independent 
controls. A close-up view of a Panel dialog box is shown in Figure 87. A 
description of each Panel function follows.

NOTE: If the panels are stacked, choose Window | Tile Panels.

The VdrPanel interface follows the same conventions as other Windows NT 
applications: the control menu box, title bar, menu bar, minimize and maximize 
buttons, mouse and keyboard all perform as expected. Refer to specific 
operating information about these items in the Windows NT manuals.
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2. Size3. Timecode
4. Play

6. Rewind

5. Stop

7. Record

8. Fast

9. Field

Forward

Selection 26. Shuttle Bar

27. Shuttle Rate

28. Clip Name
Box

1. Type
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Figure 87. Panel dialog box 

1. The Type box shows the type of pictures: I for I-frame, B for Bidirectional, 
and P for Predictive. B and P apply only to MPEG pictures. An I-frame 
picture or Intra-picture is analogous in JPEG and MPEG and so applies to 
both. 

2. The Size box shows the number of bytes stored for the current field. The 
more detailed the picture, the higher the number of bytes. Target 
compression rate is set in the Edit Presets dialog box accessed from 
Controller | Configure. See “Configuring a Controller” on page 165. 

3. The Timecode box is the current timecode of the selected clip. To configure 
timecode, refer to “Setting Timecode” on page 177. For example, when you 
use slow motion replays from several camera angles, the timecode can free 
run or freeze. Clicking on the Timecode box brings up the Go To Timecode 

10. Normal
11. Loop

12. Bounce

13. PB/EE

14. Clip
Position Bar

15. Remove In
Mark

16. Set In
Mark

17. Trim to
In Mark

18. Trim from
Out Mark

19. Set Out
Mark

20. Remove
Out Mark

21. Group Name

22. Go to 
Clip End

23. Forward
One Field

24. Back One
Field

25. Go to Clip
Beginning

Box
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dialog box. Entering a new timecode value and clicking OK moves a clip to 
a specific timecode location. If there is no recorded timecode, VdrPanel 
displays a timecode calculated from the current position (00:00:00:00 or 
above). 
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4. The Play button runs the selected clip at normal speed. If there are multiple 
clips in the clip list, Play starts with the first selected clip and proceeds 
through the list. Normal, Loop, and Bounce modes determine how the clip 
or clip list is played. 

5. The Stop button halts the current Play, shuttle, or Record function.

6. The Rewind button shuttles the clip backwards to the beginning (the first 
available field or in mark) of the selected clip. Use Go To Clip Beginning 
or enter a timecode value in the Timecode box to move directly to the 
beginning without shuttling.

7. The Record button starts storing the incoming video as JPEG or MPEG 
streams and audio under the selected clip name. If no clip is selected, a 
default clip name (pound sign [#] followed by a number) is assigned. (See 
“Defining a New Clip” on page 190.) The record process continues until the 
disk decoder runs out of storage space or you click another command button, 
such as Stop. Recording does not start unless there is a video signal assigned 
to the selected panel and there is disk storage available. 

8. The Fast Forward button shuttles the clip forward to the end. Use Go to Clip 
End or enter a value in the Timecode box to move directly to the end of the 
clip without shuttling. 

9. The Field Selection button selects a one-field or two-field display during 
still mode. One-field display eliminates temporal artifacts, while two-field 
display provides the best vertical resolution. 
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10. The Normal normal plays the selected clip or clip list to the end, freezing on 
the last field of the clip or of the last clip in the list. 

11. The Loop button plays the selected clip or clip list continuously, looping 
back to the beginning of the clip when the clip ends, or in the case of a clip 
list, looping back to the first clip in the list when the last clip ends. If you 
create a clip while in Loop mode, you are asked to enter a clip length in the 
form 00:00:00:00 (Hours:Minutes:Seconds:Frames). The Record operation 
will automatically stop at the specified timecode, thus protecting disk 
storage space. 

12. The Bounce button plays the selected clip or clip list continuously, until at 
Profile Family

the end of the clip, it plays the clip in reverse, or in the case of a clip list, it 
plays to the end of the clip list, then reverses the sequence, playing all the 
clips in reverse order. If you create a clip while in Bounce mode, you are 
asked to enter a clip length in the form 00:00:00:00 
(Hours:Minutes:Seconds:Frames). The Record operation will automatically 
stop at the specified timecode, thus protecting disk storage space. 

13. The PB/EE (Playback/E to E) button determines the action during Stop or 
Record. If you select Playback, the recorded image is displayed as a still 
during Stop, and audio is silenced. If E to E is selected, the input signal is 
routed through to the display during Stop or Record. 
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14. The Clip Position Bar displays the relative position of the current frame 
within the current clip. For example, if the Clip Position Bar is to the far left, 
the frame is at the beginning of the clip; if it is at the far right, the frame is at 
the end. Click on the bar to activate it or press j or ↓ . 

15. The Remove In Mark button removes the in mark and restores the clip to its 
first available field.

16. The Set In Mark button sets the in mark for the current clip at the current 
timecode (you can also press i). When the clip is played, it starts at the in 
mark instead of the clip beginning; however, the portion before the in mark 
is not lost. Use Remove In Mark to remove the in mark. The in mark only 
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affects this instance of the clip. If the clip repeats in the clip list or is used by 
another panel, this in mark is not automatically present.

17. The Trim to In Mark button removes the portion of the current clip preceding 
the in mark (you can also press c). This action affects all copies of this clip 
on all panels. The trimmed material is not retrievable. A warning message 
and verification prompt are displayed before the material is trimmed. 

18. The Trim from Out Mark button removes the portion of the current clip 
following the out mark (you can also press u). This action affects all copies 
of this clip on all panels. The trimmed material is not retrievable. A warning 
message and verification prompt are displayed before the material is 
trimmed.

19. The Set Out Mark button sets an out mark for the current clip at the current 
timecode (you can also press o [not zero]). When the clip is played, it ends 
at the out mark; however, the portion after the out mark is not lost. Use 
Remove Out Mark to remove out mark. An out mark only affects this 
instance of the clip. If the clip repeats in the clip list or is used by another 
panel, the out mark is not automatically present.

20. The Remove Out Mark button removes the out mark and restores the clip to 
its last available field.

21. The Group Name box lists the name of the current clip list.
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22. The Go to Clip End button jumps to the end of the current clip. You can also 
press e. 

23. The Forward One Field button moves the current clip position forward one 
field. You can also press the → key. In addition, Shift + → advances the clip 
position 10 fields or 5 frames, and Ctrl + → advances the clip position 100 
fields or 50 frames. 

24. The Back One Field button moves the current clip position backward one 
field. You can also press the ← key. In addition, Shift + ← reverses the clip 
position 10 fields or 5 frames, and Ctrl + ← reverses the clip position 100 
fields or 50 frames. 
Profile Family

25. The Go to Clip Beginning button jumps to the beginning of the current clip. 
You can also press t. 

26. The Shuttle Bar sets the shuttle rate. Use the mouse to drag the pointer to 
the desired shuttle rate (displayed in the Shuttle Rate box). When you click 
on the shuttle bar, the disk recorder enters shuttle mode. You can also press 
h. 

27. The Shuttle Rate box displays the current shuttle rate. This number ranges 
from –16.00 to +16.00, with the positive numbers indicating forward motion, 
negative numbers reverse, and 0.00 still. This number can be set by clicking 
on the Shuttle Rate box to open the Shuttle Rate dialog box, entering a 
shuttle rate and clicking OK. You can also drag the Shuttle Bar to a desired 
position. If the shuttle rate is set faster than the maximum rate for the 
controller, the maximum rate is displayed. 

28. The Clip Name box lists the names of the clips in the current clip list.
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The functions on the Panel dialog box can be accessed directly by clicking on 
the appropriate button with the mouse or by using the shortcut keys shown in 
Table 10. For example, pressing Shift + R starts recording in the active panel.

Table 10. VdrPanel shortcut keys

Shortcut Key Function Shortcut Key Function

Shift + R Record Ctrl + → Forward 100 Fields

w Rewind Ctrl + ← Back 100 Fields

s Stop j or ↓ Jog controls
6 Profile Family

Opening a Panel 
If none of the panels are visible, here are the steps to open a panel:

1. Choose Window | Open Panel. The Open a Panel dialog box appears 
(Figure 88). 

p or ↑ Play e Go to Clip End

f Fast Forward h Shuttle controls

spacebar Stop t Go to Clip Beginning

Ctrl + A thru H Activate panel A thru H i Set Mark In

→ Forward 1 Field o Set Mark Out (not zero)

← Back 1 Field c Trim to Mark In

Shift + → Forward 10 Fields u Trim from Mark Out

Shift + ← Back 10 Fields F1 Start Help
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Figure 88. Open Panel dialog box 

2. Select the panel you want to display, Panel A through H. Only panels that are 
not currently open appear in the dialog box. You can also press Ctrl + A 
through Ctrl + H to activate panels A through H. 

3. Click OK. 

Making a Panel Active 
To make a panel active, such as Panel A, do either of the following:

• Click anywhere inside Panel A, if open. 
Or: 

• Choose Window | 1 Panel A: Panel Control. 

Arranging Panels and Icons 
If a panel is obscured by another panel, you can arrange the panels so that they 
are all completely visible. To arrange the panels in this way: 

• Choose Window | Tile Panels.
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If you have minimized the panels, you can arrange the icons with: 

• Choose Window | Arrange Icons. 

Viewing Record Capacity 
The Record Capacity dialog box shows the amount of recording time remaining 
on the current media disk volume according to the current compression presets. 
To view the recording capacity: 

1. Click a panel to make it active. 

2. Choose Window | Record Capacity. A message box appears (Figure 89). In 
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this instance, the message box shows the internal disks labeled INT:. The 
recording time remaining is represented in Hours:Minutes:Seconds. For 
more information on compression presets, see “Setting Compression 
Presets” on page 168. 

Figure 89. Message box showing record capacity 

3. Click Close. 

Viewing an Audio Monitor for a Panel 
The Audio Monitor allows you to monitor the level of an audio signal for a 
panel. To view a panel’s audio monitor: 

1. Click a panel to make it active. 

2. Choose Window | Audio Monitor. The Audio dialog box appears, as shown 
in Figure 90. There are only two channels in this example, but up to 32 
channels are possible if the necessary boards are installed. 
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Record Level Controls

Peak Indicators

Channel Indicators 

Close Button
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Figure 90. Audio Monitor dialog box 

3. To turn peak hold on or off, choose PeakHold | On or PeakHold | Off. By 
default, peak hold is on. The peak indicators, the white bars in record level 
controls, indicates the audio peak you are currently recording. 

4. To show the record level controls, choose Levels | Show Record Level 
Controls. To show play level controls, choose Levels | Show Play Level 
Controls. To hide the level controls, choose Levels | Hide Level Controls. 

5. To work the record and play level controls independently, choose Levels | 
Independent Controls. To gang the controls, choose Levels | Ganged 
Controls. 

6. Click Close ( ). 

Play Level Controls
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Using Clips
With VdrPanel, you can define, rename and delete a clip. You can load an 
existing clip or group of clips.

Defining a New Clip
There are two methods for defining clips:

• You can create and name an empty clip, then record to it (Name Clip First).

• You can start recording with an empty clip list, then rename the recorded clip 
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to a meaningful name (Record Clip First).

Either method creates and stores a named clip. Use whichever method is most 
convenient for you. You can choose VideoClip | Rename Clip at any time to 
change a clip name.

Name Clips First

To define a clip by first naming the clip:

1. Click in a panel to select it.

2. Select VideoClip | New Clip to open the New Clip dialog box (Figure 91).

3. Select a drive from the Drive list. The number of drives available depends 
on your hardware.

4. Enter a clip name, up to 32 characters long. Spaces and uppercase characters 
are acceptable; however, uppercase and lowercase characters will not 
distinguish clip names.

5. Click OK. The new clip is added to the clip list for the selected channel.

6. If the Loop or Bounce buttons are pressed in the panel, a dialog appears 
asking you to specify the loop or bounce duration in the form 00:00:00:00.

7. Click the Record button (in the selected Panel dialog box) to begin 
recording. The timecode and compression rate fields are updated.

NOTE: A video input signal must be present on the selected channel 
for recording to start.

8. Click Stop to stop recording.
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Figure 91. New Clip dialog box
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Record Clips First

To define a clip by recording and then naming the clip:

1. Click a panel to select it.

2. If any clips are listed in the Clips box, choose VideoClip | Eject All Clips to 
clear the clip list.

3. Click the Record button in the selected Panel dialog box to begin recording. 
A clip named #1 (or other number for a unique clip name) appears in the clip 
list for the panel.

4. If you are in Loop or Bounce mode, the clip is limited in size to either 1,000 
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fields or to the last clip length specified in the Loop/Bounce Length dialog 
box. 

5. Click Stop to stop recording.

If you repeat these steps to record additional clips, they are named 
sequentially—one higher than the previous clip. For example, #2, #3, and so 
forth.

6. Choose VideoClip | Rename Clip to open the Rename Video Clip dialog 
box (see “Renaming a Clip” on page 194).

7. Click on the clip to be renamed (such as #1).

8. Enter the new name in the To field. Spaces and uppercase characters are 
acceptable; however, uppercase and lowercase characters will not distiguish 
clip names.

9. Click OK.

Loading and Playing a Clip
To load and play a clip:

1. Click in a panel to select it.

2. If the clip is already loaded, select it from the Clips box and go to step 7.

3. If the clip is not loaded, choose VideoClip | Load Clip to open the Load Clip 
dialog box.

4. If the clip you want to load is on a different drive, select a different disk drive 
in the Drive box.
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5. Select the clip to load—Richter in this example (see Figure 92).

6. Click OK.

7. Click the Play button in the selected Panel dialog box to begin playing the 
clip.

8. The Normal, Loop, and Bounce modes determine how play back occurs: 

- Normal mode plays the selected clip or clip list to the end, freezing on the 
last field of the clip or of the last clip in the list. 

- Loop plays the selected clip or clip list continuously, looping back to the 
beginning of the clip when the clip ends, or in the case of a clip list, 
Profile Family

looping back to the first clip in the list when the last clip ends. 

- Bounce mode plays the selected clip or clip list continuously, until at the 
end of the clip, it plays the clip in reverse, or in the case of a clip list, it 
plays to the end of the clip list, then reverses the sequence, playing all the 
clips in reverse order. 

Figure 92. Load Clip dialog box 
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Renaming a Clip
To rename a clip:

1. Choose VideoClip | Rename Clip. The Rename Video Clip dialog box 
appears.
4 Profile Family

Figure 93. Rename Video Clip dialog box 

2. If the clip you want to rename is in a different list, select it from the Drive 
box.

3. Select a clip from the Rename box. The clip name appears in the To box.

4. Edit the current name or delete the name and enter a new one. Clip names 
can have up to 32 characters. Spaces and uppercase characters are 
acceptable; however, uppercase and lowercase characters will not distiguish 
clip names. 

5. Click OK. 
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Setting Clip Protection
To set clip read-only protection:

1. Choose VideoClip | Set Clip Protection and the Set Clip Protection dialog 
box appears.
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Figure 94. Set Clip Protection dialog box 

2. If the clip you want to protect is in a different list, select it from the Drive 
box.

3. To protect a clip, select a clip in the Play/Record box and then click 
Protected. The clip is now protected as read-only.

4. To unprotect or unlock a clip, select a clip in the Read Only box and then 
click Unprotected. The clip is no longer protected.

5. Click OK.
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Striping a Clip
Striping timecode with VdrPanel allows you to complete a striping process 
faster than real time. For example, on a traditional VTR, it might take you an 
hour to stripe a one-hour clip. But with VdrPanel, you can stripe a one-hour clip 
in a matter of minutes.

To stripe timecode on a previously recorded clip:

1. Choose VideoClip | Stripe Clip and the Stripe Timecode dialog box appears.
6 Profile Family

Figure 95. Stripe Timecode dialog box 

2. Enter the timecode you want to start the clip with, in the form 00:00:00:00.

3. Enter up to eight digits to mark the clip with user bits.

4. Click OK when complete.

Setting Long or Short Clip Names
Long clip names display the full path name of the clip, for example, 
INT1:\default\clipname. Short clip names display only the clip name. Clip 
names are shown in Clip Name box in a Panel.

To set the clip name to be short or long:

• Choose Options | Display Short Name or Options | Display Long Name.

NOTE: This setting only applies to the current panel. Each panel can 
have a different setting for clip name length.
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Ejecting All Clips
To eject all clips:

1. Choose VideoClip | Eject All Clips.

2. All clips in the Clips box in the Panel are ejected immediately.

Deleting a Clip
To delete a clip:

1. Choose VideoClip | Delete Clip to open the Delete Clip dialog box.
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Figure 96. Delete Clip dialog box 

2. If the clip you want to delete is on a different drive, select it in the Drive box.

3. Select the clip or clips you want to delete.

4. Click OK when complete. A message box appears telling you which file is 
being deleted.
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Clip Lists
You can save and organize clips into lists (also called groups). You can load a 
saved group of clips. You can also save an existing group of clips under a 
different name. You can also create and later edit a list of clips.

Saving a Group of Clips in a Clip List
A clip list can be saved and loaded later. To save a clip list as a group:

1. Click within the specific Panel dialog box to select the panel where the clip 
list is currently displayed.
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2. Choose File | Save Group of Clips and the current list of clips, as shown in 
the Clips box, is saved in the current group (.grp). If the clips have not been 
saved in a group previously, the Save Group of Clips dialog box appears.

Figure 97. Save Group of Clips dialog box 

3. If you have not already saved the group, choose File | Save Group of Clips 
As.
The Save As command enables you assign a different name to an already 
named group of clips, preserving the contents of the original group. The 
saved group can be loaded at any time with VideoClip | Load Group.
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Playing a Clip List
To play a list of clips:

1. Click within the specific Panel dialog box to select the panel.

2. Choose VideoClip | Load Group if the clip list you want to play is not 
currently 
loaded.
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Figure 98. Load Group of Clips dialog box 

3. Select the group and click OK. In this example, the group is Seismic.grp.

4. Click on the first clip in the clip list.

5. Click Play to start playing the clip list.

Editing a Clip List
To edit a clip list (group of clips):

1. Click a panel to select it.

2. Choose Video Clip | Load Group if the clip list to be edited was previously 
saved as a group. Select the group and click OK.

3. Choose VideoClip | Edit Clip List to open the Edit Clip List dialog box.



Chapter 4 Using VdrPanel

20
0 Profile Family

Figure 99. Edit Clip List dialog box 

4. To add a clip to the current list loaded in step 1, select a clip in the Clips box 
and then click Add. It is added to the Clip List box (with a long clip name).

5. To remove a clip from the current list, select a clip from the Clip List box, 
and click Remove to remove the clip from the list. This does not delete the 
clip from disk—it simply removes a reference from the clip list.

6. To edit a different group, click Add Group to bring up the Load Group of 
Clips dialog box.

7. Click OK when complete.

Setting In and Out Marks in Clips
You can set a temporary beginning and ending to a clip by marking an in point, 
an out point or both. The video and audio data is not lost, however: it simply is 
not used when the clip is played. For example, if you set a mark-in point five 
seconds into a clip, it plays at the five second mark instead of at the beginning, 
but if you remove a mark-in, it returns the beginning of the clip to the actual 
clip start.

NOTE: Setting in and out marks applies to Panel Control only. It is 
not recommended for other protocols.



Setting Marks

201

Setting Marks
To set a new in mark and out mark in a clip:

1. Click a panel to select it.

2. Create a clip, load a clip, or load a clip list and then select a clip from the list. 
The Clip Position Bar is all the way to the left and the Timecode is 
00:00:00:00.

3. Use the transport controls, drag the Clip Position Bar, or click on the 
Timecode display to enter a timecode to locate the frame where you want to 
set the in mark.
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4. Click Set In Mark. The Timecode display remains the same, but the Clip 
Position Bar jumps to the far left, indicating the mark-in point on the clip.

5. Use the transport controls, drag the Clip Position Bar, or click on the 
Timecode display to enter a timecode to locate the frame where you want to 
set the out mark.

6. Click Set Out Mark. The Timecode display remains the same, but the Clip 
Position Bar jumps to the far right, indicating the mark-out point of the clip.

7. Drag the Clip Position Bar to the beginning of the clip.

8. Click Play. The clip starts at the in mark and stops at the out mark.

Removing Marks
To remove in and out marks from a clip: 

1. Select a clip containing marks in the Clip Name box. 

2. Click the Remove In Mark button to remove a mark-in point and reset the 
clip beginning to the actual start of the clip. 

3. Click the Remove Out Mark button to remove the mark-out point and reset 
the clip ending to the actual end of the clip. 

Trimming Clips 
You can trim a clip from the beginning of the clip to the in mark or from the out 
mark to the end of the clip. This action affects all copies of the clip on all panels. 
The trimmed material is not retrievable. A warning message and verification 
prompt are displayed before the function completes.
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To trim a clip:

1. Select a clip with either in or out marks or both in the Clip Name box. 

2. Click the Trim to Mark button to remove the portion of the current clip 
preceding the in mark. 

3. Click the Trim from Out Mark button to remove the portion of the current 
clip following the out mark. 

Setting Field Dominance for Marks
You can set field dominance so that a clip’s mark-in and mark-out points occur 
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at field 1 or field 2 of a given frame. By default, the field dominance is set so 
that either field 1 or field 2 can be a mark-in or mark-out point. To change field 
dominance:

1. Choose Options | Field Dominance. The Field Dominance dialog box 
appears (Figure 100). 

Figure 100. Field Dominance dialog box

2. Click Field 1 or Field 2.

3. Click OK. The change takes effect immediately.

NOTE: Field dominance applies to JPEG clips only and the latest 
field dominance setting applies to all open panels.
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Using the Profile Disk Utility

The Profile Disk Utility allows you to create new file systems on a Profile disk 
set (volume), format disks, set a new disk label, load the latest microcode from 

anufacturer, or browse through the SCSI log. A Profile volume may 
the internal disks in a PDR100, PDR200 or PDR300, or it may be the 
isks in a PDX103/208 Disk Expansion Unit, or a PRS200/250 RAID 
the disk m
consist of 
external d
03

Storage System.
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NOTE: You must login as administrator to use this utility. 

After starting the application, the Profile Disk Utility window appears. Most of 
the disk utility functions can be performed from this dialog box, as shown in 
Figure 101.

Figure 101. Profile Disk Utility window 
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NOTE: If you use the PDX103 Disk Expansion Unit with a PDR200 or 
PDR300, the 9 gigabyte hard drives in the video disk recorder are limited 
to the storage size of the 4 gigabyte hard drives in the PDX103.

Creating a File System
A file system is created for all media disks before a Profile disk recorder is 
shipped from the factory. You can set up a file system any time you need to 
build or rebuild your system.

NOTE: If you are upgrading a PDR100 to version 2.1 or later of system 
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software from version 1.4.XX or earlier, you must rebuild your file system.

Information on the disks is shown in the upper-left panel of the Profile Disk 
Utility window—information such as physical volumes, data sets, number of 
disks, and disk size. Additional information is shown in the lower pane: SCSI 
IDs of each disk, serial numbers, vendor names, number of blocks, block sizes, 
model numbers, revision numbers, bad blocks, medium errors, read errors, and 
write errors.

A volume consists of a set of physical disks, such as an array of eight internal 
disks in a Profile disk recorder or in a PDX 208 Disk Expansion Chassis. A data 
set is a group of disks that can consist of one or more volumes. The data set 
name is the name that appears in VdrPanel. Media is striped across all disks in 
the data set.

To create a file system:

1. Select a data set from the Current Data Set box. For example, Data Set 1 - 
int.

2. Select the volumes to be included in the data set from the Available 
Volumes list and click Add. To remove volumes from the data set, select 
volumes from the Selected Volumes list and click Remove.

3. Choose File | Make Data Set or click Make Data Set.
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Setting a Disk Label
To set a disk label:

1. Choose File | Set Label or click Set Label. The Set Label dialog box 
appears.
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Figure 102. Set Label dialog box

2. Enter the new label name in the New Label box. The label name can have up 
to seven characters and can contain only alphanumeric characters (0–9, a–z, 
or A–Z), dashes (-), or underlines (_).

3. Click Set when complete.
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Formatting a Disk Volume
Formatting disks organizes them so the Profile system can write data to and 
read data from them in an orderly way. All media disks come preformatted from 
the factory.

>>> CAUTION: Formatting disks removes all media and other data from the 
disks. Format disks only when absolutely necessary.

To format a disk:
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1. Select the desired physical volume with the tab in the lower pane. 

2. Select the desired disks.

3. Choose Disk Utilities | Format Disk(s) or click Format. The Format Disk(s) 
dialog box appears. If disks are non-Seagate, you can select a block size. The 
estimated time remaining to format the disk or disks is displayed. 

4. Click Format on the dialog box to continue formatting the disks.

Figure 103. Format Disk(s) dialog box
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Loading Microcode
To load microcode for your hard disks:

1. In the lower pane, select the drive or drives where you want to load 
microcode.

2. Choose Disk Utilities | Load Microcode or click the Load Microcode 
button to open this dialog box.
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Figure 104. Microcode Filename to Load dialog box 

3. Double-click on a filename or enter the name of the microcode (.lod) file in 
the Filename box and click Open to load the microcode (see Table 11). 

NOTE: Before loading microcode, check what make of drive you have in 
the Vendor field of the lower pane in the Disk Utility window. 

Table 11. Microcode update files

File Name Disk Type

cu4w6001.lod Seagate 4-gigabyte disk drives

cu9w6004.lod Seagate 9-gigabyte drives

c9lp5724.lod Seagate low profile 9-gigabyte drives

ibm9G_51.lod IBM 9-gigabyte drives
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Relocating and Testing Bad Blocks
The reason why bad block errors are reported is usually not because the 
physical block (cluster) is damaged. Often the reason is because when the 
system attempts to read a media file and for any reason it cannot read a block, 
it does not retry but simply repeats the last field and moves on to the next block.

NOTE: The following tests are nondestructive.

Testing bad blocks determines whether a bad block error is really a physical 
problem with the disk or just a nonrepeatable read error that can be ignored. If 
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the error is nonrepeatable, the block may be removed from the bad blocks list. 
Otherwise, the block will be reallocated.

To test bad blocks:

• Choose Disk Utilities | Test Bad Blocks or click Test Bad Blocks.

To relocate bad blocks:

• Choose Disk Utilities | Relocate Bad Blocks or click Relocate Bad 
Blocks.

NOTE: You must read the detail log (SCSI log) to view the results of these 
tests. See “The Detail Log” on 209.
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The Detail Log
The detail log (scsi.log) records the history of everything that happens on a disk 
and helps you track problems with disks. For example, when you relocate or 
test bad blocks, you must read the detail log to see the results.

To open and read the detail log:

1. Choose Disk Utilities | Detail Log or click Detail Log. The Detail Log 
dialog box appears.

2. Click Close when done checking the log information.
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Figure 105. Detail Log dialog box

NOTE: Scsi.log is a binary file; you cannot view it with WinTail. See 
“Viewing Profile Logs” on 211 for information about viewing other 
Profile logs.
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Chapter 6
Using Profile Utilities

This chapter shows you how to read Profile logs with WinTail, capture Profile 
logs with the capture tool, assign Profile Protocol resources for RS-422 ports 

 by Profile Protocol and managed by ProLink, access a Profile system 
ote PC with PortServer, and how to manually stop and start the PDR 
ntrol service.
controlled
from a rem
Access Co
11
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Viewing Profile Logs
You can view Profile system logs with the graphical log viewer WinTail. This 
log viewer allows you to see the end of a log file. To view any of the Profile 
system log files:

1. Double-click on the Profile Log shortcut icon on the Windows NT desktop 
or choose Start | PDR Applications | Profile Log. By default, the WinTail 
application views profile.log. WinTail automatically checks log files for 
updates every two seconds.
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Figure 106. WinTail window

2. To view other logs, choose File | Open.

NOTE: Because it is a binary file, you cannot view scsi.log with 
WinTail. See “The Detail Log” on page 209 for instructions on 
how to view scsi.log.

You can view three sets of logs:

1. The PDR Access Control service records messages from the real-time 
processor into profile.log. As installed, the WinTail application reads this log 
file by default.

2. VdrPanel logs all RS-422 protocol messages for supported third-party 
protocols. Logging occurs to files VdrPanel[ABCD].000 and 
VdrPanel[ABCD].001 in the directory where VdrPanel is run. Logging has 
a timing resolution of 10 msec. Use a dedicated RS-422 logger for better 
resolution and accuracy.
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Logging for each panel may be turned off by setting the value MsgLogger to 0 
in these registry keys with the Windows NT registry editor regedit:

HKEY_LOCAL_MACHINE
/SYSTEM

/CurrentControlSet
/Services
/VtrService

/Chan[ABCD]

NOTE: Logger does not log duplicate replies for BVW, BVW [insert 
edit] and Odetics for 61.0c CurrentTimeSense for Timer1, LTC, and 
VITC, and 61.0c StatusSense, nor for Louth for 30.05 
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PortStatusRequest and 30.10 SystemStatusRequest. 

3. VdrPort logs record all messages passed between Windows NT and the real 
time processor. The following information is logged:

- Direction:

> indicates NT-to-video-processor
< indicates video-processor-to-NT

- VDR port number (0–3)

- Tick count (msec since Windows NT booted) 

- Message

The start of the VdrPort log file contains the date and time (year/month/day 
hours:min:sec.msec), and the equivalent tick count. Events are logged to two 
files: VdrPortLog.000 and VdrPortLog.001.
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Log Capture Tool
The Profile Log Capture Tool is used to capture Profile logs and package them 
in .zip format to be sent to Grass Valley Group. To start the Log Capture tool, 
double-click the Log Tool icon on the Windows NT desktop, choose Start | Run 
and enter C:\profile\logstool.exe in the text entry field, or enter start logstool on 
a command line.

When you start the log capture tool, it compresses the current set of Profile logs 
and launches the log set selection screen (Figure 107). You can choose the 
current set of logs or one of the last four log sets captured.
4

Clicking the Cancel button cleans up any temporary files and exits the program. 
If you click Cancel while copying and compressing when the program is first 
started, the Current Logs selection will not be available.

Figure 107. Log set selection screen
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After choosing a log set, click the Next button to advance to the size selection 
screen (Figure 108). Choose one of these three sizes:

• 1.4 MB file size — Select this file size if you are using floppy diskettes to 
send the information to Grass Valley Group. 

• Single file

• Custom file size — enter a number in the field to specify the number of 
100,000-byte blocks (minimum 2). 

The single file and custom file size selections allow you to choose the file size 
that is most convenient for you to ftp or e-mail to Grass Valley Group.
Profile Family

Figure 108. Size selection screen

Clicking the Back button returns to the log set selection screen if you want to 
change your log set selection.
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The Next button completes the log capture and file sizing process, and advances 
you to the Log Tool Complete screen.

The Log Tool Complete screen displays the location of the ZIP files that were 
created from the log set that you selected. Carefully note the location of the files 
created, then click OK to exit the program.

NOTE: Clicking OK does not send any files to Grass Valley Group, it 
merely ends the program. To send the files, you must copy them to 
floppy disk, or transmit them using ftp or e-mail.
6

Figure 109. Log tool complete screen
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Profile Protocol Resources
The Profile Protocol Resources utility lets you assign Profile resources such as 
inputs, outputs, and codecs, for use with ports controlled by Profile Protocol 
over an RS-422 connection and managed by ProLink. The PRC100 is one 
example of a device which uses these ports.

Profile Protocol implements Named Configuration Space (NCS) as a 
mechanism to ease Profile configuration. Using NCS, an application can send 
one command, Open Port (10.01), with a parameter specifying a configuration 
file to use, and the Profile unit handles all the resource allocation and 
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crosspoints specified in the configuration file. This frees the application from 
the task of allocating resources manually.

The Profile Protocol Resources utility provides a simple, graphical way of 
creating configuration files. It replaces previous Profile Protocol configuration 
tools such as the PRC100 Configuration Utility (prccfg.exe), and configures all 
Profile resources, including MPEG encoders and decoders.

The following sections explain how to use the Profile Protocol Resources 
utility. You’ll also find an explanation of the contents of a configuration file, 
and some sample files that you may find helpful if you need to modify files 
manually.

Using the Profile Protocol Resources Utility
When you start the Profile Protocol Resources utility by double-clicking its icon, 
a large dialog box similar to the one shown in Figure 110 appears.

The available Profile resources are displayed in the dialog box. Note that these 
resources will vary according to the features of each Profile system. For example, 
while JPEG codecs are available on all Profile systems, MPEG encoders appear as 
resources only on Profile models that are so equipped.



Chapter 6 Using Profile Utilities

21
8

Figure 110. The main Profile Protocol Resources dialog box
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The Add Video, Add Audio, and Add Timecode buttons add the resources you 
select to the configuration file under construction. Each time you click the “Add” 
button for a set of resources, the resources are tagged as “Used” except for shared 
resources, such as a Video Input, which you can use several times.

The Clear button removes the “Used” tags from resources that have been added 
but not yet saved; the Clear All button clears all “Used” tags in the dialog box, 
including those for resources that have been saved. The Create File button allows 
you to save the temporarily stored information in the permanent configuration file.

Resources being used by other applications (such as VdrPanel) are tagged as “In 
Use.” If you wish to add “In Use” resources to the configuration file, exit Profile 
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Protocol Resources, free the resources in the other Profile applications, then restart 
Profile Protocol Resources.

To create a configuration file:

1. Select the video input, codec or encoder, and video output you wish to add 
to the configuration file and click the Add Video button. If you wish to 
assign more than one video codec or encoder to a channel, repeat the process.

If you select a JPEG codec, a dialog box appears similar to the one shown in 
Figure 111; if you select an MPEG encoder, a dialog box appears similar to 
the one shown in Figure 112. Make appropriate compression settings for 
your recordings and click OK.

Refer to “Using VdrPanel” on page 159 for an explanation of these settings.

Figure 111. Setting JPEG compression
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Figure 112. Setting MPEG compression

2. Select one or more audio inputs. The output that corresponds to each input is 
automatically selected. Click the Add Audio button.

3. Select timecode input, tracks, and output and click Add Timecode. Repeat the 
process for each timecode resource you wish to add.

4. Click the Create File button to save the file. When the Save As dialog box 
appears, enter a file name that your application will use when it opens the port. 
The configuration file should be stored in the default C:\profile\configs 
directory, and must have a .cfg extension. For example, you must create 
vtr1.cfg, vtr2.cfg, etc. files for use with the PRC100.

5. Choose OK to write the configuration file.

You have now completed creating a configuration file for your Profile Protocol 
application. Use this file when you open the desired port from the application, such 
as the PRC100. You should create as many files as you require for your 
application. 
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Manually Editing a Configuration File
In some special cases, you may wish to manually edit a configuration file. For 
example, you may wish to assign more than one video codec for use with a 
channel. 

You can use any text editor to make changes to an existing configuration file. 
Notepad will save your file in the required format. If you decide to use any other 
editor, such as WordPad, be sure to save the file as a text document (ASCII or 
txt) and use the .cfg filename extension if you change the name of the file.

Configuration files are simple text files, containing three types of lines. The 
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lines are parsed on a column basis as follows:

• If column 1 contains anything besides a number from 0-9, the line is ignored 
as a comment line.

• If column 7 contains a “C” or “c”, the line is treated as a crosspoint line.

• All other lines are treated as resource lines.

Both resource allocation lines and crosspoint lines share a similar format:
xx-yy[,][func1][func2]

NOTE: Although resource and crosspoint lines look similar, they 
have very different meanings. This is a frequent source of confusion 
and error. Make sure whether you are editing a resource line or a 
crosspoint line!
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Resource Lines

Resource lines allocate a resource for use by a port. The following is the 
column-by-column layout of resource lines:

• Column 1-2: resource type.

Must be one of the following:

00 audio codec

01 JPEG codec

02 video input
2

• Column 3: separator (-).

• Column 4-5: resource number.

This specifies which resource of the specified type is desired. Resources of 
a given type are numbered starting at 0. To select the third timecode recorder, 
specify “02” in columns 4-5.

For inputs and outputs spread across multiple cards, devices are scanned 
along the Profile EISA bus starting at slot 0. Viewed from the back of the 
Profile system, numbers increment from right to left. In a Profile system with 
two Serial Digital I/O cards, video input 00 represents the upper BNC 
connector on the rightmost Serial Digital card, while video input 03 
represents the second BNC connector on the leftmost Serial Digital card.

03 video output

04 LTC input

05 VITC input

06 timecode generator

07 LTC output

08 VITC output

09 timecode recorder

10 audio output

11 video combiner (mix effect)

12 MPEG decoder

13 MPEG encoder
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In Profile systems with a mix of video I/O cards, the video cards are scanned 
in the following order:

-  Serial Digital Component

-  Serial Digital Component with Embedded Audio

-  Component Analog

-  Composite Analog

-  Serial Digital Composite

For example, in a Profile system with two Serial Digital Component cards 
and one Analog Composite Input card, the Serial Digital inputs will be 
Profile Family

numbered 00 through 03, and the Composite input will be numbered 04, 
regardless of where the Composite card is placed.

• Column 6: optional separator (, or space).

This is mandatory if column 7 is meaningful, optional otherwise. 

• Column 7: optional parameters.

For inputs, this must be an S (for Shareable). In addition, certain resources 
may specify additional parameters, starting in column 7. These parameters 
are read and assigned in the order given below.

- For JPEG codecs:

goalsize (bytes/field), minimum luminance Q, maximum luminance Q, 
minimum chrominance Q, and maximum chrominance Q
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- For MPEG encoders:

bitrate, format, GopEnd, iPerGOP, pPerI, bPerIP, PixStruct, 
FirstEncodedLine, and LastEncodedLine

If you don’t specify parameters, the default values are used. You can 
override the defaults in the .cfg file, or by using the MPEG API calls. 
Acceptable values for these parameters are shown in Table 12.

Table 12. MPEG Encoder Parameters

Parameter Acceptable Values Default
4

bitrate Mb/s, between 4000000 and 50000000 18000000

format Select 4:2:2 or 4:2:0 (do not use the colons in 
the file entry).

422

GopEnd 0=GopOpenEnd
1=GopClosedEnd

1

iPerGOP Reserved. Must be 1. 1

pPerI The number of P pictures per I picture, from 
0 to 5.

5

bPerIP The number of B pictures per IP picture, 
from 0 to 2.

2

PixStruct Reserved. Must be 0. 0

FirstEncoded
Line

May include VBI lines. See release notes. 21 (525/60)
23 (625/50)
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LastEncoded
Line

The number of total encoded lines is the 
difference between the first and last encoded 
lines, and must be a multiple of 16. In 525/60 
total encoded lines is typically 240; in 
625/50, total encoded lines is typically 288. 
The last encoded line must not exceed 263 
(525/60) or 311 (625/50). The first encoded 
line is inclusive, meaning it is actually an 
encoded line, but the last encoded line is 

261 (525/60)
311 (625/50)

Table 12. MPEG Encoder Parameters
Profile Family

- For audio codecs:

input level, output level, window size

If you don’t specify parameters, the default values are used. You can 
override the defaults in the .cfg file, or by using the API calls. Acceptable 
values for these parameters are shown in Table 13

exclusive, meaning that the line specified is 
not actually encoded.

Table 13. Audio Parameters

Parameter Acceptable Values Default

input level From 0.0 (full attenuation) to 1.0 (no 
attenuation)

1.0

output level From 0.0 (full attenuation) to 1.0 (no 
attenuation)

1.0

window size Number of audio fields to play during video 
still frame operations.

1
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- For timecode generators:

timecode format, timecode mode, time to seed, user bits to seed

If you don’t specify parameters, the default values are used. You can 
override the defaults in the .cfg file, or by using the API calls. Acceptable 
values for these parameters are shown in Table 14

Table 14. Timecode Parameters

Parameter Acceptable Values Default

timecode 0 = Drop-frame 1
6

Each resource allocation line is assigned an index number in sequential order 
independent of comment lines or crosspoint lines. Thus, the first resource line 
found in an NCS file is assigned index number 1, the second is assigned index 
number 2, etc. These index numbers may be used by the crosspoint lines, which 
are described in the following section.

format 1 = Non-drop frame

timecode 
mode

0 = TcModeFreeze
1 = TcModeFreeRun
2 = TcModeFieldLocked
3 = TcModeRegenHold
4 = TcModeRegenFlywheel

2

time to seed frame, second, minute, hour

user bits to 
seed

32 bits, in reverse byte order
(last, third, second, first)
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Crosspoint lines

Crosspoint lines assign default and scheduled crosspoints between resources. A 
basic explanation of these events is included below.

The following is the column-by-column layout of crosspoint lines:

• Column 1-2: source index number.

• Column 3: separator (-).

• Column 4-5: destination index number.

• Column 6: separator (,).
Profile Family

• Column 7: crosspoint indicator (“C” or “c”).

• Column 8: ‘D’ or ‘S’ for default or schedule crosspoints.

Scheduled crosspoint connections take precedence during playback, default 
crosspoints take effect at all other times (or in the absence of scheduled 
crosspoints). Typically, scheduled and default crosspoints are used in sets of 
three to define playback and E-to-E modes, as follows:

- Default connection of an input to an output (E-E).

- Default connection of an input to a codec (for recording).

- Scheduled connection of the codec to the output (to override E-E during 
PB).

A configuration file should only have crosspoint lines for video and timecode.

The sample configuration files that follow provide examples of resource and 
crosspoint lines.
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Sample Configuration Files
The following sample configuration files demonstrate how to create a basic file, 
and how to add features which the Profile Protocol Resources utility does not 
support, such as assigning two codecs for one channel. You’ll find these and 
other sample configuration files in the c:\profile\configs directory.

Basic Configuration

This example shows how to create a basic configuration file. 
// format is 2 digit base 10 numbers
8

// format XX[-]YY[,][func1[func2]] starting col 1

// format if col1 is not between 0 & 9 , its a comment

// format [optional parameters with white-space separators] 
start in col 6

02-00,S // index 1 - video input 0 shared

03-00 // index 2 - video output 0

01-00 100000 // index 3 - JPEG codec 0 at 100KB

01-02,CD // Default connect video input->video output)

01-03,CD // Default connect video input->video codec

03-02,CS // Schedule connect video codec->video output

// now do the audio connections 1-4

00-00 // index 4 - audio codecs

00-01 // index 5 - audio codecs

00-02 // index 6 - audio codecs

00-03 // index 7 - audio codecs

10-00 // index 8 - audio outputs 1-4

10-01 // index 9

10-02 // index 10

10-03 // index 11
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//  now do the LTC to recorder 1

04-00,S // index 12 - LTC input

07-00 // index 13 - LTC output

09-00 // index 14 - tcRecorder

12-13,CD

12-14,CD

14-13,CS
Profile Family

Assigning a Second JPEG Codec

This example is the same as the basic configuration, but it adds another JPEG 
codec, connected to the same video input. This sample file is supplied as 
2JpegSample.cfg in the c:\Profile\configs directory on the Profile system drive.
// format is 2 digit base 10 numbers

// format XX[-]YY[,][func1[func2]] starting col 1

// format if col1 is not between 0 & 9 , its a comment

// format [optional parameters with white-space separators] 
start in col 6

// format the rest is available

02-00,S         // index 1 - video input 0 shared

03-00           // index 2 - video output 0

01-00 100000    // index 3 - JPEG codec 0 at 100KB

01-02,CD // Default connect index1->index2 

// (vid in->vid out)

01-03,CD        // Default connect video input->video codec

03-02,CS        // Schedule connect video codec->video output
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// now do the audio connections 1-4

00-00           // index 4 - audio codecs

00-01           // index 5 - audio codecs

00-02           // index 6 - audio codecs

00-03           // index 7 - audio codecs

10-00           // index 8 - audio outputs 1- 4

10-01           // index 9

10-02           // index 10

10-03           // index 11
0

//  now do the LTC to recorder 1

04-00,S // index 12 - LTC input

07-00 // index 13 - LTC output

09-00 // index 14 - tcRecorder

12-13,CD

12-14,CD

14-13,CS

// manually add these lines to add a second Jpeg Codec.

02-00,S         // index 15 - video input 0 shared

03-01           // index 16 - video output 1

01-01 100000    // index 17 - video codec 1 at 100KB

15-16,CD        // Default connect index15->index16 (vid in-
>vid out)

15-17,CD        // Default connect video input->video codec

17-16,CS        // Schedule connect video codec->video output
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Assigning an MPEG encoder

This example assigns an MPEG encoder, rather than a JPEG codec. It also 
illustrates how to assign both LTC and VITC timecode resources for a channel. 
The sample file is supplied as mpegEnc.cfg in the c:\Profile\configs directory 
on the Profile system drive.
// Sample Config File for an MPEG Encoder.

//

// first do the video system

// format is 2 digit base 10 numbers
Profile Family

// format XX[-]YY[,][func1[func2]] starting col 1

// format if col1 is not between 0 & 9 , it is a comment

// format [optional parameters with white-space separators] 
start in col 6

//

// MPEG Encoder format:

// 12-YY bitrate format GopEnd iPerGOP pPerI bPerIP PixStruct 
FirstEncodedLine LastEncodedLine (YY is the # of the Encoder 
resource)

// 

// bitrate:  between 4000000.0 and 50000000.0, Default 
18000000

// format:  422 or 420, Default 422

// GopEnd:  0=GopOpenEnd, 1=GopClosedEnd, Default 1

// iPerGOP:  reserved.  Must be 1

// pPerI: The number of p Pix per I Pix, Default 5, Range 
1-10

// bPerIP:  The number of b Pix per IP Pix, Default 2, Range 1-2

// PixStruct:  0=PixStructFrame, 1=PixStructureField, Must 
be 0

// Max LastEncodedLine(exclusive) : 263 - NTSC, 

//          313 - PAL.



Chapter 6 Using Profile Utilities

23

// FirstEncodedLine(inclusive) = LastEncodedLine - Number of 
lines per field

// Number of lines per field  240 - NTSC 4:2:0

//     256 - NTSC 4:2:2

// 288 - PAL  4:2:0

// 304 - PAL  4:2:2  

// Also FirstEncodedLine - LastEncodedLine should be divis-
ible by 16.

//
2

// for example (NTSC 4:2:0) //12-00 18000000.0 420 1 1 5 2 
0 21 261 

// for example (NTSC 4:2:2) //12-00 18000000.0 422 1 1 5 2 
0 5 261 

// for example (PAL 4:2:0)  //12-00 18000000.0 420 1 1 5 2 
0 23 311 

// for example (PAL 4:2:2)  //12-00 18000000.0 422 1 1 5 2 
0 7 311

// Video Resources

02-00,S         // index 1 - DComponentVideo1InA

03-00           // index 2 - DComponentVideo1OutA

// Next line is for an MPEG Encoder

12-00 18000000 422 1 1 5 2 0 6 262          // index 3 - MpegEnc#1

01-02,CD        // Default connect DComponentVideo1InA to 
DComponentVideo1OutA (E to E) index1 to index2

01-03,CD        // Default connect DComponentVideo1InA to 
MpegEnc#1 (Record) index1 to index3
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// Audio Resources

00-00           // index 4 - Audio Chan #1 (Input)

00-01           // index 5 - Audio Chan #2 (Input)

00-02           // index 6 - Audio Chan #3 (Input)

00-03           // index 7 - Audio Chan #4 (Input)

10-00           // index 8 - Audio Chan #1 (Output)

10-01           // index 9 - Audio Chan #2 (Output)

10-02           // index 10 - Audio Chan #3 (Output)

10-03           // index 11 - Audio Chan #4 (Output)
Profile Family

//  Timecode Resources

04-00,S // index 12 - LTCIn1

07-00 // index 13 - LTCOut1

05-00,S // index 14 - DComponentVITC1InA

08-00 // index 15 - DComponentVITC1OutA

09-00 // index 16 - TCRec#1

09-01 // index 17 - TCRec#2

12-13,CD // Default connect LTCIn1 to LTCOut1

12-16,CD // Default connect LTCIn1 to TCRec#1

16-13,CS // Scheduled connect TCRec#1 to LTCOut1

14-15,CD // Default connect DComponentVITC1InA to 
DComponentVITC1OutA

14-17,CD // Default connect DComponentVITC1InA to TCRec#2

17-15,CS // Scheduled connect TCRec#2 to 
DComponentVITC1OutA
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Assigning an MPEG Decoder

The previous example assigns an MPEG encoder to a video input. By manually 
adding the following lines, you can assign an MPEG decoder and connect it to 
a video output.

// Manually edit these lines for Decoder
13-00           // index 18 - MpegDec#1 (Use 13-01 for 
MpegDec#2, etc.)

18-02,CS        // Schedule connect MpegDec#1 to 
DComponentVideo1OutA (Play)
4

PortServer
PortSever allows you to control a Profile unit remotely using Ethernet 
communications. For example, you can run PortServer on a remote Profile 
system so that you can access it from a local Profile using your LAN. Simply 
double-click the PortServer shortcut icon on the desktop to start it (or choose 
Start | PDR Applications | PortServer). The PortServer interface is shown in 
Figure 113.

Figure 113. PortServer window 
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PDR Access Control
PDR Access Control is a Windows NT service that prevents one application 
from crashing another user’s application by mistake. Though largely 
transparent to users, the service prevents applications from accidentally 
reloading the video processor while in use, essentially providing a controlled 
gateway to the processor. Applications attempting to load different video 
processor code than what is currently running are denied access and terminated; 
however, applications attempting to load the same code are given access to 
proceed.
Profile Family

The c:\profile\profile.log file tracks all messages from the video processor. The 
state of the video processor is periodically checked. If the processor does not 
respond, an administrator alert is generated. The event is logged to the Windows 
NT Event log. The Event log can be viewed with the Event Viewer application.

PDR Access Control is automatically installed and started as part of the 
installation process and is restarted every time the system is rebooted. This 
procedure is provided in the unlikely event that you need to start the service 
manually.

1. Log in as administrator.

2. Double-click My Computer on the desktop.

3. Double-click the Control Panel icon.

4. Double-click the Services icon. The Services dialog box appears (Figure 
114).
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Figure 114. Services dialog box 

5. Select PDR Access Control from the list of services. You may have to scroll 
the list box.

6. Click Start to start the service. By default, the service is automatically 
restarted whenever the system is rebooted. It is unlikely that you will ever 
need to start the service manually.

7. Click on Stop to stop the service, if desired.

8. Click Close to close the Services dialog box.

>>> CAUTION: If the start-up option is changed from Automatic, the Profile 
applications are not able to run unless the service is started manually each 
time the system is rebooted.
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Updating Firmware
From time to time, it becomes necessary to reprogram components on boards 
in your Profile disk recorder or video file server. For example, when you install 
MPEG boards in a PDR200, you must upgrade components on the Master 
Enhanced Disk Recorder (EDR) board. Updating the firmware in the selected 
components of these boards ensures that software and hardware will function 
together as expected. 

To successfully update the EDR board, it must be Revision 2 or higher. You can 
determine the revision level of the boards by consulting the Profile log. For 
Profile Family

information on reading logs, see “Viewing Profile Logs” on page 211. 

NOTE: This procedure applies if: 1) You are field-installing MPEG 
boards in a system that is not MPEG-ready; or 2) You are field-
installing an EDR board. Systems with these boards installed in the 
factory (serial number B030000 and higher) are already updated. 

The reprogramming is based on references in the file c:\profile\edr_isp.all. Do 
not alter this file in any way as it may lead to incorrect programming of parts. 

To update firmware: 

1. Close any applications that may be running on the system. 

2. At a command line, type vdrsvc -stop and then press Enter. This stops the 
PDR Access Service. 

3. Choose Start | Programs | PDR Debug Tools | Update EDR Firmware or double-
click the Update EDR Firmware icon. A window appears. 

4. The program warns you to shutdown any applications that may be running 
and to stop the PDR Access Service. If you have already done so, as 
instructed in steps 1 and 2, type Y. Otherwise, type N, and return to step 1.
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Figure 115. Update Firmware window 

5. The update procedure steps through the reprogramming of the components, 
giving progress information as it proceeds. It retries up to three times to 
reprogram parts in the event of verification errors. After reprogramming all 
parts, a summary is provided that describes what has been done. 

6. If parts have failed to program, power down the Profile unit completely, 
power it up again, and then run the program again; otherwise, just restart the 
Profile. 

7. After the program runs successfully, restart your disk recorder so the 
changes can take effect. 
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Updating Fibre Channel Microcode 
From time to time, it becomes necessary to reprogram microcode on your Fibre 
Channel board. Updating the microcode ensures that software and hardware 
will properly function together. 

This release provides two versions of Fibre Channel board microcode. You 
must choose which one to use depending on your environment. The two 
versions are:

Loop compatible. This version is loaded on your Fibre Channel board at the 
factory. Use this microcode with Fibre Channel hubs, when your Video 
Profile Family

Network includes only Profile Systems and SGI Fibre Channel Servers. You 
can reload this microcode with the FC Loop-mode Microcode icon in the 
Profile Debug Tools folder.

Switch compatible. Use the FC Switch-mode Microcode to load this version 
of microcode onto your Fibre Channel board if you are connecting your Profile 
system to a Fibre Channel Switch. In addition, you must set switch mode on 
with the fcconfig -s on command, or with the appropriate check box in 
Configuration Managers Configure Fibre Channel dialog box. You should also 
use the switch compatible version of microcode if you are connecting your 
Profile system to Fibre Channel devices from other manufacturers. Please note 
that this inter-operable microcode has not yet been optimized for loop 
operations.

Follow these instructions to use either of these icons to load Fibre Channel 
microcode.

1. Close any applications that may be running on the system. 

2. At a command line, type vdrsvc -start and then press Enter. This starts the 
PDR Access Service if it is not already started. 

3. Choose Start | Programs | PDR Debug Tools | Update FC Microcode. A window 
appears. 

4. The program asks if you want to continue. Type Y. 

5. The program now reads the new image of the microcode from 
c:\profile\etc\gfcucode.img. The program automatically copies the old 
microcode to the file c:\profile\etc\gfcucode.old. 
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6. Restart the disk recorder in order for the microcode update to take effect. Use 
the Fibre Channel Configuration dialog box or the fcconfig command to 
verify that switch mode is on or off according to your needs. Each icon 
establishes settings that should be appropriate for most uses. 

Use the Fibre Channel Configuration dialog box or the fcconfig command to 
verify that switch mode is on or off according to your needs. Each icon 
establishes settings that should be appropriate for most uses. 
0

Figure 116. The Update FC Microcode window 



Chapter 7
Fibre Channel Video Networking

With Fibre Channel, you can copy and move media between a network of 
Profile systems at faster than real time. To transfer data across Fibre Channel, 

 system needs both the Ethernet and Fibre Channel networks to 
ate. The Ethernet local area network (LAN) carries commands 
rofile disk recorders and the Fibre Channel connections send raw 
the Profile
communic
between P
41

video data. Both networks use TCP/IP (Transfer Control Protocol/Internet 
Protocol). Because of this communication scheme, you must set up separate IP 
Profile Family 2

addresses for each network. In the example that follows, you will connect two 
Profile units together, configure them and run Fibre Channel transfers between 
them.

NOTE: To communicate across the network, all Fibre Channel 
machines should have Profile system software version 2.4 installed.

You must first configure your network, whether your Profile unit came from the 
factory with a Fibre Channel card installed or whether you have installed Fibre 
Channel as a field installation kit. Configuring your system for the Fibre 
Channel also requires that you first configure your Ethernet LAN. See the 
PDR200 Installation Manual or the Profile Family Local Area Network 
Installation Manual for more information.

NOTE: Even an isolated Profile unit with a Fibre Channel card that 
is not connected to a network must be given an IP address. Follow the 
instructions for entering an IP address under “Fibre Channel IP 
Address Set Up” on page 244. 
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Setting Up Hardware for Fibre Channel 
First, you set up the Ethernet LAN. The LAN card uses a twisted pair network 
scheme and so must be connected via a standard 10BaseT Ethernet hub. You 
cannot plug one LAN card directly into another. You can put Profile disk 
recorders onto your site’s computer network if you want, just as long as you are 
aware that it uses TCP/IP. 

Next, you set up the Fibre Channel network. Unlike the Ethernet LAN, the 
Fibre Channel network will permit two machines to be plugged directly into 
each other. More than two machines, however, require a Fibre Channel hub or 
2 Profile Family

a Fibre Channel switch. 

NOTE: The cable which connects individual machines to the Fibre 
Channel hub is the same cable that connects two machines together. 
This cable comes with the Fibre Channel card. However, Profile 
Fibre Channel cables sold for use with Fibre Channel hubs do not 
have the required connectors for use with the Fibre Channel switch. 
You must obtain cables appropriate for use with the switch.

 The pinout for a 9-pin D type connector to 9-pin D type connector is as follows: 

• Pin 1 to 5 and pin 5 to 1

• Pin 6 to 9 and pin 9 to 6
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Setting Up Software for Fibre Channel 
A common mistake is to set the IP address of the Fibre Channel board to the 
same IP address as the Ethernet network. This is wrong; they must be separate 
networks. 

Each Profile unit has a computer name, often the serial number of the unit. But 
some people like to change it to something more meaningful, such as PROFILE1 
or PROFILE2. For Fibre Channel, you must set up two IP addresses for each 
Profile, one for the Ethernet card and the other for the Fibre Channel board. 
Here are some made-up IP addresses for two Profiles units: 
Profile Family

Computer Name: PROFILE1
Ethernet Address: 192.168.99.1
FC Address: 192.168.100.1

Computer Name: PROFILE2
Ethernet Address: 192.168.99.2
FC Address: 192.168.100.2

You can use the these addresses if you want, but if your Ethernet boards are 
connected to your company computer network, check with your system 
administrator for the correct IP addresses to use. 

Ethernet IP Address Set Up
To set the TCP/IP address for the Ethernet network:

1. Login as administrator

2. Choose Start | Settings | Control Panel or double-click the My Computer icon 
on the Windows NT 4.0 desktop, then click Control Panel.

3. Double-click the Network icon.

4. Click TCP/IP, then Properties.

5. Click Specify IP Address. For PROFILE1 set the address, for example, to 
192.168.99.1

6. Click OK. 
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Fibre Channel IP Address Set Up 
You can set up your Fibre Channel network in one of two ways:

• Through the Fibre Channel dialog box in the Configuration Manager 
graphical user interface. For instructions on how to do this, refer to “Setting 
Up Fibre Channel Networking” on page 102. 

• With the fcconfig command. 

To set up Fibre Channel with fcconfig:

1. Open a MS-DOS command window and type fcconfig followed by Enter. 
4 Profile Family

The following information is displayed: 
Fibre Channel Network Configuration:
FC IP Address . . . . . . . . . . : not set
Hardware Address  . . . . . . . . : 0
TCP/UDP checksums . . . . . . . . : Enabled
Multicast . . . . . . . . . . . . : Disabled
Auto host table administration  . : Enabled
F/C Switch  . . . . . . . . . . . : Disabled

You need to set the IP address, the IP subnet mask, the hardware address and 
turn off TCP checksums and auto host table administration. By turning off 
TCP checksums, you maximize bandwidth, but you will not be able to detect 
data corruption. You turn auto host table administration table if you do not 
intend to use fcncs (see “The PDR Network Configuration Service” on page 
252). 

2. Type fcconfig /? followed by Enter. The following is displayed: 
usage: fcconfig [options]
options:

-i <fc_ip_address> (dotted decimal)
-g <gateway> (dotted decimal)
-n <subnet_mask> (dotted decimal)
-a <hardware_address> (1-120, 0 for autoconfig)
-t <on | off> - enable/disable tcp checksums
-hta <on | off> - enable/disable auto host table admin
-s <on | off> - enable/disable use of the switch
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3. For PROFILE1 in this example, type the following:

NOTE: Do not reboot when prompted. 

192.168.100.1 followed by Enter
FC IP address set to 100.100.100.1
Reboot computer for settings to take effect!

fcconfig -g 255.255.255.0 followed by Enter
Gateway set to 255.255.255.0
Reboot computer for settings to take effect!

NOTE: Based on the address you use for a subnetmask, there is an 
Profile Family

implicit subnetmask, but you can override this with a larger mask. 
For example, 255.0.0.0 can be overridden by 255.255.0.0 or 
255.255.255.0. 

fcconfig -a 1 followed by Enter
Address set to 1
Reboot computer for settings to take effect!

NOTE: The hardware address can be any number between 1 and 120. 
In these examples, use 1 for PROFILE1 and 2 for PROFILE2. No two 
hardware addresses should be the same on the network. 

fcconfig -t off followed by Enter
TCP/IP checksums are now disabled.
Reboot computer for settings to take effect!

fcconfig -hta off followed by Enter
Auto host table administration set to off.
Reboot computer for settings to take effect!

4. Now type fcconfig again followed by Enter: 
Fibre Channel Network Configuration:
FC IP Address .................... : 192.168.100.1
Hardware Address ................. : 1
TCP checksums .................... : Disabled
Auto host table administration ... : Disabled
F/C Switch ....................... : Disabled
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Enabling the Fibre Channel Switch
If you intend to connect your Profile system to a Fibre Channel switch instead of 
a loop, you’ll need to load the appropriate microcode for the Fibre Channel board 
as explained in Chapter 6, “Using Profile Utilities”, and set Fibre Channel Switch 
Mode ON. You can do this in one of two ways:

• Type the following command from the Command Prompt: fcconfig -s on.

OR

• In Configuration Manager, select Enable Switch in the Fibre Channel 
6 Profile Family

Network Configuration dialog box (see “Setting Up Fibre Channel 
Networking” on page 102).

NOTE: You do not need to set the Fibre Channel hardware address of Profile 
systems connected to the Fibre Channel switch. These addresses are assigned 
dynamically in a fabric environment.

Once you’ve installed the required version of Profile System Software and loaded 
the appropriate microcode and drivers on all the devices you are connecting to the 
switch, you must configure each device for operation in a Fibre Channel fabric 
environment.

To configure your Fibre Channel server or any device other than your Profile 
system, refer to the installation manual for that device for instructions.
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Editing the Hosts File 
The next step is to edit the file c:\winnt\system32\drivers\etc\hosts. This file 
tells the Profile system what IP address is associated with what Profile unit. If 
you enter in all the Profile units’ IP addresses that are on your network, then the 
same file can be copied onto all the other Profile units. This saves you editing 
each Profile’s individual hosts file. You can also use a DNS server for name 
lookup, however instructions for using such a server are outside the scope of 
this manual. 

An alternative to editing the hosts file is to use the PDR Network Configuration 
Profile Family

service (fcncs) to automatically update and maintain the hosts file. For more 
information on fcncs, see “The PDR Network Configuration Service” on page 
252. If you want to use fcncs to automatically update your hosts file, you must 
enable auto host table administration by entering the command fcconfig -hta on 
followed by Enter. Your c:\winnt\system32\drivers\etc\hosts file will now be 
automatically administered by fcncs. 

To update your hosts file manually: 

1. Open the file in Notepad. The format is simple. First type the Ethernet IP 
address, followed by the machine name, such as PROFILE1. On the next line, 
type the IP address of the Fibre Channel board in that Profile unit, then the 
machine name again and add the characters _fc0. Here is an example: 
192.168.99.1 PROFILE1
192.168.100.1 PROFILE1_fc0
192.168.99.2 PROFILE2
192.168.100.2 PROFILE2_fc0
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2. Add these lines to the hosts file and remove any other lines which might 
conflict with them. All lines beginning with a # are comments and can be 
ignored. The hosts file will look something like this: 
# Copyright (c) 1993-1995 Microsoft Corp.
#
# This is a sample HOSTS file used by Microsoft TCP/IP for Windows NT.
#
# This file contains the mappings of IP addresses to host names. Each
# entry should be kept on an individual line. The IP address should
# be placed in the first column followed by the corresponding host name.
# The IP address and the host name should be separated by at least one
# space.
#

8 Profile Family

# Additionally, comments (such as these) may be inserted on individual
# lines or following the machine name denoted by a ‘#’ symbol.
#
# For example:
#
#      102.54.94.97 rhino.acme.com # source server
#       38.25.63.10 x.acme.com # x client host

192.168.99.1 PROFILE1
192.168.100.1 PROFILE1_fc0
192.168.99.2 PROFILE2
192.168.100.2 PROFILE2_fc0

3. Save the file in Notepad and exit. 

4. Reboot your Profile unit. 

5. Copy the new hosts file onto the other machine to save you editing it again.
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Testing the Fibre Channel Network
Once both Profile machines are back up and running: 

1. Double-click on the Port Server icon. This starts the Fibre Channel 
communication tool. It must always be running on any machine where you 
are using Fibre Channel. If you want, you can place Port Server in StartUp 
folder and set it to run minimized. Make sure its running on the other Profile 
machine, too.

2. After configuring all machines, verify name resolution using fcping by 
typing:
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fcping PROFILE1_fc0 

If this command returns: 
Host PROFILE1_fc0 is up 

You have successfully resolved the name PROFILE1_fc0 to the IP address
192.168.100.1. Keep in mind that although this verifies name resolution, it 
does not test Fibre Channel connectivity.

If, however, the fcping command returns:

Host PROFILE1_fc0 appears unreachable 

The Fibre Channel IP address could not resolve properly. You may want to 
reboot to ensure that any changes have taken effect or check your spelling. 

3. Now start the Media Manager by double-clicking its icon. You only need to 
run Media Manager when you want to manually copy clips from one 
machine to another, but the Port Server needs to be run at all times on all 
machines connected to the Fibre Channel network or they won’t be seen by 
Media Manager. For information on how to use Media Manager, see 
Chapter 3, “Using Media Manager,” on page 105. 
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You will not automatically see the other machine on the network. For example, 
if you are running Media Manager on PROFILE1 you will only see PROFILE1. 

1. Choose File | Add/Remove Machine. The Add/Remove Machine dialog box 
appears. The Local label follows the name of the current machine, 
PROFILE1. 

2. Click on the computer name for the other Profile machine you want, for 
example, PROFILE2. 

3. Click Add. 

4. Click OK. 
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For more information on connecting to remote Profile machines, see 
“Connecting to a Remote Machine” on page 110. 

You can now copy or move media from one machine to another. In addition, 
you can play a clip or master with VdrPanel or Tool Box Editor while the media 
is being moved or copied to another machine. 

Using the Listnames and Copymovie Commands
The listnames command line utility provides a way to list media on a remote 
Profile without using Media Manager. Valid arguments are datasets or 
volumes, groups or lists, and media. Dataset names are case sensitive. That 
means that INT: and int: would be considered different datasets.

The two arguments for listnames are: 

• -l start_arg list media based on a starting argument start_arg, such as INT:
If not specified, the utility will list all valid datasets (volumes) 

• -r remote_machine lists media of a remote machine, such as PROFILE1. If not 
specified, the utility searches local machine only 

This example lists all the valid datasets (volumes) on the remote machine 
PROFILE1: 

listnames -r PROFILE1 

This one lists all groups (clip lists) in INT: on PROFILE1: 

listnames -r PROFILE1 -l INT: [or just //]

The final examples lists all movies in INT:/default on Profile1: 
listnames -r PROFILE1 -l INT:/default/ 
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The copymovie utility copies media between two Profiles using the Fibre 
Channel network. The parameters to this utility are case-sensitive. The 
command is issued in the form: 

copymovie srcMachine srcName destMachine destName

There are four arguments: 

• srcMachine for the Profile machine where the source media is located (use 
an asterisk [*] to specify the local machine) 

• srcName for the source name of the media 

• destMachine for the Profile machine where you want copy to go (use an 
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asterisk [*] to specify the local machine) 

• destName is the name of the destination media 

This example copies media called INT:/default/movie1 from PROFILE1 to 
PROFILE2, where it will be named INT:/default/movie2.

copymovie Profile3 INT:/default/movie1 Profile4 INT:/default/movie2

This example copies media called INT:/default/movie1 from PROFILE1 to the 
local Profile where the command was run, where it is named 
INT:/default/movie7. 

copymovie PROFILE1 INT:/default/movie1 * INT:/default/movie7
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The PDR Network Configuration Service
The PDR Network Configuration service (fcncs) collects information about 
other PDRs on the network via multicast, and maintains a local table of the 
information. It also will update the c:\winnt\system32\drivers\etc\hosts file if 
the fcconfig -hta option is set to on, and only if it is set to on.

This service has the following standard command line options: 

fcncs -install installs the service on the system. The service starts 
automatically when installed.

fcncs -remove removes the service from the system.
2 Profile Family

fcncs -start starts the service.

fcncs -stop stops the service. 
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Storing media on a Profile system rather than on tape opens the door to almost 
instant access to video and audio material. Media is available to all of Profile’s 

t once, so you can play a video on more than one channel at the same 
e each of the channels (up to four) is independent, playback can start 
ent time and place in a clip. One of the best features of the Profile 
channels a
time. Sinc
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system is that you can start playing material while it’s still being recorded.
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The basic element of digitally stored video and audio is the clip. A clip is a 
reference to video, audio, and timecode material recorded in media files on 
Profile disks. A clip has a beginning and an end, and, when first recorded, the 
beginning and end correspond to the first and last frames stored in the media 
file. A clip may refer to the entire media file or just part of it. When you delete 
a clip, the media file that the clip referred to remains on disk—only the 
reference to the media file is deleted, not the media itself.

The Tool Box Editor is a graphical user interface that lets you create digital 
media by capturing video and audio clips while also providing an inexpensive, 
cuts-only editing system. It lets you log video and audio material from a variety 
of sources, such as a satellite feed, live camera, VTR, CD player, or 
microphone. You can assemble material on disk and then send it back out to 
tape, broadcast, or archive. 

After launching the Tool Box Editor (see Figure 117), the first step you must 
take is to acquire resources—such as codecs and audio channels—with the 
Resource Manager. Then you can capture a new clip or play an existing one. 
Other common tasks include creating new masters, playing masters, creating 
subclips, trimming clips, and deleting media. 

NOTE: Profile system software version 2.5 supports Tool Box Editor 
version 1.1.5.
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Starting and Exiting the Tool Box Editor
To start the Tool Box Editor:

• Double-click the Tool Box Editor shortcut icon on the desktop.

• Choose Start | PDR Applications | Tool Box Editor.

NOTE: The Tool Box Editor may be restarted at any time. Multiple 
instances are allowed.
4 Profile Family

Figure 117. Tool Box Editor window 
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You can start the Tool Box Editor from a command line, provided that 
c:\profile is in the path, by typing:

tbxedit.exe 

You can also specify a project file name when you start the Tool Box Editor 
from a command line:

tbxedit.exe myproject.tbx 

You can start Tool Box Editor while also connecting to a named Profile unit on 
the network:

tbxedit.exe -m profile7 
Profile Family

NOTE: You cannot specify both a project file and a remote Profile 
machine in a command line at the same time.

Whenever you start the Tool Box Editor, a Hardware Communication Monitor 
is also started, if it is not already running. This program keeps track of the 
Profile host file (profile.hst) which lists Profile systems on the network, as well 
as remoting activities.

Figure 118. Hardware Communication message box 
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The Hardware Communication Monitor tries to connect to a machine in the 
project file (see “Project Files” on 257). If there is no project file present, you 
will automatically connect to the local machine. Otherwise, you will go to the 
Connect to Machine dialog box (see Figure 119).

To exit the Tool Box Editor:

• Choose File | Close.

A message box is displayed, asking you to confirm that you really want to exit 
the application. Click on the Yes button to confirm the exit or the No button to 
cancel the quit command. 
6 Profile Family

Configuring Resources 
You must configure video, audio, and timecode resources before using Tool 
Box Editor. You configure resources with Resource Manager. To start this tool: 

• Choose Config | Resources. 

For instructions on using Resource Manager, see “Using the Resource 
Manager” on 313. 
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Project Files
You can save your work environment into a project file (.tbx). A project file 
stores allocated resources and the current bin. Saving your environment eases 
the transition of set-ups between users. A descriptive project title is displayed 
in the title bar of the Tool Box application, including the current machine name 
and channel.

A project file contains the following information for the last Profile machine 
connected to:

• What the last machine was.
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• The Resource Manager configuration.

• The current bin.

If you connect to a new remote Profile machine during a session, the default 
settings for that Profile machine (saved by Resource Manager) are used for that 
machine. If no defaults have been saved, factory defaults are used.

To save the current work environment in a project file in the current working 
directory:

• Choose File | Save.

To open an existing project file:

• Choose File | Open.

You can also specify a project file name when you start the Tool Box Editor 
from a command line:

tbxedit.exe myproject.tbx

To create a new project file:

• Choose File | New.

You are asked to save the current project file (if necessary) and then if you are 
connected to a local machine, the Tool Box Editor caches media and is set up 
using a default configuration. If you are connected remotely, you are also asked 
which machine to connect to in the Connect to Machine dialog box. 

To save an existing project file under a different name:

• Choose File | Save As.
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Connecting to a Remote Profile Machine
You can connect from your local machine to any remote Profile machine in 
your network. A local Profile machine refers to a Profile system to which you 
are directly attached. A remote Profile machine refers to a Profile system that 
is connected to your local system via an Ethernet local area network (LAN).

To connect to a remote Profile machine:

1. Choose File | Remote Machine. The Connect to Machine dialog box 
appears. The label Local appears after the name of the local Profile machine.
8 Profile Family

Figure 119. Remote Machine dialog box

To connect a Profile machine from the network host list:

1. Select the name of the machine in list box.

2. Click Connect.

3. The Connecting to Machine dialog box is displayed. If the connection is 
unsuccessful, you are given the opportunity to retry the connection or to 
cancel the operation. 

NOTE: To add a Profile machine to the network host list, see 
“Connecting to a Remote Machine” on 110.



Selecting a Current Bin

259

Selecting a Current Bin
After you have acquired resources and chosen operational settings, you are 
ready to start editing. First, let’s discuss some basics.

With the Tool Box Editor, you edit media such as clips and masters. The capture 
timeline lets you capture video and audio clips while the edit timeline allows 
you to edit a sequence clips into a master. 

A bin is simply a collection of masters and clips. The current bin is the set of 
media displayed in the current bin display. (See Figure 120) By default, the 
current bin is the first or top bin displayed in Media Manager.
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The current bin display helps you focus on and work with a set of clips and 
masters. Above the display, the column headers are shown. Click on the column 
header bar by pointing the mouse pointer at the header and pressing the left 
mouse button. The media files are then sorted according the criteria of the 
columns.

You can also view (sort) media in the current display in several other ways—
showing all media at once (default), clips only, or masters only.

To select a view, simply click on the view bar above the contents pane and 
choose a menu item. You can also customize how you sort the media by name, 
type, or date—or all three at once. Selecting and sorting views is useful when 
you have a lot of media on disk. 
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Figure 120. Current bin display

Below the current bin display is a set of buttons (from left to right):

• Load Media: Loads a selected master onto the edit timeline or a selected clip 
onto the capture timeline.

• Insert Media: Inserts a selected clip into the currently loaded master on the 
edit timeline near the location of the current timeline cursor.

• Timeline Eject: Ejects media from the active timeline.

• New Master: Creates a new, empty master, ready to receive clips.

• New Bin: Creates a new bin within a volume and displays it in the current 
bin display.

• Open Bin: Opens an existing bin and displays it on the current bin display.

• Delete Media: Deletes selected media.

Load Media

Timeline Eject
New Master

Open Bin

New Bin

Delete Media Bin Toolbar
Insert Media

Undo Redo
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Opening a Bin
To open or change the current bin:

1. Click the Open Bin button.

2. Enter the name in the text box or select the desired bin from the list box and 
press OK.

3. The selected bin is loaded into the current bin display.

Creating a New Bin
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You will often want to create a new bin to store and organize new media. To 
create a new bin:

1. Click the New Bin button below the current bin display and the new bin 
dialog box is displayed.

2. Enter the name of new bin in the text box, or accept the default name.

3. Click OK to accept the new bin name.

The new bin automatically appears in the current bin display.

Record Time Remaining
Below the edit timeline (lower-left) is the record time remaining, in the form 
00:00 (Hours:Minutes). This indicates the amount of storage remaining in the 
current Profile volume. The amount varies based on the current video quality. 
Generally, the higher the quality of video, the more disk space is used, thus 
leaving less time remaining.

Renaming Media
To rename a clip or master: 

1. Select the clip or master in the current bin.

2. Choose Rename from the Media menu or from the shortcut menu with a 
right-click. You can also select the bin or master again in the current bin.

3. Type a new name, then press Enter.
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Viewing Media Properties
You can view the media properties for clips and masters. To view these 
properties:

1. Select a clip or master in the current bin.

2. Choose Properties from the Media menu or from the shortcut menu with a 
right-click. You can also double-click the clip or master in the current bin. 
The Properties dialog box appears (see Figure 121). 
2 Profile Family

Figure 121. Properties dialog box 
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In this dialog box, you can view:

• A preview frame of the clip or master to help identify it. Preview frames are 
not available for MPEG masters.

• The name of the clip or master.

• How many tracks the clip or master uses for both audio and video.

• The media format, either NTSC or PAL. NTSC clips are recorded with either 
drop-frame or non-drop-frame timecode.

• The length of the clip or master. The length is shown in timecode format: 
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00:00:00:00 (Hours:Minutes:Seconds:Frames).

• The date and time that the media was created and the date and time it was 
last changed. The date and time the media was created or last changed is 
shown in the form: 12/2/94 9:40 PM

• The read-only attribute, which you can change by clicking the Read Only 
box. Clips and masters with the read-only attribute cannot be renamed, 
deleted, or modified in any way.

Deleting Media
When the amount of remaining disk storage begins to get low (the time 
remaining is displayed below the edit timeline), you can free space by deleting 
unused media.

1. Select media from the current bin display. You can select either clips or 
masters; you can also select several clips or masters at a time.

2. Choose Delete from the Media menu or from the shortcut menu with a right-
click. Press the Delete key or the Delete button on the bin toolbar.

3. A dialog box asks you to confirm that you want to delete the selection. If you 
click on Yes, the media is deleted; if you click on No, the operation is 
cancelled.

4. When media is deleted, it is moved to the Recycle bin until the Recycle bin 
is emptied.

NOTE: If a clip is locked, you cannot delete it. When a clip is deleted, 
its source material is not deleted if any other clips or masters 
reference that material. Only after the last clip is deleted is any disk 
storage freed.
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Emptying the Recycle Bin
When a clip or master is deleted, it is moved to the Recycle bin and is 
permanently deleted when the Recycle bin is emptied. If an item of the same 
name is in the Recycle bin, the new item is automatically renamed.

To empty the Recycle bin:

• Choose File | Empty Recycle Bin.

NOTE: If the Recycle bin contains no deleted media, the Empty 
Recycle Bin menu item is dimmed.
4 Profile Family

The Capture Timeline
The capture timeline allows you to capture and trim clips. You can 
set the current time position and adjust mark in or mark out points. 
Click on the Capture button below the audio controls to activate the 
Capture timeline without changing the current time position.

Figure 122. Capture timeline 

When recording a clip on the capture timeline, you see the clip name and its 
record status. With normal recording, you see a Recording label. With loop 
recording, you see a Buffer Recording label. If a clip is being recorded on 
another channel simultaneously, the Mark-in and Mark-out buttons are disabled 
and the Read Only label is displayed.
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The Tool Box Editor displays four timecode indicators: current position, 
duration, mark-in, and mark-out. The timecode indicators display hours, 
minutes, seconds, and frames in the form 00:00:00:00. The duration displays 
the minimum number of digits. Drop-frame timecode is indicated by a 
semicolon (;) before the frame number.

Each part of the timecode—frames, seconds, etc.—can be selected by a click of 
the left mouse button and then changed separately. To the right of each 
indicator are the spin buttons with an arrow pointing up or down. Click on the 
up arrow and the time is increased, or decrease it by clicking the down arrow.

When a clip is loaded onto the capture timeline, the current position timecode 
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indicator shows the frame-accurate cursor position in the clip. To move the 
current position cursor, click anywhere on the capture timeline. The updated 
timecode is displayed in the indicator as you move the cursor.

To adjust a clip’s mark in or out point, move the current position cursor to the 
desired location and then click on the Modify Mark-In or Modify Mark-Out 
button. The mark in and mark out timecode indicators are displayed on either 
side of the capture timeline. The mark in and mark out markers on the capture 
timeline indicate where these marks lie on the clip. To move the mark in or 
mark out, grab the mark in or mark out marker on the capture timeline by 
clicking on it with the left mouse button and holding the button down while you 
move it.

To bring up the timecode entry window, click in a timecode indicator and then 
press + (plus sign), – (minus sign) on the keypad or = (equal sign) on the 
keyboard. To add to a timecode, click inside a timecode indicator, press + and 
the timecode entry window appears. Enter the desired value in the form 
00:00:00:00 and press Enter. (Only numbers need to be typed.) The value is 
added to the timecode.
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To subtract from a timecode, click inside a timecode indicator press – and the 
timecode entry window appears. Enter the desired value in the form 
00:00:00:00 and press Enter. The value is subtracted from the timecode. To 
change the value of the timecode, click inside a timecode indicator press = and 
the timecode entry window appears. Enter the desired value in the form 
00:00:00:00 and press Enter. The value is changed to the desired timecode. If 
an entry in the timecode entry window is out of bounds, it is ignored.

Figure 123. Timecode entry window 
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The E to E (Electronics to Electronics) button is to the right of the duration 
timecode indicator. By default, E to E is off. If you click on this button, E to E 
is activated. When E to E is off, the monitor shows the active timeline’s current 
position. When it is on and no clips are playing or recording, the Profile 
channel’s live video input bypasses the codec and is directly connected to the 
outputs.

Figure 124. E to E button 

Capturing a New Clip
Now you are ready to capture or record a new clip.

Figure 125. Record buttons

1. First, you need to enable video and/or audio for recording. To enable inputs 
for recording, you can click on video or audio buttons. The buttons are lit 
when activated.

Record Button
Video Enable Button

Audio Enable Button



Capturing a New Clip

267

2. All acquired audio channels may be used when recording new clips. 
However, you need to select a set of audio channels. To select a set of audio 
channels for recording:

• Click the Audio Enable button.

• Enable audio channels by clicking on the channel selection button above the 
appropriate audio meter. (See Figure 132)

3. Enter the new clip name in the Clip Name text box, or simply accept the 
default. The default name automatically increments to a unique name. With 
a right-click in the text box, you can choose from several editing commands.
Profile Family

Figure 126. Clip Name text box 

4. Click on the Record button. You can also choose Record from the Media 
menu or from the shortcut menu with a right-click.

5. When you are done recording, click on the Stop button. (See Figure 127)

Figure 127. Transport controls
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The transport controls are:

• Loop Play: Plays the active timeline at normal speed. When the end of the 
media is reached, play begins again at the beginning of the media.

• Reverse: Plays the active timeline in reverse.

• Rewind: Rewinds the active timeline or returns the current position to the 
beginning of the clip.

• Play: Plays the active timeline at normal speed.

• Fast Forward: Fast forwards the active timeline.
8 Profile Family

• Stop: Stops play on the active timeline.

Loop Recording
You can also loop record material. To loop record material, you set up a record 
buffer that will allow you to record for a length of time. When you reach the 
end of the record buffer, the current position moves back to the beginning of the 
buffer and previously recorded material is overwritten. The steps for loop 
recording are as follows:

1. Choose Config | Record Buffer and the Record Buffer dialog box appears. 
The maximum record time reflects time allocated to all activated buffers and 
time allocated to the channel and available record time on the Profile unit.

Figure 128. Record Buffer dialog box 

2. Enter the length of the record buffer and click OK.

3.  Click BUF in the upper-right corner of the screen to activate this feature. 
When activated, the button is lit.

4. Follow the steps in “Capturing a New Clip” on 266.
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Playing a Clip
Now that you have recorded a clip, you can play it back:

1. Select a clip in the current bin.

2. Choose Load from the Media menu or from the shortcut menu with a right-
click. You can also click on the Load button on the current bin toolbar. The 
clip is loaded onto the capture timeline.

3. Click on the Play button.

You can also drag and drop a clip onto the capture timeline. To drag and drop 
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a clip:

1. Select a clip by clicking the left mouse button while the mouse pointer is 
over the desired clip and hold the button down.

2. Drag the clip to the capture timeline and release the mouse button. 

Trimming a Clip
Trimming a clip means changing the mark-in and/or mark-out points so that the 
clip duration becomes shorter. To trim a clip:

1. Select the clip you want to trim in the current bin.

2. Load the clip onto the capture timeline.

3. Do one of the following:

• Drag the mark-in or mark-out cursors to a new position on the timeline (see 
the mark-in and mark-out cursors in Figure 122, page 264).

• Drag the current time cursor to a new location and click on the Modify Mark-
in button or Modify Mark-out button. The current position is taken as the 
new mark position.

• Adjust the in and out marks by entering the new timecodes in the boxes 
provided (see the timecode entry boxes in Figure 122, page 264).

Even when trimmed, media remains on disk. Choose Media | Cleanup to 
remove excess media permanently from a trimmed clip. The trimmed portions 
are removed from disk, thus freeing space for more clips.
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NOTE: Media | Cleanup works only if no subclips have ben created 
from a clip. If subclips have been created, or if the clip is referenced 
by a master, Cleanup will fail.

Creating a Subclip
A subclip is a portion of an existing clip. Subclips can help you order your 
material when creating masters. The buttons that allow you to create subclips 
are the Create Mark-in and Create Mark-out buttons. With the Create Mark-
in button, you mark where you want to start the subclip; with the Create Mark-
out button, you specify where you want to end the subclip.
0 Profile Family

In addition, you can set user marks as points of interest that you can jump to at 
a later time.

Figure 129. Create and User Mark buttons, plus event and frame controls 
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To create a subclip:

1. Select the clip in the current bin from which you want to create a subclip.

2. Choose Load from the Media menu or from the shortcut menu with a right 
click. You can also click the Load button on the current bin display toolbar. 
The clip is loaded onto the capture timeline.

3. Enter a name for the subclip in the Clip Name text box. This is optional as a 
default name is automatically generated.

4. Move the current position cursor to the desired starting location.
Profile Family

5. Click on the Create Mark-in button.

6. Move the current position cursor to the desired ending location.

7. Click on the Create Mark-out button. The subclip is added to the current bin.

User Marks

You can insert a user mark into a clip so that you can easily jump to that mark 
later in the editing process. You insert the mark by placing the current position 
cursor and then clicking on the User Mark button. A user mark is inserted at the 
current time cursor position. You can jump to user marks by clicking on the 
Previous Event and Next Event buttons.

To remove the current user mark:

1. With the clip loaded on the capture timeline, locate the exact frame where 
the user mark is located using the event and frame controls.

2. Choose Timeline | Remove Current User Mark.

To remove all user marks:

1. Load the clip onto the capture timeline.

2. Choose Timeline | Remove All User Marks.
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Event and Frame Controls

The event and frame controls let you navigate the active timeline in forward or 
reverse direction (see Figure 129). The Previous Frame and Next Frame 
buttons display the last or next frame. The Previous Event and Next Event 
buttons move the current position to the next user mark, mark-in, or mark-out 
points.

Shuttle Controls

The shuttle rate slider sets the play speed in the range –16 to +16. The play 
speed increases as you move the slider to the right and decreases you as you 
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move the slider to the left. You can also adjust the play speed with the shuttle 
rate input box. Simply type in the rate in the range –16 to +16 and press Enter. 
The selected clip begins playing automatically whenever you adjust the shuttle 
rate.

Creating Subclips on the Fly
To create a subclip on the fly, either while recording a new clip or by playing 
an existing clip:

1. To start recording, choose Record from the Media menu or from the shortcut 
menu with a right-click. You can also click the Record button. A new clip 
appears in the current bin display whose duration grows longer with each 
new frame recorded.

2. To play an existing clip, select a clip in the current bin display, choose Load 
from the Media menu or from the shortcut menu with a right-click. You can 
also click the Load button on the current bin toolbar. Then click the Play 
button.

3. Enter a new subclip name in the clip name field or accept the default name.

4. To create a clip on the fly, click Create Mark-in. This starts the new clip. A 
new clip name appears in the current bin display with a duration of only one 
frame.

5. Click Create Mark-out. The new clip’s duration is updated.

6. Repeat steps 2–4.

7. Click the Stop button when done.
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The Edit Timeline
The edit timeline lets you edit masters and their tracks of video and 
audio (up to sixteen tracks of audio). The current frame is indicated 
by the placement of the current position (time) cursor. The 

horizontal scroll bar allows you to scroll through time, and the vertical scroll 
bar allows you to scroll through tracks. Select the Edit button beneath the audio 
controls to activate the edit timeline without changing the current time position.

Linear Timecode
Readout

Current Position (Time) CursorMaster Name Selected Clip
Profile Family

Figure 130. Edit timeline 

Beneath the edit timeline is a toolbar displaying these buttons:

• Zoom-in: Zooms in the track scale.

• Zoom-out: Zooms out the track scale.

You can insert clips at the edit closest to the current time position by choosing 
Insert from the Media menu or from the shortcut menu with a right-click, or by 
clicking Insert Media on the current bin toolbar.

Zoom-In

Zoom-Out
Scroll BarsTrack

ReadoutsTrack Labels
(1 Audio, 2 Video)

Trim Handles
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After you have inserted material onto the edit timeline, you can trim source 
material. You can trim clips directly with trim handles. To make the trim 
handles appear, select the clip while it is on the edit timeline (see Figure 131). 
You can drag the trim handles to the left or right to make the clips shorter or 
longer, to the limit of the beginning and ending of the source material.

Trim
handles
4 Profile Family

Figure 131. Trim handles on the edit timeline 

As you trim a clip, the current channel output plays source material from the 
trim position rather than the current time position. Timecode for the trim 
position is shown at the bottom of the timeline, with the amount of time added 
or removed from the clip below that.

A few keyboard shortcuts are available for trimming:

• Select trim handle head: Ctrl-h

• Select trim handle tail: Ctrl-t

• Trim left 10 frames: Shift-z

• Trim left 1 frame: z

• Trim right 1 frame: x

• Trim right 10 frames: Shift-x
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Creating a New Master
A master is a sequence of clips. To create a new master:

1. Click on the New Master button on the current bin toolbar. The New Master 
dialog box appears. (You can also drag clips to the empty edit timeline from 
the current bin.)

2. Enter the name of the new master in the New Master text box, or simply 
accept the default. The default name is always unique. 

3. Click on the OK button. The name of the new, empty master appears above 
the edit timeline.
Profile Family

Adding Media to a Master
A newly created master is empty. You can assemble a master by inserting clips 
or even other masters into it:

1. Click in the edit timeline to make it active.

1. Select a clip or master in the current bin.

2. Choose Insert from the Media menu or from the shortcut menu with a right-
click. You can also click the Insert Media button on the current bin toolbar.

3. The media is loaded onto the edit timeline.

You can also drag and drop a clip or master onto the edit timeline. To drag and 
drop media to the edit timeline:

1. Select a master or clip in the current bin by pressing the left mouse button 
while the mouse pointer is over the desired clip and hold the button down.

2. Drag the master to the edit timeline and release the mouse button.

3. Each is inserted into the new master at the closest cursor location. After 
insertion, the time cursor automatically moves to the last frame of the new 
material.
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Playing a Master
Now that you have created a new master, you can play it or any other master 
using the edit timeline:

1. Select the master you want to play in the current bin.

2. Choose Load from the Media menu or from the shortcut menu with a right-
click. You can also click on the Load button on the current bin toolbar. The 
master is loaded onto the edit timeline and the timeline is made active.

3. Click on the Play button.
6 Profile Family

You can also drag and drop a master onto the empty edit timeline. To drag and 
drop a master:

1. Select a master by pressing the left mouse button while the mouse pointer is 
over the desired clip and hold the button down.

2. Drag the master to the edit timeline and release the left mouse button.

NOTE: Masters cannot be loaded onto the capture timeline.
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Using the Audio Controls
The Tool Box Editor lets you gain access to up to 32 channels of audio. Each 
audio channel consists of an audio channel record selector button and an audio 
metering section. The audio metering section contains an input indicator, an 
overload indicator and, from left to right, tick marks to indicate decibel levels, 
an input gain level indicator, an audio level bar meter, and an output gain level 
indicator.

Audio Channel Record Selectors
Profile Family

Figure 132. Audio controls
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The overload indicator lights if the audio level is above the highest level of the 
meter. The input gain level, audio level, and output gain level use the same 
metering scale. The metering scale is a +4.0 dB meter scale (+0 corresponds to 
+4.0 dB) and ranges from +14 dB to –40 dB. (+18 dB to –56 dB full scale).

At the top of the four audio meters are the audio channel record selector 
buttons. Valid audio channels for the current channel will have record selector 
buttons containing a channel number. To enable a channel for recording, place 
the mouse pointer over the record selector button and click on it with the left 
mouse button.

The audio fader lets you adjust the audio input and output levels of the currently 
8 Profile Family

selected channel. If more than one audio channel is selected for gain 
adjustment, the fader level reflects the highest gain level of the selected audio 
channels. The decibel level window above the fader also displays the fader’s 
current decibel level.

The input and output gain levels of each channel may be adjusted also. To select 
an audio channel for gain adjustment, place the mouse pointer over any part of 
the channel’s meter section. Click the left button to select the channel. The 
meter section is highlighted.

Below the audio gain displays is the audio control toolbar which has the 
following buttons:

• Unity: Sets all audio levels to the unity level (0 dB[+4.0]). To set unity, the 
audio meter must be selected and the input or output gain adjustment button 
must be selected.

• Input gain adjustment mode: This button activates the input level arrow 
(left side) for fader adjustments.

• Output gain adjustment mode: This button activates the output level arrow 
(right side) for fader adjustments.

• Scale adjustment increase/decrease: These buttons zoom in or zoom out 
on the audio display scale in the range of +6 to –6 dB.
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Tool Box Editor Keyboard Shortcuts
The Tool Box Editor automatically programs a number of keyboard shortcuts.

Table 15. Tool Box Editor Keyboard Shortcuts 

Shortcut Key Command

F1 Activate Channel 1

F2 Activate Channel 2

F3 Activate Channel 3

F4 Activate Channel 4
Profile Family

F9 Select video

F11 Select audio

F12 EE toggle

j Reverse Play

h Rewind

; Fast Forward

l Play

n Record

SPACE or k Stop

i Create Mark-In

o Create Mark-Out

q Modify Mark-In

w Modify Mark-Out

u User Mark

, (comma) Previous Frame (left)

. (period) Next Frame (right)

Left Arrow Previous Frame (left)

Shift Left Arrow Jump Back 10 Frames

Right Arrow Next Frame (right)

Shift Right Arrow Jump Forward 10 Frames

a Previous Event

s Next Event

Ctrl-H Select trim handle head

Ctrl-T Select trim handle tail

z Trim left 1 frame
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x Trim right 1 frame

Shift-z Trim left 10 frames

Shift-x Trim right 10 frames

1 Give focus to current position timecode

2 Give focus to Duration timecode

3 Give focus to Mark-in timecode

4 Give focus to Mark-out timecode

Table 15. Tool Box Editor Keyboard Shortcuts 

Shortcut Key Command
0 Profile Family

7 Give focus to Fader Level

8 Give focus to Shuttle Rate

9 Give focus to New Clip Name

0 Give focus to Bin Display

Ctrl-M Media Manager

Ctrl-N New Project File

Ctrl-O Open Project File

Ctrl-S Save Project File



Chapter 9
Using the List Manager

The Profile List Manager lets you automate your use of the Profile video disk 
recorder. You’ll probably want to use List Manager to schedule playback of 
JPEG or MPEG clips or masters created in the Tool Box Editor on designated 
outputs. List Manager also lets you record incoming video at predetermined 

nd incoming video directly to an output. You can also set up times to 
ve connection, transfer media between Profile systems connected via 
nnel, or even archive a clip on a library unit. You can combine these 
times or se
switch a li
Fibre Cha
81

functions to increase the automation level of your station operations. (See 
Figure 133.)
Profile Family 2

NOTE: Profile system software version 2.5 supports List Manager 
version 1.2. This version supports MPEG.

List Manager Overview
The Profile List Manager works with events. Each event is a task or operation 
that List Manager performs on a clip or a master or on incoming video. 

List Manager uses a software “engine,” called the Event Scheduler Engine, to 
schedule your lists. It runs behind the scenes and does all the actual work of 
playing and recording clips at the appointed times. This low-level software 
starts automatically when you start the List Manager, and continues to run for 
the rest of that Windows NT session, even if List Manager isn’t running.

If you need to stop the Event Scheduler for any reason, click the minimized 
Event Scheduler icon, then type exit on the command line and press Enter.

List Manager lets you schedule playback, record, switch, transfer, and archive 
events. A playback event lets you play a clip or master at a designated time, 
while a record event allows you to record material at a given time. A switch 
event schedules a live connection; input and output are connected directly in E 
to E mode at a predetermined time and remain in that mode until the next 
playback event. A transfer event schedules the copying of media from one 
Profile video disk recorder to another Profile unit on the network (requires 
Ethernet and Fibre Channel connections). An archive event copies media to or 
from a Profile library system, such as the PLS200 or PLS20. 



Chapter 9 Using the List Manager

28

All of these capabilities are available on all Profile channels. For example, if 
you have four video channels, you might choose to dedicate two channels to 
recording incoming material, one for on-air playback, and the other for 
preview. 

Each event can be scheduled to occur at an exact time, on demand, or it can 
follow other events. You can override or stop a list at any time.

List Manager provides you with two ways of scheduling lists:

• Monitor. You can drag and drop events into the list in Monitor view to 
schedule them immediately. Monitor displays the On-air List, which is the 
2 Profile Family

name of the list that is controlling activities on your Profile. List Manager 
always reads the On-air List, and will perform the events you see in the 
Monitor view at their appointed times unless you delete events. The On-air 
List can’t be saved for future use. There is one On-air List and it has a limit 
of 5000 events.

• Edit Window. You can build several lists in the Edit window to use at a later 
date or to store for repeated use. Lists you build in the Edit window are not 
scheduled immediately. When you choose the Schedule List command from 
the Edit menu, the list is integrated into the On-air List and its events are 
performed with other events which were already on the On-air List.

List Manager validates the On-air List to make sure that you haven’t scheduled 
conflicting events using the same Profile resources. You can then schedule the 
list and let List Manager control your Profile. You can follow the operation of 
a list by using the Monitor view on any or all of your Profle’s channels.
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Starting List Manager
To start List Manager in Windows NT 4.0:

• Double-click the List Manager shortcut icon on the desktop.

Or: 

• Choose Start | Programs | PDR Applications | List Manager.

When you start List Manager for the first time, your screen should look similar 
to the one shown in Figure 133.
Profile Family

Figure 133. List Manager window 
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Whenever you start List Manager, a Hardware Communication Monitor is also 
started, if it is not already running. This program makes calls to the disk 
recorder, keeps track of the Profile host file (profile.hst) which lists Profile 
systems on the network, as well as remoting activities.
4 Profile Family

Figure 134. Hardware Communication Monitor message box 

Viewing Help
To view Help topics:

• Choose Help | Help Topics.

Closing List Manager
To close List Manager:

• Choose File | Exit.
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Configuring Resources
Before you can use List Manager, you must configure video, audio, and 
timecode resources, which are required for List Manager to operate. You 
configure resources with Resource Manager. To start this tool:

• Choose Project | Configure. 

Resource Manager provides the means to add or remove channels (either JPEG 
or MPEG), add or remove video, audio, and timecode tracks, and assign inputs 
and outputs to those tracks. For detailed instructions on using Resource 
Manager, see “Using the Resource Manager” on page 313.
Profile Family

System resources used by List Manager are not available to other applications, 
whether or not a list is scheduled. If you try to start an application that requires 
the resources being used by List Manager, you’ll be warned that those resources 
are not available. You can free up those resources for use by other applications 
by starting the Resource Manager, then setting the desired resources to None. 
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Connecting to a Remote Profile Machine
You can connect from your local machine to any remote Profile machine in 
your network. A local Profile machine refers to a Profile system to which you 
are directly attached. A remote Profile machine refers to a Profile system that 
is connected to your local system via an Ethernet local area network (LAN).

To connect to a remote Profile machine:

1. Choose File | Remote Machine. The Connect to Machine dialog box 
appears. The label Local appears after the name of the local Profile machine.
6 Profile Family

Figure 135. Remote Machine dialog box

To connect a Profile machine from the network host list:

1. Select the name of the machine in list box.

2. Click Connect.

3. The Connecting to Machine dialog box is displayed. If the connection is 
unsuccessful, you are given the opportunity to retry the connection or to 
cancel the operation. 

NOTE: To add a Profile machine to the network host list, see 
“Connecting to a Remote Machine” on page 110. 
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Building a Playback List
List Manager lets you use a simple graphical interface to build lists that 
automate your operations. You can drag media from the Media Manager into 
your list, then define things like when to play the material, and what channel 
and output to use. 

Drag and drop of incompatible clips is not allowed. There are four types of 
channels. JPEG, MPEG Record, MPEG Play, MPEG Play/Record. JPEG 
channels allow only JPEG clips and MPEG channels allow only MPEG clips.

• JPEG channels - allow any type of events (play/record etc.)
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• MPEG Play - allow any type of events except record

• MPEG Record - allow any type of events except play

• MPEG Play/Record - allow any type of events (play/record etc.)

Adding Media for Playback
Creating a playback list is the simplest of all List Manager operations. To build 
a playback-only list:

1. Click the Monitor tab to view of the On-air List. The first time you use List 
Manager, this list should be empty.

2. Scroll through the Media Manager tree to locate the first clip or master that 
you wish to include in your list.

3. Drag the clip or master into the List Manager window and drop it at the 
desired location in the list.

You can add clips or masters between two existing events by dropping an 
event on the line separating the two events and selecting the top event. The 
item is inserted below the selected event.

4. Change the event settings to meet your needs. The settings are described in 
“Changing Event Settings” on page 289.

5. Continue adding clips or masters by dragging them onto the list. List 
Manager will perform the events at the scheduled time. 

After adding a few events, your list should look similar to the one shown in 
Figure 136.
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Figure 136. A basic playback list
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Changing Event Settings
List Manager establishes default settings for each event as you drop material 
into the window. You can move from event to event in the list with the up and 
down arrow keys. You can customize the event by editing the property settings 
in the list. You can also edit property settings by double-clicking on the left end 
of the row, then changing settings in the edit boxes of the properties dialog box 
that appears. The dialog box for play event properties is shown in Figure 137.
Profile Family

Figure 137. Play event properties dialog box
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By default, the list displays five columns: Status, Name, Start Time, Duration, 
and Comment. A label at the top of each column (except Status) identifies the 
settings in that column. Choose View | Columns to change which columns are 
displayed. (See “Customizing Your List Display” on page 308.)

Status - This cell displays the current status of the event. The word Status does 
not appear in the header. The Status column is active only in the On-air List (in 
the Monitor view). If there is a conflict between an event and any other event 
in the current list or another event on the On-air List, the Status cell displays 
Error. You can identify the conflict by right-clicking on the cell and reading the 
error message in the Event Property dialog box. Table 16 shows all the event 
status indicators.
0 Profile Family

Name - This cell identifies the clip or master name, whether it is being played 
or whether it is a new clip being recorded.

Start Time - You can enter the time at which you wish to play the specified 
material. Enter the time in standard timecode format (HH:MM:SS:FF). If the 
time entered consists of one or two digits not separated by colons, List Manager 
displays the entry as a number of seconds, not frames. For example, if the time 
entered is 25, List Manager displays 00:00:25:00. (Leading zeros are ignored—
that is, 0025 is interpreted as 00:00:25:00.)

Table 16. Event status indicators

Status Color Description

Play Green The event is currently being executed.

Record Green The audio and video from the specified input is currently 
being recorded as the Destination clip name.

Error Red The signal is in conflict with another event, or the 
material is not available.

Stop White The event is stopped.

Cued Yellow Approximately five seconds before Start Time, the 
required resources are prepared for playback or 
recording.

Take White Event is about to be executed.
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Duration - The duration of the playback event is set by the duration of the 
media. If you change the duration to one shorter than the media’s duration, List 
Manager will play the material from the mark in point for the specified 
duration. If you enter a longer duration, List Manager plays the material from 
the mark in point to the last mark out point, then freezes on the last frame for 
the rest of the duration. 

Comment - The Comment cell displays the name of the master or clip which 
you dragged into the window. You can change this to a title more meaningful 
to you. However, this will not change what clip or master is used, nor will it 
change its name.
Profile Family

Optional Columns

These are the columns that you can add to the window to provide you with 
additional event information.

Action - When you drag material into the List Manager window, Action is set 
to Play. The possible actions are: Play, Record, Switch, Transfer, and Archive. 
These options are described in later in this chapter.

Event Number - Events are numbered as they are added to the current list. 
The event number can’t be changed because it provides a unique identifier for 
this event in the current list. The event number does not determine the playback 
order. 

Parent - This setting uses the number of the event that precedes it, the “parent” 
event, and is valid only for Follow events. Any event can be a parent event as 
long as it has a Follow event after it.

Type - The event types are:

• The Absolute event type plays the material at the time specified in the Start 
Time. An Absolute event is always displayed in bold face in the list.

• The Follow event type plays the event immediately after the preceding event 
in the list. A Follow event is always displayed in regular face in the list.

• The Approx event type is queued but will not play unless you select the event 
from the list and then issue a Take command. An Approx event is always 
displayed in bold face in the list.

Date - Enter the date on which you wish the event to take place. Dates must be 
in the format used in your current Windows NT session, usually 
MM/DD/YYYY. The current date is entered by default.
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Settings Unique to Transfer Events

Transfer events add these settings (refer to “Scheduling a Transfer Event” on 
page 298): 

Source Media - The path name of the source media.

Source Profile - The name of the Profile unit where the media is stored.

Destination Media - The path name of the destination media.

Destination Profile - The name of the Profile unit to which the media is copied.

Settings Unique to Archive Events
2 Profile Family

Archive events have these added settings (see “Scheduling an Archive Event” 
on page 299): 

Media - The name of the media (clip) that is to be archived or restored.

Path - The name of the directory path for the media.

Action - Click either Archive or Restore.

Cartridge - Under Advanced. Enter the bar code number for the cartridge—
00000015, for example. This is an optional setting.

Partition - Under Advanced. Enter the partition number where the media is 
archived. This also is an optional setting.
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Monitoring a List as it Runs
Events you enter in the Monitor view are performed at their appointed times. 
The current house time is displayed at the top of the window. You can monitor 
the progress of events on each channel in the channel panels. Each panel shows:

Air Time - The timecode of the current frame of material.

Duration - The duration of the current material.

Time Till Next Event - This clock counts down the time until the next 
scheduled event.

The current event is highlighted in green for easy identification; a cued event is 
Profile Family

highlighted in yellow.

Validating a List
The On-air List is validated automatically every few minutes. You should 
manually check any other list to make sure that you haven’t scheduled 
conflicting events using the same Profile resources. To validate a list:

• Choose Validate List from the Options menu or from the shortcut menu 
with a right-click.

If a conflict arises, the word Error appears in the Status (left-most) column next 
to an invalid event. Three errors are at the root:

• The media does not exist. As a solution, bring in the correct media or verify 
that the name is correct.

• There is a conflict for a channel resource. For example, a channel resource 
would generate an error if it is scheduled for use at the same time by two or 
more events. To solve this problem, change the events so that they don’t 
attempt to use the resource at the same time.

• The media is not long enough, that is, the media is shorter than the duration 
of the event. To fix this, shorten the duration of the event to match the media.
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Scheduling a New Play Event
Another way to add events to a list is to open the New Play Event dialog box 
and enter the properties of the new event in the edit boxes.

1. Open the list to which you are adding the play event.

2. Choose File | New Event | Play to open the New Play Event dialog box as 
shown in Figure 138.

3. Fill in the edit boxes with the various event properties. If you select one of 
the repeat options, you’ll need to enter time and date settings.
4 Profile Family

4. Click OK to close the dialog box and enter the new play event in the list.

Figure 138. Creating a play event
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Scheduling Recording Operations
You can schedule recording operations to take place automatically at 
predetermined times. For example, you may want to record a satellite feed 
during off-hours. Scheduling a recording operation is just as simple as a 
playback.

1. Open the list to which you are adding the recording event.

2. Choose File | New Event | Record to open the New Record Event dialog box 
as shown in Figure 139
Profile Family

Figure 139. Creating a record event

3. In the New Record Event dialog box, enter all the event information as 
described in “Changing Event Settings” on page 289. The clip is stored in the 
default bin with the name you enter in the Clip Name box.

4. Click OK.
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Scheduling Rules and Constraints
Rule #1: Absolute events always start at the scheduled time.

• Of multiple absolute events inserted at the same time, the last inserted 
absolute event is the one that is scheduled.

• If an event’s end time overlaps an absolute event start time, that event is 
shortened so that the absolute event starts on time.

Rule #2: An approximate event always cues if it is the next event in the time 
line.
6 Profile Family

• A cued approximate event is de-cued 150 frames prior to the start time of an 
absolute event (see rule #1).

• Approximate events remain in the list during their aging process. The aging 
process allows approximate events to stay cued past their start time.

Allow at least fifteen seconds for a channel to switch between record and 
playback. The 15-second gap is used in the following manner: 5 seconds for 
queuing, 5 seconds for de-queuing, and 5 seconds to account for transition gap.

Allow at least 10 seconds between starting a recording on one channel and 
playing that clip on another channel. The 10-second delay allows the material 
to exist at least 5 seconds prior to queue time.

In the situations described here, use absolute events rather than approximate 
events, because the rules for approximate events allow them to exceed the 
constraints.
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Using a Live Feed
To further automate station operation, you can integrate live feeds into your 
lists. For example, you may want to broadcast a live event, inserting stored 
commercials at appropriate times. 

1. Open the list that you want to add a live event to.

2. Choose File| New Event | Switch and the New Switch Event dialog box 
appears, as shown in Figure 140.
Profile Family

Figure 140. New Switch Event dialog box

3. In the New Switch Event dialog box, enter all the event information as 
described in “Changing Event Settings” on page 289. This will set the cross-
point switch for the channel so that your video input is routed directly to the 
output. In a PDR100, audio inputs are not routed to audio outputs for switch 
events; however, they are routed to audio outputs in the PDR200 and 
PDR300. 

4. Click OK.
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Scheduling a Transfer Event
You can schedule transfer events in your lists. A transfer event schedules the 
copying of media from one Profile video disk recorder to another Profile unit 
on the network (requires Ethernet and Fibre Channel connections). Only one 
Transfer event may be scheduled at one time.

1. Open the list to which you wish to add the live event.

2. Choose File | New Event | Transfer and the New Transfer Event dialog box 
appears, as shown in Figure 141.
8 Profile Family

Figure 141. New Transfer Event dialog box

3. In the New Transfer Event dialog box, enter all the event information as 
described in “Changing Event Settings” on page 289. 

4. Click OK.
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Scheduling an Archive Event
You can schedule archive events in your lists. An archive event copies media 
to or from a Profile library system, such as the PLS200. The PLS200 must be 
attached to a Profile system running the Event Scheduler engine.

1. Open the list to which you wish to add the live event.

2. Choose File | New Event | Archive and the New Archive Event dialog box 
appears, as shown in Figure 142.
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Figure 142. New Transfer Event dialog box

3. In the New Archive Event dialog box, enter all the event information as 
described in “Changing Event Settings” on page 289. 

4. Click OK.
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Editing Event Lists
You can reorganize your event lists at any time. While you can change the 
settings for each event in a list, sometimes you’ll want to change the order of 
events, or add, replace, or delete events from the list. The following sections 
describe how to organize your lists to meet your needs.

Changing the Order of Events
You may want to change the order of events in your list. There are two ways to 
do this:
0 Profile Family

• If an event’s type is set to Absolute, you must:

- Change the Start Time of the event so that it starts at the desired time.

• If an event’s type is set to Follow, you can: 

- Select the event by clicking on the event in the left-most column of the 
window, then drag the event to its new position to the list. You can move 
several events by using the standard Windows operations to select a range 
of events (Shift-click to select a range or extend it), then drag the 
selection.

Inserting Events
To insert an event in a list from a Media Manager window:

1. Select a clip or master in the Media Manager contents pane.

2. Drag the material to the List Manager window. 

3. Drop the material in the list where you want to place the new event. The new 
material is dropped below the highlighted event.

To insert an event elsewhere in a list:

1. Select the event that you want to insert elsewhere.

2. Drag the desired event and drop it on the event. The event is placed below 
the selected event.
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Removing Events From a List
The On-air List grows as you add events. You may want to reduce the size of 
the On-air List by deleting events that have been performed and whose status is 
now Done. To remove unwanted events from a list:

1. Select the unwanted event. You can select several events by using the 
standard Windows operations to select more than one event (Ctrl-click to 
add an event to the selection, Shift-click to select a range of events).

2. Delete the event or events using Ctrl-X, or Edit | Cut, or the Delete key. You 
can also choose Delete from the shortcut menu with a right-click.
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3. Click Yes to confirm that you want to delete the event. 



Chapter 9 Using the List Manager

30

Using the Edit Window
You can use the Edit window to build lists in exactly the same way as you did 
in the Monitor view. The lists you build in the Edit window will not be 
scheduled until you choose the Edit | Schedule List command from the Edit 
menu.

The Edit window allows you to create and store lists that you want to reuse. By 
saving your lists, you can use them on a daily or weekly basis without having 
to rebuild the list each time. For example, you may want to use this for inserting 
commercials in network feeds.
2 Profile Family

Creating a New List
To create a new list:

1. Choose File | New and the New List dialog box appears.

Figure 143. New List dialog box

2. Enter a name for the list. Click OK to save the new list.

Saving a List
You must save a list to your system’s hard disk if you want to use it at a later 
date. To save the list:

1. Choose File | Save As.

2. Enter a different name for the list. Click OK to save the list.
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Reusing a List
There are two ways to reuse a list that you created earlier:

1. In the Edit window, choose File | Open and select the desired list. When the 
list opens, choose Edit | Schedule List to integrate the list into the On-air 
List. 

2. In the Monitor view, drag the list from a Media Manager window to the On-
air List. The dragged events are added to the bottom of the On-air List. Make 
sure you select the appropriate channel before dragging in the list, then 
change the Channel settings to match. 
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In either case, List Manager checks for conflicts with events already in the On-
air List. If it finds any conflicts, such as events using the same channel or output 
at the same time, it will report these errors so that you can take corrective action. 
The word Error will appear in the status cell of the event causing the conflict. 
Right-click on the event, choose Event Property (Alt-Enter), and read the error 
information in the Event Properties dialog box. You can also double-click the 
event to get properties. 

Closing a List
To close a list:

• Choose File | Close List.

Exporting a List
To export a list into an ASCII text file (.lst):

1. Click the Edit window tab.

2. Choose File | Export. A dialog box appears.

3. Enter the a name of the file you want to save in the File Name box. 

4. Click OK. The .lst extension is added to the file name automatically.
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List File ASCII Text Format

The file format for an ASCII text list file follows these rules:

• A line beginning with pound sign (#) is treated as a comment.

• Each event is saved on a single line in the text file.

• Individual fields of an event are separated by a comma (,).

• White spaces are allowed before and after field delimiters.

• Fields are case insensitive.
4 Profile Family

The format for each event is: Action, Clip Name, Start Time, Duration, Type, 
Start Date, Comment, other required fields depending on the action.

There are several other rules for list files saved as text:

• The first event in the list file has to be an absolute event, otherwise it is an 
error.

• A follow event will be on the line following the parent event in the list file.

• Each event can have only one follow event.

• Empty lines will be ignored while parsing.

• An error occurs if all the fields for a particular type of event are not present.

• If an error is detected in any event while parsing the list file, the event list 
will not be created for that file.

• The date field will be of the format mm/dd/yyyy.

• Time field (both start time and the duration) will be in the format 
Hour:Min:Sec:Frames or Hour:Min:Sec.Frames.

• Allowed event actions are: Play, Record, Switch, Archive or Transfer.

• For play and record events, the Clip Name, Start Time, Start Date, Duration, 
Comment will be saved in the list text file.

• For a switch event, Start Time, Start Date, Duration, Comment will be stored 
in the list text file.

• For Transfer event source Profile (Machine Name or IP address), destination 
Profile (Machine Name or IP address), source media and the destination 
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media will be stored in the text file.

• For Archive event Cart Label, Clip Name, Partition Number and the Option 
(Keep/Delete clip after archiving) will be saved.

Here is a sample list file in ASCII text format:

# Play event.

# The format is Action, Clip Name, Start Time, Duration, Type, 
# Start Date, Comment

Play, INT:/Default/River Rafting, 05:10:20:00, 00:01:30:00, 
Absolute, 02/02/1997, River Rafting
Profile Family

# Record event.

# The format is Action, Clip Name, Start Time, Duration, Type, 
# Start Date, Comment

Record, INT:/Default/Pepsi commercial, 05:10:20:00, 
00:01:30:00, Absolute, 02/02/1997, Commercial1

# Switch event.

# The format is Action, Start Time, Duration, Type, Start Date, 
# Comment

Switch, 05:10:20:00, 00:01:30:00 Absolute, 02/02/1997, Coke

# Archive event.

# The format is Action, Start Time, Duration, Type, Start Date, 
# Comment, Clip, Name, Cart Label, Path, Partition Number

Archive, 05:10:20:00, 00:01:30:00, Absolute, 02/02/1997, Ad1, 
Surf Soap, Label1, INT:/Default, 1

# Transfer event. 

# The format is Action, Start Time, Duration, Type, Start Date, 
# Source Profile, Destination Profile, Source Media,
# Destination Media, Comment

Transfer, 05:10:20:00, 00:01:30:00, Absolute, 02/02/1997, 
Profile1, Profile2, Soap, Surf Soap Ad, New Surf Ad
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Importing a List
You can import a list that has been previously exported to an ASCII text file 
(.lst). To import a file:

1. Click the Edit window tab.

2. Choose File | Import. An Open dialog box appears, displaying files of type 
.lst in the path c:\profile.

3. Select the name of the file you want to import. Double-click the file name or 
click OK.
6 Profile Family

Deleting an Entire List
To remove an entire list:

• Choose Edit | Delete List.
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Overriding Events in a List
Not every operation in your environment can be predicted to the second. In 
some instances, you’ll want to be able to interrupt an event as it’s playing, or 
stop a list completely. List Manager provides you with the tools you need to 
meet these challenges.

Taking an Event
As your list executes, you may want to manually choose a particular event and 
start playing it immediately. For example, you may have inserted a very long 
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Switch event to use a live feed, but you now want to run a commercial. List 
Manager lets you immediately use any event in your list.

1. Schedule your list normally.

2. Monitor the list by clicking the Monitor tab. Make sure you can see the 
channel that will execute the event you wish to take.

3. Highlight the event that you want to use immediately.

4. Click the Take button. The event begins five seconds later.

5. The list will continue running all the events which would normally be 
performed after the Take event. It will not return to the event that was 
interrupted, unless you highlight that event and use the Take button again.

NOTE: An Approx event type is not a scheduled event. You must take 
an event of type Approx to run it.

Stopping an Event
List Manager provides a way to stop a event at any time. You can use the Stop 
button to interrupt the event on the current channel. To stop an event:

1. Locate the event which is currently being executed (highlighted in green) 
and select the event.

2. Click the Stop button to stop the event.

3. After a few seconds, the event will stop and the video output will display 
black.
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Customizing Your List Display
You may find that the default list display does not meet your needs. For 
example, you may have long input names that are not visible because the Name 
column is not wide enough. If you never use List Manager to schedule Record 
events, you might not want to see the Source column at all.

You can change fonts, text color, and highlight color in a list display. To change 
a font:

1. Choose View | Font and the Font dialog box appears (Figure 144).
8 Profile Family

Figure 144. Font dialog box

2. Enter your changes. You can change the font, font style, font size, and color. 
You can also underline and strike out the text.

3. Click OK.

NOTE: Absolute events are always shown in bold face and Follow 
events are displayed in regular face.
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You can change the text color another way besides the Font dialog box, as well 
as the text highlight (background) color. The Color dialog box allows you a 
much broader range of colors than the Font dialog box. The change the text’s 
color or highlight color:

1. Choose View | Color | Text or View | Color | Highlight and the Color dialog 
box appears (Figure 145).
Profile Family

Figure 145. Color dialog box, with custom color controls shown

2. To select a preset color, click one of the basic 48 colors and then OK.

3. To create a custom color, move the cursor in the rainbow window until you 
find the color you want, then click Add to Custom Colors. The color is 
added to the array of custom color boxes.

4. To select a custom color, click on one of the custom color boxes that contains 
a custom color, then click OK.
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You can change which columns to display, the size of the columns and order of 
the columns in the list display. You display up to 10 columns in a list. By 
default, the Name, Start Time, Duration, and Comment columns are displayed. 
You can add columns for Action, Event Number, Parent Event, Type, and Date. 
You can also make a column as wide or as narrow as you want, or make it 
disappear completely. You can move one or several columns to the left or right 
to arrange them in an order that you find more convenient.

To add a column to a list display:

1. Choose View | Columns and Columns dialog box (Figure 146).
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Figure 146. Columns dialog box 

2. Click on a column label in the Available Columns box.

3. Click Add. The column label moves to the Displayed Columns box.

4. To change the order of the columns, click a column label in the Displayed 
Columns box, then click Move Up or Move Down.

5. To return the columns to their original settings, click Reset.

6. Click OK when done.
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To adjust the size of a column:

1. Position the mouse pointer over the right border of the column title of the 
column you wish to adjust. The pointer changes to a sizing shape.

2. Drag the border to the right to widen the column, to the left to make the 
column narrower. 

3. Drop the border at the desired column width.

4. Drag the right border completely to the left to reduce the column width to 
nothing, removing the column from the display. To make the column visible 
again, double-click on the border you dragged, then follow steps 1. and 2.. 
Profile Family

To change column order:

1. Select the column you wish to move by clicking on its title. You can select 
more than one column by clicking in one column title, then dragging the 
mouse pointer through the adjacent titles you wish to select.

2. Drag the selected column or columns to the desired destination.
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Using the Event Log
As events are performed in the On-air List, a record of those operations is kept 
in a file called c:\profile\evntsch.log. You can extract information from this log 
file for record-keeping, billing, or any other purpose where accurate records are 
required.

The information in the log file is stored as ASCII text in tabular form, separated 
by commas. You can use a text editor to read the file, but be careful not to save 
any changes you may make. You can see an example of a section of a log file 
in Figure 147.
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Figure 147. An example of a log file

The Scheduled Duration field shows the value entered in the On-air List. It does 
not show the actual duration of the event. The times shown in the Start Time 
and End Time fields are actual times which can be used to calculate the event 
duration.

The List Name field shows the name of the original list containing that event, 
which subsequently was Scheduled and became part of the On-air List

When the log file reaches about four megabytes in length, the information in 
the file is moved to a new file called evntsch1.log and kept as an archive. This 
ensures that evntsch.log always contains current information, but keeps its size 
manageable. Subsequent archived information will be stored in evntsch2.log, 
evntsch3.log, and so on.

Channel

Status

Event Type

Type Start Time End Time User Name Event Title

Date Scheduled Reserved List Name
Duration
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Using the Resource Manager 

The Resource Manager lets you assign system video, audio, and timecode 
resources and configure operational settings for one or more Profile channels. 

urces are used by the Tool Box Editor, List Manager, and Time 
These reso
Delay. 
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Figure 148. Resource Manager dialog box
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The channel resources that you can configure with Resource Manager include: 

• Video inputs and outputs 

• Video codecs (JPEG) 

• Video encoders and decoders (MPEG) 

• Audio inputs and outputs

• Timecode sources (inputs and outputs) 

• Timecode codecs 
4 Profile Family

Operational settings include: 

• Video quality (compression)

• Field dominance 

• Still play mode 

• Audio window size 

• Timecode generator settings 
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Configuring Resources
Before you can make use of a Profile application, you must allocate Profile 
resources such as video inputs and outputs for its use. These resources are 
assigned to channels for use by the application. Once the resources are 
allocated, they are unavailable for other applications. You must manage Profile 
resources to ensure that each application is able to use the required resources 
when it needs them.

To gain access to Resource Manager and configure Profile resources:

• In Tool Box Editor choose Config | Resources.
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• In List Manager choose Project | Configure.

• In TimeDelay choose Config | Resource Manager.

The Resource Manager is available when an application is running, unless 
media is loaded on a timeline.

Assigning Profile Channels
Your first step is to acquire one or more Profile channels. The single channel 
tab labeled Channel A is the default. You can change the name of the channel 
by entering a new name in the Name text box. Channel names can have up to 
32 characters, but a shorter name is recommended for readability.

Depending on your system, you can configure channels up to a limit set by the 
application; however, some systems only have two channels (ports). To add a 
channel, click the Add Channel button. To remove a channel, click the 
Remove Channel button. One channel is always visible.

A resource such as a video input is available when the checkbox next to its 
name is empty and its name is in dark print. If the resource is in use, its name 
is dimmed. If it is in conflict, that is, in use by another application or channel, 
its name appears in red. If it is requested, the checkbox next to its name is 
marked.
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Configuring Video Resources
To configure video resources:

1. Choose a video track in the configuration tree, such as Track 1 (MPEG). 

2. Choose an appropriate channel type: Player/Recorder, Player, or Recorder 
(see Figure 149). Depending on the channel type, different codec or 
encoder/decoder information is displayed below the configuration tree as 
listed in Table 17.

Table 17. Channel types 
6 Profile Family

Figure 149. Choosing a channel type

Channel Type MPEG JPEG

Player/Recorder Encoder and decoder 
resources 

Codec resource

Player Decoder resource only Codec resource 

Recorder Encoder resource only Codec resource 
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3. To add a video track, click the Add Track button and the Add Track dialog 
box appears (see Figure 150). Click Video, then select either JPEG or 
MPEG, depending on the type of track you want. Click Add when done. The 
new video track icon will appear in the configuration tree. 

NOTE: JPEG and MPEG tracks cannot be mixed. Therefore, before 
you can add an MPEG track, you must remove all JPEG video tracks, 
or before you can add a JPEG track, you must remove all MPEG 
tracks.
Profile Family

Figure 150. Add Track dialog box for video 

4. In the Video Quality list box, select a video quality if you want something 
other than the default (Medium). The higher the quality, the more disk space 
is used.

5. To make a custom quality setting, click the button next to the Video Quality 
list box, and the Custom Video Quality Settings dialog box appears. Select 
either Custom1 or Custom2 in the Video Quality list box. When selected, 
you can change the name of a custom setting. 

- For JPEG (see Figure 151 and Table 18), select a video quality with the 
slider. 

- For MPEG (see Figure 152 and Table 19), move the diamond on the grid 
to change the bit rate and group of pictures (GOP) settings, and click the 
button for the desired chrominance setting. The High, Medium, Low, and 
Draft buttons select the preset bit rates and GOP settings, which can be 
useful as reference points when you are making a custom setting. Click 
Undo to undo changes, and click OK when done.
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Figure 151. Custom Video Quality Settings dialog box, JPEG 

Table 18. JPEG Video Quality Settings

Quality Settings Compression in Mbps

Draft 12 

Low 24 

Medium (default) 36 

High 48 

Custom 1 or 2 6 - 54 in increments of 6 
(24 default)
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Figure 152. Custom Video Quality Settings dialog box, MPEG 

Table 19. MPEG Video Quality Settings 

Quality Settings Compression 
in Mbps

Chrominance GOP

Draft 4 4:2:0 IBBPBBPBBPBBPBBP (default)

Low 8 

Medium (default) 15 4:2:2

High 24

Custom 1 or 2 4-44 in 
increments of 4 
(12 default)

4:2:2 (default) 
or 4:2:0

Choose from I, IP, IBP, IBBP, IBPBP, 
IBBPBBP, IBPBPBPBP, 
IBBPBBPBBP, IBBPBBPBBPBBP, 
and IBBPBBPBBPBBPBBP(default)
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6. Click the Crosspoints button and then select a video input from the Video 
Input check boxes (see Figure 153 for MPEG or Figure 154 for JPEG). The 
names of video inputs are determined by the system configuration created 
with the Configuration Manager application (see Chapter 2, “Using the 
Profile Configuration Manager”). You can choose only one video input at a 
time per track. 

7. Click the Crosspoints button and then select video outputs from the Video 
Output(s) check boxes. The names of video outputs are determined by the 
system configuration created with the Configuration Manager application 
(see Chapter 2, “Using the Profile Configuration Manager”). You can choose 
one or more video outputs at a time. Each output corresponds to one of the 
0 Profile Family

video output connectors on the back of the Profile. Once allocated, other 
Profile channels cannot share assigned video outputs. 
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Figure 153. MPEG video track settings
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Figure 154. JPEG video track settings
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NOTE: Use of the Advanced panel as described in the following step 
is necessary only if you want to specify the exact codec resource to be 
used. By default the system will choose a codec resource for you 
based on availability. This default option is indicated by displaying 
“Any” for your codec selection.

8. Click the Advanced button and make encoder and decoder selections for 
MPEG (see Figure 155), or a codec selection for JPEG (see Figure 156). You 
can choose only one video encoder, decoder, or codec at a time.
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Figure 155. MPEG encoder and decoder check boxes 
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Figure 156. JPEG codec check boxes 
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Field and Frame Setup 

NOTE: You can select field dominance only for JPEG. MPEG is set 
by default to Field 1 dominance.

To set field dominance and still-play mode: 

1. Select the Video icon in the configuration tree; the field dominance and still-
play mode controls appear at the bottom of the Resource Manager dialog box 
(see Figure 157). 

2. Field dominance determines which field is the mark-in or mark-out point for 
Profile Family

the frame. The default is Field 1. To set it to Field 2, click the button.

3. Still-play mode determines whether your still frames are interlaced or line-
doubled. Line-Double is the default. With Interlaced, you may get some 
flicker in still display. Line double reduces flicker. Click the button you 
want.

The Field /Frame Setup button is always depressed because when the Video 
track type is selected, the Field Setup panel is the only panel available
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Figure 157. Field/Frame Setup controls



Configuring Audio Resources

327

Configuring Audio Resources 
Configuring audio resources for a channel involves adding one or more audio 
tracks to the channel, and selecting an audio input for each track. When you 
select the audio input for the track, the corresponding output is automatically 
selected. For instance, if you select AES/EBU-In1-J5 for your input, 
AES/EBU-Out1-J5 is automatically selected as the output. Likewise, if you 
select an output, the corresponding input is automatically selected.

To configure audio resources: 

1. Select the audio Track icon in the configuration tree. With the Crosspoints 
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button selected, the Audio Input and Output check boxes appear at the 
bottom of the Resource Manager dialog box (see Figure 158). 

Figure 158. Audio inputs and outputs 
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2. To add an audio track, click the Add Track button. In the Add Track dialog 
box that appears (see Figure 159), click Audio, then enter the number of 
tracks you want to add. Click Add when done. The new audio track icons 
will appear in the configuration tree. 
8 Profile Family

Figure 159. Add Track dialog box for audio 

3. For each audio track, choose an audio input or audio output by selecting a 
check box in the appropriate list.
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Audio Window Setup 

The audio window is a segment of audio that is heard when you move through 
a clip at higher-than-play speed. You can specify the size of the window, and 
thus the amount of the audio that you hear, by selecting a number of fields.

To set the audio window size:

1. Select the Audio icon in the configuration tree.

2. From the Audio Window Size box that appears, select a size from the three 
available choices: 5 fields, 10 fields (default), and 20 fields.
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Figure 160. Audio Window Size list box 
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Configuring Timecode Resources 
To configure timecode resources: 

1. Click on a Track icon under the Timecode icon in the configuration tree and, 
with the Crosspoints button clicked, the Timecode Input and Output check 
boxes appear at the bottom of the Resource Manager dialog box (see Figure 
161). 
0 Profile Family

Figure 161. Timecode Input and Output check boxes 
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2. To add a timecode track, click the Add Track button. In the Add Track 
dialog box that appears (see Figure 162), click Timecode, then click Add. 
The new timecode track icon will appear in the configuration tree. 
Profile Family

Figure 162. Add Track dialog box for timecode 

3. Select a timecode input under Timecode Input. You can record timecode 
from an internal generator, genlock VITC, LTC inputs, or a VITC input from 
a Profile video input. 

4. Select a timecode output under Timecode Output. The default timecode 
output is None. You can choose either a VITC output from a Profile video 
output or an LTC output. 

NOTE: VITC outputs appear in the Timecode Output list box only if 
the corresponding video outputs have been selected for the same 
channel. For example, “SDI-VITC-OutA-J6” appears in the 
Timecode Output list box for Channel A only if you’ve selected “SDI-
Out-J6” as a video output for Channel A. If you remove a video 
output for a channel, any request for the corresponding VITC output 
is also removed.



Chapter 10 Using the Resource Manager

33

Choosing Timecode Codecs

NOTE: Use of the Advanced panel as described in the following step 
is necessary only if you want to specify the exact codec resource to be 
used. By default the system chooses a codec resource for you based 
on availability. This default option is indicated by displaying “Any” 
for your codec selection.

To select a timecode codec: 

1. With a timecode Track selected in the configuration tree, click the Advanced 
button. The Timecode Codec check boxes appear (see Figure 163). 
2 Profile Family

2. Choose one of the eight timecode codecs or None.
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Figure 163. Timecode Codec check boxes 
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Timecode Generator Settings 

If you have selected “Internal Generator” as your timecode input, there are 
several other settings that you can make to the timecode generator. The controls 
for making these settings are available only when the timecode input is 
“Internal Generator,” and are dimmed for any other timecode input.

To change timecode generator settings: 

1. With a timecode Track selected in the configuration tree, click the TC 
Generator button. The timecode generator panel appears (see Figure 164). 
The controls are dimmed except when “Internal Generator” is the timecode 
4 Profile Family

input.

Figure 164. Timecode generator controls 
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2. Choose a generator mode. You can start timecode using a fixed time or the 
time of day. Click Time of Day to use the Windows NT clock, or click Fixed 
Time to set a timecode value under Starting Value.

3. If you selected fixed time, you can use the default of 00:00:00:00 
(Hours:Minutes:Seconds:Frames) under Starting Value or set a new fixed 
starting time. This setting takes effect the next time you click the Record 
button.

NOTE: The Drop Frame control is hidden if your Profile system is 
configured for PAL video. Refer to “Video Input” on page 52 for 
information about configuring the Profile system for PAL video.
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4. To choose drop frame, click on the Drop Frame check box. To compensate 
for the 29.97 frame rate in NTSC, drop-frame timecode synchronizes the rate 
with elapsed time. Drop-frame timecode drops two frames per minute, 
except on the tenth minute. PAL, on the other hand, has a constant rate of 25 
frames per second and never requires drop-frame timecode. 

Resolving Resource Conflicts
Resource conflicts occur when you attempt to allocate a resource that is already 
in use, either by the application you are working with, or by another application. 
To resolve a conflict, you must either request a resource that is available, or free 
the resource that you want from its other use. Resource Manager uses color 
coding to indicate the status of a resource. If a resource such as a video output 
is in use, its listing is dimmed, “grayed out.” If you request a resource that is in 
use, its listing turns red, indicating a conflict.

Resource Manager also uses Tool Tips to provide additional information about 
resources that are in use. When you hold the cursor for a short period of time 
over a resource that is in use (gray) or in conflict (red), a Tool Tip appears with 
status information about that resource. Tool Tips do not appear for resources 
that are available.



Chapter 10 Using the Resource Manager

33

When the resource is being used by another of the applications that use 
Resource Manager, the Tool Tip supplies the name of the application using the 
resource and the Profile unit (or PC) on which that application is running (see 
Figure 165).
6 Profile Family

Figure 165. Tool Tip showing an external user

When the resource is being used by the application in which you are currently 
working, the Tool Tip simply lists the channel that is using the resource as 
shown in Figure 166.

Figure 166. Tool Tip showing an internal user

When the resource is being used by an application that does not use Resource 
Manager, such as VDR Panel, the message in the Tool Tip says only “In use” 
as shown in Figure 167.

Figure 167. “In use” Tool Tip message
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Should the application that is using a resource shut down abnormally and 
release that resource while you have Resource Manager open, the listing for 
that resource remains gray indicating that it is “in use.” The Tool Tip displays 
“<Error>” as shown in Figure 168 after several seconds of delay. The delay is 
the result of Resource Manager timing out after looking for status information 
that is no longer available. If this message appears for a resource, close and re-
open Resource Manager. The error indication will disappear, and Resource 
Manager should correctly indicate the status of all resources.
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Figure 168. “<Error>” Tool Tip message
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Chapter 11
Using TimeDelay

TimeDelay is a Profile application that enables you to record incoming video, 
audio, or both, and to delay the playback for a specific period of time. While 

y can be used in combination with other applications like Media 
Tool Box Editor, VDR Panel, and others, it is primarily intended for 
 will dedicate all of a Profile system’s resources to one or more 
TimeDela
Manager, 
users who
39

instances of the TimeDelay application.
Profile Family 3

This chapter provides information about TimeDelay version 2.0, which is 
supported by Profile system software version 2.5 and higher.

In this chapter you find three major sections:

• Getting Started with TimeDelay — describes how to launch TimeDelay, 
describes the TimeDelay project file, and describes how to use Resource 
Manager to configure TimeDelay channels.

• Starting the TimeDelay Process — explains how to start the TimeDelay 
process either manually or automatically, and provides instructions for and 
details about the various settings you need to make.

• Using the Interface — this is a reference section that describes each of the 
controls in the Record and Playback panels and each of the menu items in the 
File, View, and Config menus. 
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Getting Started with TimeDelay
Here are two different methods that you can use to launch TimeDelay:

• Double click on the TimeDelay shortcut icon on the desktop. When the 
TimeDelay window appears, you can use the default settings that include one 
record and one playback panel (see Figure 169).

• Double click on a TimeDelay project file (.tdx). This launches TimeDelay 
using the configuration saved in the file.

NOTE: TimeDelay uses the standard Windows NT interface. For 
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help with Windows NT interaction, refer to Microsoft NT manuals.

To exit TimeDelay:

• Choose File | Quit.

Figure 169. TimeDelay window
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Working With the TimeDelay Project
A TimeDelay project includes the resource configuration for record and 
playback channels as well as application specific information like single or two 
column view, current timecode source, and information used for crash 
recovery. This project information is stored in a file that uses a “.tdx” file name 
extension.

When you start TimeDelay, a default TimeDelay project is created. Although it 
contains a record and playback channel, the default project is not usable until 
you assign video and audio inputs and outputs with Resource Manager.
Profile Family

Once you save a TimeDelay project, you can use the project file to start the 
TimeDelay application. Launching a project file directly starts TimeDelay with 
the saved project settings.

Saving a TimeDelay Project

To save a TimeDelay project:

1. Choose File | Save or File | Save As…

This opens a standard WindowsNT Save dialog. TimeDelay projects use the 
‘.tdx’ file name extension.

2. Chose a file name and file location for the TimeDelay project. This can be 
anywhere on the WindowsNT network.

3. Click the Save button.

Opening an Existing Project

To open an existing TimeDelay project, do one of the following:

• Double-click a TimeDelay project file in the WindowsNT desktop.

• With TimeDelay running, select File | Open…

This opens a standard WindowsNT “Open” dialog, which allows you to select 
an existing TimeDelay project file.
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Launching a Project at Start-up

To automatically launch a TimeDelay project at start-up:

1. Configure and save a TimeDelay project.

2. Add the name of the TimeDelay project file to the end of the pdrstart.bat file.

Pdrstart.bat is a start-up script that is installed with the Profile software. By 
adding the project name to the start-up file you ensure that TimeDelay will not 
attempt to run until all Profile services have been initialized at start-up.

Copying Project Files Between Machines
2 Profile Family

Once you create a TimeDelay project file, you can copy it to any number of 
machines (or open it remotely). There are several issues to consider:

• When you copy a project to and run it on a PC (rather than a Profile unit), the 
project still references the original machine name. No matter which PC 
launches the project, TimeDelay connects to the same machine. A better 
alternative is to use File | Import to import another project’s configuration 
information, then save the project again to create a project file that has a 
different machine name.

• When you copy a project to and run it on a Profile unit, the machine name 
stored in the project does not matter (TimeDelay always connects to the local 
machine). What should be considered is different machine capabilities.
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Connecting to a Remote Profile Unit
You can run TimeDelay on any PC that uses Windows NT 4.0 and connects to 
a remote Profile unit over an Ethernet local area network (LAN). When 
TimeDelay starts on the PC or when you choose File | Remote Connection…, 
the Remote Connection dialog box shown in Figure 170 appears.

NOTE: TimeDelay remote connection is allowed only when 
TimeDelay is running on a PC. Consequently, the “TimeDelay 
Remote Connection” dialog box does not appear when TimeDelay is 
launched on a Profile unit, and the File | Remote Connection… 
Profile Family

menu item is not available when TimeDelay is running on a Profile 
unit. 

To connect to a remote Profile unit:

1. Select one of the names in the Network Host List.

2. Click on Connect, or double-click on the name in the Network Host List. 

The Connection Status dialog box appears while TimeDelay establishes a 
connection with the selected Profile unit. If the connection cannot be 
established, an error message is displayed.

• Press Cancel to return to the Remote Connection dialog box.

Figure 170. The Remote Connection dialog box
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Changing the Remote Connection

To connect to a different machine:

1. Choose File | Remote Connection… to open the Remote Connection dialog 
box.

2. Select one of the names in the Network Host List.

3. Click on Connect, or double-click on the name in the Network Host List.

Changing the machine connection closes the current TimeDelay project. If you 
haven’t saved changes to the project, you are prompted to save before 
4 Profile Family

TimeDelay makes the new connection. When the new connection is 
established, the default project settings are used.

Adding Names to the Network Host List

To add a machine to the Network Host List:

1. Click the Add… button to open the “Add Network Host” dialog box.

Figure 171. The Add Network Host dialog box

2. Enter the new machine name. This can either be the host name, or the 
machine’s IP address (Ex. 128.181.199.237).

3. Click OK to close the Add Network Host dialog box and add the new host 
name to the Network Host List.

4. Click OK in the Remote Connection dialog box to close it and to open the 
connection status dialog box, which shows the progress of any new 
connections.
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Removing Names from the Network Host List

To remove a machine from the Network Host List:

1. In the Network Host List, click the name you wish to remove.

2. Click the Remove button.

Avoiding a Connection Change

When you save a project file, it includes the name of the machine to which 
TimeDelay is connected. When you launch the project file at a later time, 
TimeDelay attempts to connect to the same machine. By importing a project 
Profile Family

file rather than opening it, you can use the resource configuration from the 
project without its connection information.

To import a project file and avoid changing the connection:

1. Choose File | Import… to open the Import Project dialog box, a standard 
WindowsNT Open dialog box.

2. Select a project file.

3. Click the Open button.

Unlike the Open operation, importing a project file does not change the current 
machine connection.
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Configuring Channels with Resource Manager
The Resource Manager is used for creating and configuring all TimeDelay 
channels. In TimeDelay, the first channel (labeled “Recorder” in Figure 172) is 
always the record channel, and all other channels are playback channels. You 
cannot remove the first two channels because TimeDelay always requires a 
record channel and at least one playback channel. You can have as many as 6 
playback channels.

For more detailed information about using Resource Manager, refer to “Using 
the Resource Manager” on page 313.
6 Profile Family

Adding a Playback Channel

To add a playback channel:

1. Choose Config | Resource Manager… to open Resource Manager.

2. Click the Add Channel button. This creates a new channel tab in the 
Resource Manager dialog box.

3. Configure the new channel as necessary. Instructions for using Resource 
Manager are in “Using the Resource Manager” on page 313.

4. Click the OK button.

When you close the Resource Manager dialog box, a new playback panel is 
displayed in the TimeDelay window.

Deleting a Playback Channel

To remove a playback channel:

1. Choose Config | Resource Manager… to open Resource Manager.

2. Click on the channel tab that you want to remove.

3. Click the Remove Channel button to delete the selected channel tab.

4. Click the OK button.

When you close the Resource Manager dialog box, the panel that corresponded 
to the removed channel is no longer displayed in the TimeDelay window.
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Because TimeDelay always needs a record channel and at least one playback 
channel, Resource Manager will not let you delete the record channel or the last 
playback channel.
Profile Family

Figure 172. The Resource Manager dialog box
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Changing a Panel’s Name

To change a panel’s name, 

1. Select Config | Resource Manager from the TimeDelay menu. 

2. Select the tab name that needs to be changed. 

3. In the Name edit box, type a the new name. Names may be up to 32 
characters long and may consist of any alphanumeric characters. Channel 
names should be, but are not required to be unique.

4. Click the OK button.
8 Profile Family

When you close the Resource Manager dialog box, the panel corresponding to 
the renamed channel displays the new name in the TimeDelay window. This 
name is saved with other resource information in the TimeDelay project file.

Modifying a Channel’s Configuration

While the details of resource configuration are generally covered in “Using the 
Resource Manager” on page 313, TimeDelay imposes some unique restrictions 
when using Resource Manager to configure channels. These unique restrictions 
are described here.

• Since playback channels share source material with the record channel, they 
must have similar configurations. They should have the same number of 
video, audio, and timecode tracks, and must have the same video 
compression format. You cannot mix MPEG and JPEG resources in the 
same TimeDelay project. 

• Record and playback channels should always have at least one timecode 
track.

• The record channel should always use a valid timecode input. This input may 
come from an external VITC or LTC source, or may simply be a Profile 
timecode generator. Timecode display and the Auto Start feature are affected 
if the connected VITC or LTC source does not provide valid timecode.

• When configuring playback channels (which only play material), you do not 
need to select input resources for video, audio, and timecode tracks.
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Handling Resource Allocation Errors

Resource conflicts can occur when another application is running on the same 
Profile unit as TimeDelay. TimeDelay channels might conflict with each other 
if the same output is used on more than one channel. When there is a resource 
conflict and all TimeDelay resources cannot be allocated, the warning dialog 
box shown in Figure 173 will appear.
Profile Family

Figure 173. Warning dialog box

Click the Yes button to return to the Resource Manager dialog and resolve 
conflicts. If you click No and do not resolve the resource conflicts, TimeDelay 
cannot function correctly.
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Starting the TimeDelay Process
The basic time delay process involves recording program material and playing 
it back after a specified time has elapsed. You accomplish this using the Record 
and Playback panels in the TimeDelay window. In each of the procedures that 
follow, it is assumed that you have already connected (if necessary) to a Profile 
unit if you are operating remotely, and that you have allocated the necessary 
resources with Resource Manager. 

Manually Starting the TimeDelay Process
0 Profile Family

To start a recording with delayed playback:

1. In the Buffer Size edit box, enter a record buffer size or accept the default. 
See “Setting the Record Buffer Size” on page 352.

2. In the Playout Delay edit box, enter a playout delay. Repeat this action for 
each Playback Panel. See “Setting a Playout Delay” on page 354.

3. On the Record Panel, click the Record button.

To stop the TimeDelay process click the All Stop button on the Record Panel.
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Automatically Starting the TimeDelay Process
When you select an external VITC or LTC signal as TimeDelay’s timecode 
source, you can start the TimeDelay process automatically when a specific 
timecode value is reached. This feature allows you to synchronize multiple 
Profiles that are using the same external timecode source.

To automatically begin recording at a set timecode:

1. Choose Config | Timecode Source…

2. Select an external timecode source.
Profile Family

3. In the Record Panel, click the Auto Start button, or choose 
Config | AutoStart. The Auto Start… dialog box appears (see Figure 174).

4. Click the Auto Start check-box.

5. Enter the desired start time in the Start Time field. This time should be at 
least 10 seconds ahead of the current time.

6. Click the Close button.

When you activate auto start, a countdown is shown on the record panel. When 
the countdown gets to 00:00:00:00, recording begins.

Figure 174. The Auto Start dialog box
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Working with the Record Buffer
The record buffer is a quantity of storage space allocated for recording. The size 
of the buffer determines how much video can be stored before recording returns 
to the beginning of the buffer, and limits the length of delay that you can set. 
You can select a different drive to be the record buffer’s location. and you can 
save the contents of the buffer as a clip.

Setting the Record Buffer Size

To set the record buffer size, enter the buffer duration in the Record Panel’s 
Buffer Size edit box.
2 Profile Family

The record buffer must be at least 5 seconds longer than your longest playout 
delay. The minimum buffer size is 10 seconds; the maximum buffer size is the 
recording capacity of the current record buffer volume. By default, the 
maximum buffer size is shown when TimeDelay is started.

If you enter a buffer size that is greater than the amount of available storage, 
TimeDelay automatically reduces the value to reflect the largest possible 
duration. If you enter a buffer size that is smaller than the longest playout delay, 
TimeDelay automatically increases the value to reflect the smallest buffer size 
that can encompass the longest playout delay. 

Changing the Record Buffer’s Location

By default, the TimeDelay Record buffer is created on the first internal disk 
volume. To change the record buffer’s location to a different drive:

1. Choose File | Set Buffer Drive… to open the dialog box shown here:

Figure 175. TimeDelay Buffer Location dialog box

2. Select the appropriate drive.

3. Click the OK button.



Working with the Record Buffer

353

Saving the Record Buffer’ Contents as a Profile Movie

Each time the TimeDelay process is started, the disk storage used by the record 
buffer is deleted. The Save Buffer operation allows you to save the contents of 
the record buffer before closing or restarting the TimeDelay process.

To save the record buffer contents as a Profile movie, do the following:

1. On the File menu, click Save Buffer As… This opens the dialog shown 
below:
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2. Enter a name for the movie.

This movie name must be unique. When the dialog is opened, a unique 
default name is suggested. If you change the name and it is not unique, you 
will be prompted to enter a new name or cancel the save operation.

3. Use the Save in: combo box to choose a bin for the movie.

4. Click the OK button.

Saving a large record buffer as a movie will reduce the amount of available disk 
storage. This may effect the TimeDelay application’s ability to function.
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Working with the Playback Panel
The Playback Panel allows you to control the playout delay for the playback 
channel that it represents. 

Setting a Playout Delay

To set a playout delay, enter the delay duration in the Playback Panel’s Playout 
Delay edit box.

The minimum playout delay is five seconds; the maximum delay is five seconds 
less than the current record buffer size. TimeDelay automatically adjusts 
4 Profile Family

playout delays that are too large or too small to the closest valid value. 

Starting a Playback Channel Immediately

To immediately start a playback channel:

1. Start the TimeDelay process.

2. In the appropriate playback panel, click the Play button.

Starting playback with the Play button overrides the delay time. Once the 
channel begins playing, the delay time is automatically adjusted to reflect the 
difference between the record and play positions.
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Modifying a Playout Delay

To modify a playout delay after the TimeDelay process has started:

1. In the Playback Panel, click the Stop button. The playback channel stops and 
shows black.

2. In the Playout Delay edit box, enter the new delay value.

3. Click the Play button The playback channel restarts immediately with the 
new delay.

Pausing Playback
Profile Family

To pause playback, click the Pause button in the Playback Panel for the 
channel that you wish to pause. The playback channel’s output pauses.

As the time difference between the record position and the paused playback 
position increases, the playout delay value also increases until it exceeds the 
maximum playout delay, automatically stopping the channel.

To resume playback after a pause, click either the Pause button or the Play 
button in the paused Playback Panel.
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Working with Timecode
When TimeDelay channels are configured, one our more timecode tracks can 
be connected to timecode sources including external VITC and LTC signals, or 
an internal timecode generator. 

As with all TimeDelay channel resources, the number of timecode tracks in 
each playback channel should match the number of timecode tracks in the 
record channel.

Since TimeDelay panels have a single timecode display, they can only display 
timecode from a single source at a time. The Select Timecode Source… dialog 
6 Profile Family

box shown in Figure 176 allows you to select from multiple timecode sources.

 

Figure 176. The Select Timecode Source… dialog box

To select a timecode source:

1. Choose Config | Timecode Source… to open the Select Timecode 
Source… dialog box.

2. Select the name of the appropriate timecode source from the Timecode 
Sources list, which is drawn from the record channel’s timecode sources. 
The Buffer Position item allows you to show the record/play position 
relative to the beginning of the record buffer.

3. Click the Select button.



Crash Recovery

357

Crash Recovery
The Crash Recovery option adds recovery features that will restore TimeDelay 
to the state in which it ended. When you activate Crash Recovery, Time Delay 
periodically saves the project file. This allows you to add the project file to the 
pdrstart.bat file and fully recover from a crash when the Profile unit restarts. If 
TimeDelay is closed or crashes while recording, it will come up recording when 
started again; TimeDelay starts recording at the first break in the timecode and 
resets the playbacks to their original settings.

Choose Config | Crash Recovery to activate the crash recovery functionality. 
A check mark next to the menu item indicates that crash recovery is activated. 
Profile Family

If you have not saved the project file prior to activating Crash Recovery, the 
Save As dialog box appears, prompting you to save the project file.

To ensure that TimeDelay restarts in case of a crash, add the project file name 
to the pdrstart.bat file as described in “Launching a Project at Start-up” on page 
342.
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Setting Audio Levels
The audio meters in the Record Panel include sliders that allow you to control 
the audio level as you record. Click and drag the audio level controls to the 
desired record level for each audio track. Similar controls in the Player panel 
allow you to control the playback level of the audio.
8 Profile Family

Figure 177. The audio level controls

Record level sliders

Playback level sliders

Show/Hide
Meters button

Show/Hide
Meters button
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Using the Interface
This is a reference section that contains descriptions of the operating controls 
and menus found in the TimeDelay window. It is divided into three sections: 
the Record Panel, the Playback panel, and the Menus

The Record Panel
The following is an overview of the record panel controls:

Panel Name Displays the record channel name. The default record 
channel name is “Recorder.” You can change the 
Profile Family

channel name using the Resource Manager, but in 
Resource Manager the first tab is always the record 
channel. The record panel might shorten long channel 
names to fit in the display. 

Buffer Size This edit box displays in timecode format the duration 
of the record buffer (the length of material recorded 
before the buffer fills and starts recording at the 
beginning of the buffer). This control allows you to set 
the duration of the TimeDelay buffer. The minimum 
buffer size is 10 seconds. The maximum buffer size is 
the recording capacity of the current record buffer 
volume. By default, the maximum buffer size is shown 
when TimeDelay is started.

Timecode Display Displays the current timecode source value. Timecode 
sources include external VITC and LTC signals, 
internal timecode generators, the VITC in the house 
reference, or simply the offset in the record buffer. The 
timecode source is chosen in Resource Manager.

Record Button Starts the TimeDelay process. When you click this 
button the record panel starts recording and the 
playback panels start their delays.

Auto Start Button Opens the Auto Start dialog box. Auto start allows you 
to trigger the TimeDelay process using the current 
timecode source. This button is enabled only when the 
current timecode source is a VITC or LTC signal.
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Countdown Display Shows the amount of time before the record panel 
automatically starts. The Countdown Display appears 
only when the Auto Start mode is active.

All Stop Button Stops the TimeDelay process. If the playback has not 
started yet, the delayed start is canceled.

Video/Audio Status LightsThe number of status lights indicates the number of 
video and audio tracks in the record channel. A Video 
status light turns red when the corresponding video 
track is not receiving a signal. An audio status light 
turns red when the audio input signal peaks and is 
0 Profile Family

clipped.

Show/Hide Meters ButtonExpands the panel to show video and audio meters.

Video/Audio Meters The video meter shows the record channel’s data rate 
relative to the maximum rate. Audio meters show the 
audio input level in dB.

The Playback Panel
Though TimeDelay may have multiple playback panels, each has its own set of 
the following controls:

Panel Name Displays the playback channel name. Default 
playback channel names are “Player 1”, “Player 2”, 
etc. You may change the channel name using the 
Resource Manager. The playback panel may shorten 
long channel names so they fit in the display.

Playout Delay This edit box shows the amount of time the playback 
panel waits before playing. The minimum playout 
delay is 5 seconds. The maximum delay is 5 seconds 
less than the current record buffer size. The default 
playout delay is 5 seconds.

Timecode Display Shows the current timecode source value (relative to 
the position of the playback channel). Timecode 
sources include external VITC and LTC signals, 
internal timecode generators, the VITC in the house 
reference, or simply the offset in the record buffer.
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Play Button Starts the playback channel immediately, overriding 
the current playout delay and updating the playout 
delay control.

Stop Button Stops the playback channel; when playback stops, the 
output channel shows black. Press the stop button to 
modify the playout delay after the TimeDelay process 
has started. 

Pause Button Pauses the playback output. The playout delay 
increases as long as the playback channel is paused. 
Press pause again or press play to resume playback.
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Video/Audio Status Lights The number of status lights indicates the number of 
video and audio tracks in the record channel. A Video 
status light turns red when the corresponding video track 
is not receiving a signal. An audio status lights turn red 
when the audio input signal peaks and has to be clipped.

Show/Hide Meters Button Expands the panel to show video and audio meters.

Video/Audio Meters The video meter shows the record channel’s data rate 
relative to the maximum rate. Audio meters show the 
audio input level in dB.

Menus
TimeDelay menus include the following:

File

Remote Connection… Connect to a remote Profile unit.

Import Imports the resource settings from an 
existing TimeDelay project, but keeps the 
current machine connection.

Open… Opens an existing TimeDelay project file 
previously saved by TimeDelay with a .tdx 
file extension.
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Save Saves the TimeDelay project file. All TimeDelay project files 
receive a .tdx file extension. If the project file has not been saved 
before, Save works like Save As…

Save As… Saves the currently open TimeDelay project file with a new file 
name.

Set Drive…  Selects a different disk volume for the record buffer.

Save Buffer As… Save the record buffer as a PDR movie.

Exit Closes TimeDelay.
2 Profile Family

View

Single Column Displays all the playback panels below the 
record panel in a single column. When the 
column becomes too large for the screen, 
scroll bars appear to allow access to hidden panels.

Two Columns Displays the record and play panels in two columns as shown in 
Figure 178.

Figure 178. Two-column display
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Config

Resource Manager… Opens the Resource Manager 
dialog box for allocation of video, 
audio, and timecode resources, and for 
adding, naming, and removing 
channels.

Timecode Source… Opens the timecode display selection dialog box. If the 
record channel has more than one timecode track, this allows 
you to select the one for display in the record and playback 
panels.
Profile Family

Auto Start… Opens the auto-start setup dialog box.

Crash Recovery…Turns on “auto-restore mode.”
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Access Time
The time it takes to find and retrieve digital information, generally from hard 
disk storage.

AES/EBU
Acronym for Audio Engineering Society/European Broadcasting Union, an 
industry standard for the transmission of serial digital audio information. The 

ecifies the physical attributes of the link, as well as how the 
 is transmitted along it.
standard sp
information
65

A to D
Profile Family 3

Analog-to-digital converter. An electronic component that converts 
incoming analog signals into its digital representation.

Analog video
Video represented as a continuously variable electrical signal. Consumer TV 
and domestic VCRs are analog video devices. Analog video can be converted 
to digital format to be stored and manipulated by computer or other digital 
devices.

Archive library
The archive library is an automated tape storage device used to supplement a 
machine’s disk storage. The library consists of digital tape cartridges and, in 
some cases, robot that moves cartridges to and from tape transports.

ASPB
Audio signal processing board. An audio board on the PDR200 that provides 
16 channels of analog, embedded digital, and AES/EBU digital audio. You 
can install up to two ASPBs in a PDR200 for 32 channels of audio. 

Assemble record mode
Video and all audio tracks assigned to a machine are recorded 
simultaneously, along with timecode, and any previous contents are 
overwritten. Traditionally this mode is used when appending to a master tape 
that has not had black, timecode, and control track previously recorded 
before editing.
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Audio I/O
The audio path through the Profile video disk recorder, especially the 
crosspoint circuitry that routes the audio within the Profile system.

Auto Start
A feature that lets you enter a timecode and have the record buffer start 
recording at that timecode.

Bit rate 
The rate at which video streams in megabits per second (Mb/sec). The bit 
6 Profile Family

rate is a reflection of quality—the higher the bit rate, the higher the quality 
of video. However, video data stored at a high bit rate consumes more disk 
storage space than data stored at a lower rate. Bit rates can be as low as 6 
Mb/sec and as high as 54 Mb/sec. The default video quality bit rate is 24 
Mb/sec, which is broadcast quality. 

BNC
Connector used in professional A/V components. The BNC connection 
provides optimum shielding between the video input signal lines to provide 
the best possible performance. BNC was recently adopted as an alternate 
AES signal connector.

B Picture
A B picture is a bidirectionally predictive picture used in MPEG video 
compression. MPEG uses motion prediction to increase efficiency, that is, it 
reduces data by not duplicating pixels that do not change from frame to 
frame. A B picture relies on data from both forward and backward motion 
vectors to determine how a future frame will be composed. See GOP,
I-frame, P Picture. 

Button (on the display)
A small display box that has a raised appearance and contains text. 
Generally, clicking on a button activates a function or performs some action. 
See Clicking.

Button (on the mouse)
The two or three buttons on the top of the mouse.
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Capture
Generally, the act of storing digital audio and video in memory or on a disk. 
The process may involve converting an analog signal to a digital one. Some 
compression of the digital data may be involved.

Cartridge tape
A tape used in the library that stores video and audio in digital form.

CD-ROM
Compact Disc-Read-Only Memory, the preferred medium for multimedia 
Profile Family

storage because of its large capacity, high quality, ease of use, and low cost.

Channel
A collection of video, audio, and timecode resources used for either playing 
or recording.

Chroma
A term that describes the saturation or vividness of a color. A chroma of 0 
describes a neutral, gray color. Chroma ranges to the most vivid color a 
screen or printer generates for a specific hue and value. See Hue.

Cleaning cartridge
A special tape cartridge that cleans tape transports on demand.

Clicking
Quickly pressing and releasing the left mouse button (usually) without 
moving the pointer.

Clip
A clip is a reference to recorded video or audio tracks from a single source, 
and may include timecode. If a clip includes both video and audio, they must 
be synchronous. A reference to several clips edited together is called a 
master. Deleting a clip will delete its associated material only if that material 
is not used by another clip or master. 

Clip position 
Clip position refers to the current location in a clip, denoted by timecode. 
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CODEC
CODEC is an acronym for Coder/Decoder, the link between JPEG 
component parallel digital video and the SCSI-2 channel. The CODEC 
compresses the video data to a rate that is commensurate with the available 
disk bandwidth. Conversely, the CODEC decompresses the video data 
coming from the SCSI-2 channel back to 8-bit component parallel digital 
video.

The Profile video disk recorder translates digital video data between CCIR 
601 digital component and compressed motion JPEG for storage on hard 
disk.
8 Profile Family

Command line
The line that you type to invoke a program or initiate an action. A command 
line usually contains the application program name, along with optional 
arguments known as command-line options.

Composite video
A single video signal composed of combined luminance and chrominance 
information.

Component video
Typically the transmission or storage of video as a separate luminance and 
chrominance information, such as Y, B–Y, R–Y.

Compression, video
A technique for reducing the amount of space needed to store images or 
sequences of images. JPEG, Motion-JPEG (M-JPEG) and MPEG are 
examples of video compression techniques.

Data cartridge
A digital tape cartridge that is capable of storing media in large quantities.

dB
Decibel. In theory, the minimum change in sound intensity that the human 
ear can distinguish; also, a relative unit used to compare the strength of 
acoustic signals.
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Default
A value that is automatically assigned or used in the absence of any other 
input. For example, a new Profile system shipped from the factory is zero-
timed by default while E to E mode is the nondefault setting.

Dialog box
A box displayed in a computer application’s graphical user interface where 
you choose options and enter information. Use the mouse or keyboard to 
move from field to field, click on buttons and position the text insertion 
point. Enter information with the keyboard.
Profile Family

Digital
In digital audio/video systems, sounds and images are converted into a series 
of binary values (ones and zeros).

D to A
Digital-to-analog converter. A device used to convert digital signals into an 
analog form. For example, compact disc players use D to A convertors to 
convert the digital information on the CD into analog audio suitable for 
amplification.

Disk expansion unit
A product (PDX103 and PDX208) that adds disk storage to a Profile video 
disk recorder.

Disk Utility
The Profile Disk Utility tool is used to maintain Profile hard drives. This 
includes formatting and labeling disk volumes, eliminating bad blocks, and 
updating hard drives with new microcode.

Display
A device that receives video output from a display adapter such as VGA card 
and displays the video output on a screen.

Dragging
Pressing and holding down the left mouse button while moving the pointer. 
The mouse pointer must be over an object such as a file.
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Drop-frame
In NTSC, you don’t actually get 30 frames per second; the real number is 
about 29.97 fps. Timecode usually assumes 30 fps. To account for the 
discrepancy, drop-frame timecode skips or drops two timecode values at the 
beginning of every minute except every tenth minute. This allows timecode 
to exactly match a real-time clock on 525/60 systems. This correction is not 
needed on 625/50 systems because the frame rate is exactly 50 fps.

E to E (EE)
Electronics to Electronics mode routes audio and video input directly to 
output.
0 Profile Family

Edit
The process of creating or refining a sequence of media (clips) in a specific 
order.

EDL
An Edit Decision List is a list of events that include the source to be 
recorded, and where to record it. In addition, an EDL can include 
information about transitions (cuts, dissolves, wipes), transition durations, 
effects, etc.

Factory default
The value assigned to a parameter as delivered from the factory. See Default.

Field
A part of the total number of lines that represent a video image, scanned in 
two passes. For example, an NTSC 525-line frame is divided into 262.5-line 
fields. See Frame.

Firmware
Software instructions that are permanently stored in the memory of a 
computer and are not lost when you turn the power off.

fps
The abbreviation for frames per second, the standard way of measuring the 
speed of video playback. Thirty fps is considered real-time playback in 
NTSC, 25 fps in PAL. 24 fps is standard for film and is considered animation 
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speed playback. In the range of 12 to 15 fps, the human eye can detect the 
difference between one frame and the next; visually this appears as a jerky 
motion, or flicker.

Frame
The standard unit of measure for film and video. One frame represents one 
complete still image, divided into two fields.

Frequency response
The frequency range which an electronic component can accurately 
reproduce. Humans (some) can hear from 20 Hz to 20,000 Hz (20 KHz). An 
Profile Family

ideal audio component would have a frequency response, totally flat and 
without any deviation, from 20 Hz to 20 KHz. Frequency response 
specifications are measured in decibels (dB), based on how closely an 
output’s response resembles that of the input.

Genlock
This term defines the relationship between video paths. Two video signals 
that are exactly synchronized are said to be genlocked.

GUI
A Graphical User Interface (GUI) provides a visual way to interact with 
computer software. GUIs allow people to control an application by using a 
pointing device such as a mouse to perform operations. The usual alternative 
to a GUI is a command-line interface, which requires people to type in 
application-specific commands following precise rules of syntax. GUIs are 
considered easier to use than command-line interfaces.

Group
In audio terms, this provides the ability to group tracks to perform functions 
across several tracks at the same time, such as gain, mute, etc. 

GOP
A Group of Pictures (GOP) is part of the video compression scheme used by 
MPEG. MPEG uses motion prediction to increase efficiency, that is, it 
reduces data by not duplicating pixels that do not change from frame to 
frame. It does so by relying on a GOP. A GOP is composed of I-frames, B 
pictures, and P pictures. See B Picture, I-frame, P Picture. 
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Hard disk
Computer systems use hard disks as permanent storage devices. Information 
is magnetically recorded on spinning platters for quick access.

Hardware
The physical parts of a system, such as a computer, display monitor, or 
keyboard.

Help
Profile software applications come with on-line help manuals that include 
2 Profile Family

examples, demonstrations, and reference information about using the 
application. The manual, and the Help window it is displayed in, follow the 
Microsoft standard.

Hertz (Hz)
Hertz is the unit of frequency named after the physicist Heinrich Hertz 
(1857–1894). One hertz (Hz) is equal to 1 cycle/second.

Hue
A term that describes a color family (for example, red or yellow). Hue is a 
polar coordinate—that is, it moves in a circular motion around the color 
spectrum—and ranges from 0 to 360, with 0 being red. Hue is measured in 
degrees. See Chroma.

I-frame
MPEG uses motion prediction to increase efficiency, that is, it reduces data 
by not duplicating pixels that do not change from frame to frame. It does so 
by relying on a GOP. A GOP is composed of I-frames, B pictures, and P 
pictures. An I-frame (or I picture) is analogous to a JPEG frame in that it is 
a self-contained picture. It does not use motion vectors as do the B picture 
and P picture. See B Picture, P Picture. 

Input device
A device that allows you to send information to a software application. 
Typical input devices include keyboards, mice, tablets, and trackballs. See 
Pointer and Pointing Device.
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Insert record mode
In insert record mode, audio and video material can be recorded 
independently. New material can replace existing material anywhere in the 
program. Insert record mode requires timecode on the destination.

Interface
A common connection that is used for sending or accepting information and 
control between programs and machines.

Keyboard
Profile Family

An alphanumeric input device that allows communication with software 
applications.

Library system
The Profile Library System (PLS200) is a robotic tape library that provides 
affordable mass storage for the Profile video disk recorder.

LTC
Longitudinal Time Code is typically an analog audio track or a dedicated 
address channel on a tape. LTC can’t be read in still mode, and may not be 
reliable during low-speed shuttle operations.

Media files
Audio, video, and timecode sources that have been captured by the Profile 
disk recorder are considered media. Media is stored on disk as media files. 
Audio and video clips do not contain media, but instead reference positions 
in a media file.

Memory
A component of a computer system used for virtually instantaneous 
temporary storage and retrieval of information (data) or instructions 
(programs). Information in memory is volatile, and is lost when the 
computer is shut down. Storing information on a permanent storage device 
such as a hard disk or a tape allows for retrieval during another work session.

Menu
A list of commands or functions that you select with a pointer. A menu is 
normally displayed in a small window.
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Monitor
Two-channel audio output of selected machine tracks. Generally, audio 
systems or video displays used in a studio environment to control quality. 
Also, a video display device, without audio capabilities.

Mouse
An input device that, when moved across a flat surface, causes the pointer to 
move across a screen. The mouse usually has buttons that you press to send 
signals. These signals, in turn, accomplish certain functions. The 
representation of the mouse on the screen is called the pointer. See Pointer.
4 Profile Family

MPEG
MPEG (Moving Picture Experts Group) is a set of standards used for 
compressing digital video and audio. MPEG uses compression methods that 
maintain high quality while requiring smaller bandwidths to transport video 
and audio streams. 

NTSC
The standard composite color format used in North America and Japan that 
was developed by the National Television Standards Committee.

Off-line cartridge
The archive library has immediate access of up to 80 cartridges. However the 
library database can contain information about any number of cartridges. A 
cartridge is considered off-line when it has been ejected from the library 
storage device, but remains in the library database.

PAL
The Phase Alternate Line standard is used to encode color information in 
Western European composite video.

Panel (TimeDelay)
The graphical representation of a channel. The record panel shows controls 
for the record channel. A player panel shows controls for a play channel.
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Partitions
To give the archive tape transports some degree of random access, a data 
cartridge is divided into an number of partitions. Media may be added to a 
partition until that partition is full. Deleting media from one partition does 
not affect any other partition.

Parameter
A variable that is given a specific value. This value is passed to a program 
before execution.

Pixel
Profile Family

The smallest part of a display memory that can be addressed.

Playback
Playback is the act of playing a clip, track or master loaded on a machine at 
any rate.

Playback delay
The amount of time that the playback channel is behind the record channel.

Pointer
The pointer allows you to make selections in menus, to size and position 
windows and icons, and to select the window where you want to send the 
input. The window manager, such as Windows NT, determines the shape of 
the pointer. See Pointing Device.

Pointing device
Typically a mouse, tablet, or some other device with effective dimensional 
motion. See Pointer.

Port
A physical connection (such as a multi-pin connector or coaxial connector) 
and its associated firmware, that permits one computing device to 
communicate data and control information with another computing or 
peripheral device.
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P Picture
A P picture is a predictive picture used in MPEG video compression. MPEG 
uses motion prediction to increase efficiency, that is, it reduces data by not 
duplicating pixels that do not change from frame to frame. A P picture relies 
on data from forward-moving motion vectors to determine how a future 
frame will be composed. See B Picture, GOP, I-frame. 

Protocol
A set of rules that allows computers to transfer information across a network 
to other computers.
6 Profile Family

Read-only memory (ROM)
Memory that is not erased when power is turned off. It is also called 
firmware. The firmware in a computing device allows it to boot without 
being connected to a host computer.

Real-time
Generally considered to be 30 fps in NTSC, 25 fps in PAL, 24 fps for film. 
In computer terms, processing information as it becomes available, rather 
than storing for processing at a later time.

Record Buffer
Determines the length of the Time Delay clip that the record buffer loop 
records on.

Resource
A resource is a Profile input, JPEG codec, or output. You allocate resources 
for exclusive use by any application, such as Tool Box Editor, List Manager, 
and VDRPanel. You should free up (deallocate) unneeded Profile resources 
whenever possible to that they can be used by other applications.

RGB
An additive method of combining percentages of red, green, and blue 
primary colors to form other colors.

ROM
See Read-Only Memory.
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RS-232-C
A standard serial communications interface for data communications, 
commonly used for communications between a computer and modem, or to 
control automated devices which don’t have a conventional computer 
operating system.

RS-422
A standard serial communications interface for data communications, 
similar to RS-232-C, but good for longer distance cabling. It is typically used 
for communications in a broadcast or post-production environment between 
devices such as VTRs, mixers, and controllers.
Profile Family

SCSI Channel (Small Computer System Interface)
The interface between the Profile processor and the disk array or library 
system. It is fast and wide and provides for speeds up to 20 Mbytes/second 
on a 16-bit bus.

SDI
An acronym for Serial Digital Interface, a standard for transmitting CCIR 
601 digital video over a pair of conductors (coaxial cable).

SECAM
France and Russia use the Séquence Couleur À Mémoire standard color 
format.

Serial port
Usually, the standard RS-232-C of a personal computer. Attach a serial cable 
to communicate with a peripheral device such as a modem or printer.

S/N Ratio
The Signal-to-Noise Ratio, measured in decibels, is the ratio between the 
maximum signal level and the noise level with no signal present. The higher 
the value, the better the sound reproduction.

Source
In Profile operations, a source is any signal (video, audio, or timecode) 
presented to the machine inputs. A VTR output, a satellite downlink, a 
camera output, and a facility router output are all examples of sources.
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Status bar
The status bar at the bottom of most windows provides status information, 
short explanations of commands and errors.

Tape
See Cartridge Tape.

Text insertion point
The I-shaped pointer which appears in a text input area. Clicking the mouse 
in a text input area causes the text cursor to appear in that area. Whatever 
8 Profile Family

information you type on the keyboard appears in the text input area 
displaying the text cursor.

Timecode Source
LTC, VITC, Timecode generator

TimeDelay
The name of the application and the amount of time that elapses between the 
start of the record channel and the start of the playback channel.

Tool Tips
A tool tip is a small pop-up window that displays a single line of text 
describing the purpose of a control in a window. A tool tip is hidden most of 
the time, appearing only when the user puts the cursor on a tool and leaves it 
there for approximately one-half second. The tool tip appears near the cursor 
and disappears when the user clicks a mouse button or moves the pointer off 
of the tool.

Tracks
Clips and masters are made up of individual tracks. A clip may consist of any 
combination of a video track, timecode track, and up to 16 audio tracks. A 
master may consist of any combination of a timecode track, 0-4 video tracks, 
and 0-16 audio tracks.

Trimming
Shortening an originally recorded media file to a desired duration using the 
In and Out marks. Material beyond the In and Out points is removed from 
the volume unless it is used in another clip or master.
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Video interface
The link to or from the internal video router and the external video signal. 
An example is a composite analog input channel. This path takes a 
composite analog video signal and converts it to 8-bit component parallel 
digital and places it on the video router. Another example is the component 
serial digital output. This path takes component parallel digital video from 
the video router and converts to serial digital component format.

Video disk recorder/ server
A device such as the PDR200 Video File Server that stores audio and video 
as digital information on disks.
Profile Family

VITC
Vertical Interval Time Code is encoded into the video lines at the start of 
field. VITC can be read during still frames, but becomes unreliable at frame 
rates faster than normal play speed, such as fast shuttle operations.

Video router
The video path through a system. The crosspoint circuitry that routes the 
video within the Profile video disk recorder is a router.

Volume
A volume is a logical set of disks, such as the disks in a PDR100 or a 
PDR200, which are used as a grouping of disks for the storage of audio and 
video information. Volumes may also consist of a PDX103 or PDX208 Disk 
Expansion unit, or a PRS200 or PRS250 Profile RAID System. 
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4:2:0 170
4:2:2 24, 170

A
A to D 365

1, 300

Archiving a bin or clip 137
ASPB 365
Assemble record mode 365
Assigning Profile Channels 315
Audio

channels 277
configuration 93
controls 277
gain levels 277
Absolute event type 29
Access Control 235
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Access Time 365 I/O 366
Profile Family 3

Actions in List Manager 291
Adding a Profile machine 110
Adjusting column width 311
Advanced 55, 66
AES/EBU 26, 83, 365
Air time in Monitor view 293
Analog Audio Input

PDR100 78
PDR200 84

Analog audio interfaces 23
Analog Audio Output

PDR100 81
PDR200 89

Analog Component 62
Analog Composite Video Input

Advanced Control 55
Vertical Interval 60

Analog Composite Video Output 67
Analog video 365
API 28
Application programming interface 28
Archive event 299
Archive library 365
Archived clip properties 150

input mapping 93
meters 277
monitor in VdrPanel 188
output mapping 96
PDR100 23, 77
PDR200 23, 83

Audio Resources
configuring 327
setting the audio window size 329

Audio signal processing board (ASPB)
25

audio window size, setting 329
Auto Start 351, 366
Auto-Timing 47

B
B picture 22, 170, 366
Back One Field 185
Bad blocks 208
Betacam 172
Bin 105

archiving 137
cleaning up 269
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creating a new 120
deleting 121
renaming 121
restoring from archive 138

Bit rate 170, 366
Black Level 69
Blocks 208
BNC 216 Digital Interface chassis 26, 83
BNC connections 176, 366
Boards, information on 38

Chroma Phase 69
Chroma Reduction 58
Chroma sampling 170
Cleaning Cartridge 367
Cleanup Media 269
Clip 367

archiving 137
capture 266
capturing 253
clip list 198
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Bounce 183
Building a list 287
Burn-in timecode 26, 73
BVW 162
BVW [insert edit] 172
BVW clip length 164
Bytes per Field 169

C
Camera 253
Capture 367
Capture timeline 264
Capturing clips 253
Cartridge properties 150
Cartridge Tape 367
CCIR 601 24
CD player 253
CD-ROM 367
Changing configuration files 221
Channel 367
Channels, audio 277
Checksums 244
Chroma 367
Chroma Gain 69

define 190
delete 122, 197
drag and drop 269
edit a list 199
eject 192, 197
group 198
load 192
lock 195
long names 196
new 190
play 193, 269
protect 195
record 266
renaming 121, 194
restoring from archive 138
short names 196
striping 196
subclip 270
trimming 269
unlock 195

Clip length (BVW) 164
Clip list 198
Clip marks 164
Clip Name Box 185
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Clip position 367
Clip Position Bar 184
Closing an application 32
Cluster 208
CODEC 23, 24, 173, 175, 368
Collapsing the media tree 112
Column width 311
COM1 and COM2 163
Comb 56
Command Line 368

Copying media in Media Manager 116
Copymovie 251
Create Mark-In button 271
Create Mark-Out button 271
Creating configuration files 220
Crosspoints

timecode 178
video 175

Ctrl key 19
Profile Family 3

Comment column 291
Communications port 163
Component video 368
Composite video 368
Compression 23, 169, 368
Configuration file, editing 221
Configuration files 39
Configuration Manager 33, 37
Configuration tree 38
Configuration, PRC 100 217
Configuration, ProLink 211, 217
Configuring Audio Resources 327

Setting the audio window size 329
Configuring Resources 315–??
Configuring resources, RS-422 217
Configuring Timecode Resources 330
configuring TimeDelay resources 346
Configuring Video Resources 316

adding a video track 317
selecting video inputs and outputs

320
selecting video quality 317

Controller 161, 164
Controls, audio 277

D
D to A 369
Data cartridge 368
Data set 204
Date 291
dB 278, 368
Decibels 278
Decoders 24
Decoders, MPEG 23
Default 369
Default Procamp 69
Defining clips 190
Delete Media 260
Delete, vertical interval 61
Deleting an archived clip 140
Deleting clips 197
Deleting media in Media Manager 122
Desktop, Windows NT 31
Detail log file 209
Dialog box 369
Digital Audio Input

PDR100 79
PDR200 86

Digital audio interfaces 23
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Digital Audio Output
PDR100 82
PDR200 92

Direct Memory Access (DMA) interface
25

Disk drives 23
Disk Expansion Unit 369
Disk label 205
Disk Utility 34, 203, 369
Display 369

EDL 370
EISA 24
EISA bus 77
Ejecting clips 192, 197
Emptying the Recycle Bin 264
Emptying the Recycle Bin in Media

Manager 122
Enable Impulse Noise Reduction 58
Enable Luma 58
Enable Procamp 68
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Dominance, field 202
Double-clicking 19
Drop-frame 370
Drop-frame timecode 180, 265
Duplicating media in Media Manager

120
Duration 291
Duration in Monitor view 293

E
E to E 44, 47, 183, 370
E to E button 266
E to E timed outputs 46
Edit

Delete 301
New Event 294, 295

Edit presets 168
Edit timeline 273
Edit view in List Manager 282
Edit Window 302
Editing a clip list 199
Editing configuration files 221
Editing lists 300
Editor, Tool Box 159

Enable Quiet Line 58
Encoders 24
Encoders, MPEG 23
Entry window, timecode 265
Ethernet 23, 36, 234, 241
Event

Archive 299
date 291
duration 291
inserting 300
play 287
record 295
removing 301
settings 289
start time 290
switch 297
taking 307
transfer 298

Event log, Windows NT 235
Event Number column 291
Event order 300
Event Scheduler Engine

definition 281
stopping 281
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Event Viewer application 235
Expanding the media tree 112
Explore in Media Manager 112
Exporting a cartridge 142

F
Factory default 370
Fast Forward 182, 268
fcconfig 244

G
Gain levels 277
Gaussian Chroma Filter 68
Generator, timecode 178
Genlock 27, 371
Go to Clip Beginning 185
Go to Clip End 185
GOP 21, 170, 371
Graphical user interface 371
Profile Family 3

fcncs 252
fcping 249
Fibre Channel 36, 105, 241
Fibre Channel IP Address 244
Fibre Channel switch 246
Field 370
Field dominance 202
Field Selection 182
File

Open 303
Save 302

File systems 204
Finding Clips and Masters 128
Finding media in Media Manager 128
Firmware 237, 370
Fixed Q 169
Follow 300
Formatting cartridges 147
Forward One Field 185
fps 370
Frame 371
Free Run timecode 178
Freeze timecode 178
Frequency response 371

Group 371
Group Fader 85, 100
Group Name Box 184
GUI 371

H
Hard disk 372
Hardware Communication Monitor 107,

255, 284
Help 372
Help files 18, 32
Hertz (Hz) 372
House Time 293
Hue 372

I
Icon definitions 113
I-frame 22, 170, 372
Importing a cartridge 140
In marks 184, 200
Input Clocking 96
Input device 372
Input mapping 93
Insert edit, BVW 172
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Insert Media 260
Insert record mode 373
Inserting events 300
Installed boards information 38
Intel i960 real-time processor 24
Internal Reference Timing 49
Internal storage 23
Internal timecode generator 331
Inventorying a cartridge 144
Inventorying the library 146

event order 300
inserting events 300
opening 303
saving 302
validate 293

List Manager 35, 159, 281
configuring resources 315
Edit view 282
engine, See Event Scheduler Engine

281
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IP address 243
ISA 24

J
JPEG 24, 175
JPEG CODECs 23
JPEG codecs, assigning 217

K
Keyboard 373
Keys, shortcut 186

L
Labeling a disk 205
LAN 36, 234, 242
Launching TimeDelay at start-up 342
Library properties 150
Library system 373
Line formats 23
Line level 85
List

building 287
editing 300

live events 297
Monitor 282
monitoring a list 293
recording 295

listnames command 250
Live events 297
Load Media 260
Loading clips 192
Loading microcode 207
Lock to Field Number 178
Locking clips 195
Log Capture Tool 214
Log file 211
Logging in 30
Logs 211
Long clip names 196
Loop 183
Loop Play 268
Louth 28, 162
LTC 27, 50, 177, 178, 331, 373
Luminance Black Clip Level 69
Luminance Only 68
Luminance White Clip Level 69



Index

87

M
Mainframe bandwidth 23
Manual conventions 19
Manually logging in 30
Marks 164, 184, 200
Master

adding media to 275
creating 275
delete 122

150
moving media 117
renaming an archived clip 139
renaming clips and masters 121
restoring a bin or clip from archive

138
starting and exiting 106
tape transport status 153
toolbar 115
Tools menu 108
Profile Family 3

playing 276
renaming 121

Master List 287
Master timecode 41
Master VITC 41
Max Chroma 169
Media

cleaning up trimmed clips 269
sorting 259

Media files 373
sorting 259

Media Manager 33, 105–158
archiving a bin or clip 137
copying and pasting media 116
creating, renaming, deleting bins 120
deleting an archived clip 140
deleting clips and masters 122
duplicating media 120
emptying recycle bin 122
exporting a cartridge 142
formatting cartridges 147
icons 113
importing a cartridge 140
inventorying the Library 146
library, cartridge, and clip properties

Transfer Monitor 156
updating and inventorying cartridges

144
using a Library System 137–155
viewing properties 124, ??–127
viewing the hierarchy 112

Media properties 124, 262
Memory 373
Menu 19, 373
Meters, audio 277
Microcode 207, 239
Microphone 253
Min Lum Q 169
Modify Mark-In button 265
Modify Mark-Out button 265
Monitor 374

selecting 287
Monitor Channels 100
Monitor output 71
Monitoring a list 293
Motion JPEG 24
Mouse 374
Moving media in Media Manager 117
MPEG 21, 23, 130, 170, 281, 374
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MPEG encoders, assigning 217

N
Name column 290
Network host list

add or remove machine 111
Networking, video 241
New Bin 260
New clips 190

Clip Name Box 185
Clip Position Bar 184
Fast Forward 182
Field Selection 182
Forward One Field 185
Go to Clip Beginning 185
Go to Clip End 185
Group Name Box 184
Loop 183
making active 187
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New Master 260
Normal 183
Normal, vertical interval 61
Notch 56, 61
NTSC 26, 374

O
Odetics 28, 162
Off-line cartridge 374
onfiguration files, creating 220
Open Bin 260
Opening a list 303
Out marks 184, 200
Output mapping 96
Overload status 85

P
P picture 22, 170, 376
P1 through P8 163
PAL 26, 126, 263, 374
Panel

Back One Field 185
basics 180
Bounce 183

Normal 183
PB/EE 183
Play 182
Playback 183
Record 182
Remove In Mark 184
Remove Out Mark 184
Rewind 182
Set In Mark 184
Set Out Mark 184
Shuttle Bar 185
Shuttle Rate 184, 185
Stop 182
tiling 187
Timecode 181
Trim from Out Mark 184
Trim to In Mark 184

Panel control 161
Parameter 375
Parent Event column 291
Partitions 375
Pass On Y 61
Paste Special 117
PB/EE 183
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PDR 100 24
PDR 200 24
PDR 300 24
PDR Access Control 235
PDR Network Configuration Service

252
PDR100 Audio 77
PDR200 Audio 83
PDR200 Installation Manual 18
PDX 208 25

PRC100 Profile Control Panel 159
PRC100 Profile Control Panel User

Manual 18
Presets 168
Profile Configuration Manager 33, 37
Profile Disk Utility 34, 203
Profile Log Capture Tool 214
Profile logs 36, 211

capturing 214
Profile Protocol 28, 36, 159
Profile Family 3

PDX103 Disk Expansion Unit Installa-
tion Manual 18

PDX208 Disk Expansion Chassis 204
PDX208 Disk Expansion Chassis In-

struction Manual 18
Peak hold 189
Physical volumes 204
Pixel 375
Play 182, 268
Playback 183, 375
Playback delay 375
Playing clips 193
PLS20 and PLS200 Profile Library Sys-

tems 105
PLS20 Library System Manual 18
PLS20 Profile Library System 137
PLS200 Library System Manual 18
PLS200 Profile Library System 137
Pointer 375
Pointing device 375
Port 163, 375
PortSever 234
Powering on 30
PRC 100 configuration 217

Profile Protocol Resources 217
Profile System Version 2.4 Release

Notes 18
profile.log 211
ProLink, configuration 211, 217
Properties 150, 262
properties, media 124
Protecting clips 195
Protocol 376
PRS 200 25
PRS200/A RAID Storage Instruction

Manual 18
PRS250 RAID Storage Instruction Man-

ual 18

R
RAID 105
Read-only memory 376
Real-time 376
Record 182, 190, 295
Record Buffer 376
Record Capacity 188
Record Event 294, 295
Recycle Bin 264
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Reference Genlock 48
Reference signals 23
Regedit registry editor 213
Regenerate timecode 178
Relocating a bad block 208
Remote Profile machine 110
Remove In Mark 184
Remove Out Mark 184
Removing a Profile machine 110
Renaming an archived clip 139

S
S/N Ratio 377
Satellite feed 253
Save Group of Clips 198
Saving a list 302
saving a TimeDelay project 341
SCSI 24, 377

IDs 204
log file 209
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Renaming clips 194
Renaming media in Media Manager 121
Resource Manager 313

add channel 315
configuring audio resources 327
configuring timecode resources 330
remove channel 315

Resources 376
assigning 313
configuring 315
freeing 285

Resources, PRC 100 217
Restoring an archived bin or clip 138
Reverse 268
Rewind 182, 268
RGB 376
Right-click 19
ROM 376
Router, video 379
RS-232-C 377
RS-422 23, 377
RS-422 protocol 212
RS-422, configuration 217

SDI 377
SECAM 377
Select timecode 177
Serial Digital Component Video

Input 64
Output 74

Serial port 163, 377
Service, PDR Access Control 235
Set In Mark 184
Set Out Mark 184
Settings

event 289
Short clip names 196
Shortcut keys, VDR Panel 186
Shuttle Bar 185
Shuttle Rate 184, 185
Size box 181
SMPTE 272M Level A 26, 83
Software Development Kit 28, 36
Sorting

media files 259
Sorting media 259
Source 377
Spatial Adaptive 57
Start Time 290
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Starting an application 32
Status bar 38, 378
Status Bar, Media Manager 109
Status column 290
Stop 182
Striping a clip 196
Subclip 270
Subnet mask 244
Switch event 297
System timing 44

drop-frame 180, 265
entry window 265
free run 178
freeze 178
internal generator 331
lock to field number 178

Timecode Resources
changing generator settings 334
choosing codecs and generators 332
configuring 330
Profile Family 3

System timing (E to E) 44

T
Take button 307
Target compression rate 169
TC Recorder 178
TCP/IP 242
TCREC 173
TekCfg 28
TekPdr 28
TekRem 28
TekVdr 28
TekVfs 28
TekVme 28
TekXfr 28
Temporal/Spatial Adaptive 57
Testing a bad block 208
Text insertion point 378
Time base correction 59
Time Till Next Event in Monitor view

293
Timecode 177, 181

crosspoint 178
display 181

Timecode Source 378
TimeDelay 35, 339–363

auto start 351
configuring channels 346
configuring resources 315, 346
connecting to a remote machine 343
menus 361
playback panel 360
project file 341
record panel 359

Timeline
capture 264
edit 273

Timeline Eject 260
Timing Adjustment 75
Tool Box Editor 35, 159, 253

configuring resources 315
exiting 254
launching 254

Tool Tips 378
Toolbar 38

Media Manager 109
Toolbar buttons 115
Tracks 378
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Transcode Utility 130
Transfer Event 298
Transfer Monitor 156
Transport controls

cue 268
fast forward 268
loop play 268
mode 268
play 268
reverse 268

VDR Panel shortcut keys 186
VdrPanel 34, 159
VdrPort logs 213
Vertical Interval 60, 70
Video

channels 23
crosspoints 175
Gain 69
input 23
input and output 320
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rewind 268
stop 268

Transport status 153
Tree hierarchy 112
Trigger

Follow 300
Trim from Out Mark 184
Trim to In Mark 184
Trimming 378
Type box 181

U
Undo button 38
Unity, audio 278
Unlocking clips 195
Update Fibre Channel Microcode 36,

239
Update Firmware 36, 237
Updating a cartridge 144
User mark 270
Using 211

V
Validating a list 293

Video disk recorder/server 379
Video interface 379
Video network 23, 241
Video resources

configuring 316
Video router 24, 379
Viewing columns 290
VITC 41, 165, 177, 331, 379

erase 75
Generator Setting 74
reader setting 48

VITC detection 26
Volume 105, 113, 204, 379
VTR 21, 24, 253

W
Window

Open Panel 172
Timecode Crosspoint 179
Video Crosspoint 175

Windows NT 3.51 32
Windows NT 4.0 32
Windows NT desktop 31
WinTail 36, 209, 211
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X
XLR 216 Digital Interface chassis 26, 83

Z
Zooming the edit timeline 273
Profile Family 3
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